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ABOUT THIS GUIDE

This chapter provides information about the caCORE SIW and UML Model Loader
Technical Guide for Version 4.0.

It includes the following topics:
e Purpose on this page
e Audience on this page
e Topics Covered on page 2
e Additional References on page 3
e Text Conventions Used on page 3

e Credits and Resources on page 4

Purpose

The purpose of this guide is to describe the Semantic Integration Workbench (SIW) and
UML Loader components of caCORE. caCORE is the cancer Common Ontologic
Representation Environment and is an open-source, standards-based, semantics
computing environment and tool set created by the National Cancer Institute’s Center
for Biomedical Informatics and Information Technology (CBIIT).

The SIW provides a way for UML model owners to bind the elements in their models to
terms from a controlled vocabulary (EVS concepts). The controlled vocabulary is used
to help accurately define the elements in the model. This binding is referred to as
“annotation.” The purpose of annotating using a controlled vocabulary is to provide
ways for disparate models to use the same terms to describe similar model elements
that are used in a similar way (such as name or gene or address or patient).

Once the model is annotated with EVS concepts, those concepts are then used to link
(where possible) the annotate elements from the model to metadata elements already
being used by other UML models registered by other organizations. This linking is
referred to as “registration” and is the key to semantically integrating your model with
other registered UML models.

The UML Loader is the tool used to register UML model metadata into the caDSR. The
caDSR is the Cancer Data Standards Repository, and consists of a database and
toolset that are used to create, edit and reuse common data elements. These data
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elements (also known as DEs or CDES) represent common pieces of metadata used by
registered UML models and which can be re-used by other models as appropriate.

This guide provides an overview of the SIW and the UML Loader and explains how
these two components can be used to achieve semantic integration of your UML model
with other organizations’ models.

Audience

The information in this guide is directed at UML model owners who want to bring their
model semantically in line with other similar organizations’ systems, and (if desired) to
register their system’s metadata into caDSR. This guide is also designed to provide
other types of readers (non-programmers) with a basic overview of the NCICB’s
purpose and methods for semantic integration between dispersed research information
systems.

This guide also contains information directed at EVS curators who are using the SIW to
annotate the XMl files submitted to the NCICB for curation.

While semantic integration typically occurs separately from the use of other caCORE

tools (e.g., caAdapter or the SDK), it is a good idea to use the SIW to confirm that the
file you are using for the other aspects of developing a caCORE-compatible system is
also semantically compatible with other registered caCORE systems’ metadata.

This guide provides information about how to use the SIW to bind the elements from
any UML model to metadata concepts located in EVS, or to data elements already
registered in caDSR.

Topics Covered

The primary information covered in this guide is the use of the SIW by both model
owners and EVS curators. This information includes detailed explanations and
procedures for using the tool, as well as information on why each step is important.

Because the UML Loader is used exclusively by NCICB personnel, the information
included in this guide is limited to an overview of the end result of the UML Loader
process. This guide also provides basic instructions for searching the caDSR for your
model’s loaded elements.

Below is a list of the chapters contained in this guide and a brief overview of the
information you will find in each chapter:

e Chapter 1, Overview of caCORE and Semantic Integration, on page 5 provides
overview information about caCORE and about the purpose and process of
semantic integration. It also provides information regarding the steps you must
follow before using the SIW.

e Chapter 2, Using the Semantic Integration Workbench (SIW), on page 21
provides the basic information you need to know to use the SIW, including an
overview of the sections of the SIW viewer and their functionality, and details
about the viewer preferences available, how to change the default preferences,
and how these changes affect the display of your model information in the SIW
viewer.
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e Chapter 3, Semantically Integrating Your UML Model, on page 41 provides
detailed information on how to use the SIW to review and annotate the XMl file
exported/saved from your UML modeling software.

e Chapter 4, caCORE UML Loader and Registering Metadata, on page 91
provides an overview of the process (including the expected outcome) of
registering your model’'s metadata in caDSR. This chapter also provides basic
information on using the caDSR tools to browse for your model’s elements once
they are loaded.

e Glossary on page 121 provides definitions for terms used throughout this guide
and for terms that relate to caCORE in general.

Additional References

For more information about caCORE Semantic Integration tools and other caCORE
components referenced in this guide, refer to the NCICB web site, which contains
information about all of the tools available in the caCORE suite: http://ncicb.nci.nih.gov/

The caCORE Wiki also provides a centralized place for overviews and links to
additional information and release notes. The caCORE Wiki can be found at: https://
wiki.nci.nih.gov/x/BlAe.

Specific locations on the wiki that may be of interest include:

e SIW Wiki Page, which contains links to the Release Notes for the past several
releases: https://wiki.nci.nih.gov/x/QYEI.

e Semantic Integration Tools Project on GForge, which provides extensive
information regarding both past and ongoing development of the SIW and UML
Loader: http://gforge.nci.nih.gov/projects/siw/.

e caDSR Wiki Page, which contains descriptions of each of the tools in the
caDSR toolset, links to release notes, and links to the URLSs for each of the
available tools: https://wiki.nci.nih.gov/x/OYEI.

e caCORE SDK Wiki Page, which contains overview information about the SDK
and links to release notes and to the 4.0 documentation suite: https://
wiki.nci.nih.gov/x/XIAl.

Text Conventions Used

This section explains conventions used in this guide. The various typefaces represent
interface components, keyboard shortcuts, toolbar buttons, dialog box options, and text
that you type.

Convention Description Example

Bold Highlights names of option buttons, Click Search.
check boxes, drop-down menus, menu
commands, command buttons, or icons.

RL Indicates a Web address. http://domain.com

text in SMALL CAPS Indicates a keyboard shortcut. Press ENTER.
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Convention Description Example
text in SMALL CAPS + | Indicates keys that are pressed Press SHIFT + CTRL.
text in SMALL CAPs | simultaneously.
Italics Indicates emphasis on particular words | To undo your changes,
or phrases. select a different node
before clicking Apply.
Italics Used for references to other See Figure 4.5.
documents, sections, figures, or tables.
Italic boldface | Represents text that you type. In the New Subset text
monospaced type box, enter
Proprietary
Proteins.
Note: Highlights information of particular Note: This concept is
importance used throughout the
document.
{1} Surrounds replaceable items. Replace {last name, first

name} with the Principal
Investigator’'s name.
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CHAPTER

OVERVIEW OF CACORE AND SEMANTIC
INTEGRATION

This chapter provides an overview of the NCICB caCORE infrastructure and of the
caCORE product release paradigm. This chapter also provides an overview of
semantic integration and how it fits into the caCORE process.

The final sections of this chapter provide information and instructions for model owners
regarding prerequisites for the UML model prior to exporting it for use with the caCORE
Semantic Integration Workbench.

Topics in this chapter include:
e caCORE Overview on this page
e Introduction to Semantic Integration on page 8
e Recommended UML Model Pre-requisites on page 14
e Generating the XMl file for the SIW on page 19

The caDSR team maintains a list of commonly asked questions and answers and tips
about the SIW and UML Loader on the FAQs - UML Modeling page on the caCORE
Wiki at: https://wiki.nci.nih.gov/x/7wFy.

caCORE Overview

The NCI Center for Bioinformatics (NCICB) is an organization that provides biomedical
informatics support and integration capabilities to the cancer research community. In
order to assist with this integration, the NCICB has developed caCORE, the cancer
Common Ontologic Representation Environment (caCORE). caCORE is a data
management framework designed for researchers who need to be able to access and
provide data across a large number of data sources.
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By providing a common data management framework, caCORE helps streamline the
informatics development throughout academic, government, and private research labs
and clinics. The components of caCORE support the semantic consistency, clarity, and
comparability of biomedical research data and information. caCORE is open-source
enterprise architecture for NCl-supported research information systems, built using
formal techniques from the software engineering and computer science communities.

The four characteristics of a caCORE-compatible system include:
e Model Driven Architecture (MDA)
e n-tier architecture with open Application Programming Interfaces (APIs)
e Use of controlled vocabularies, wherever possible
e Registered metadata

The use of MDA and n-tier architecture, both standard software engineering practices,
allows for easy access to data by other applications. The use of controlled vocabularies
and registered metadata, less common in conventional software practices, requires
specialized tools that are generally unavailable.

As a result, the NCICB (in cooperation with the NCI Office of Communications) has
developed the Enterprise Vocabulary Services (EVS) system to supply controlled
vocabularies, and the Cancer Data Standards Repository (caDSR) to provide a
dynamic metadata registry. The Semantic Integration Workbench (SIW) and UML
Loader provide a process-bridge between the EVS, the caDSR and any UML model.

When a system meets all four of the development characteristics listed above, it is said
to be “caCORE-like.” Such systems provide several advantages:

e With its open APIs, the end user (whether human or machine) can retrieve data
without having to understand the implementation details of the underlying data
system.

e The maintainer of the resource can move the data or change implementation
details without affecting the ability of remote systems to access the data.

e Most importantly, the system is semantically interoperable; it uses runtime-
retrievable information to provide an explicit definition and complete data
characteristics for each object and attribute supplied by the data system.

Components of caCORE
The components that comprise caCORE include: SDK, SIW, EVS, caDSR, UML
Loader, caBIO, CSM, and CLM. The following subsections provide a brief description of
each component. You can also find more information on the NCICB web site at: http://
ncicb.nci.nih.gov/.

Software Development Kit (SDK)
The caCORE SDK is designed to assist researchers and application developers with
creating caCORE-compatible APIs for their system. When use of the caCORE SDK is
combined with the use of controlled vocabularies and registered metadata, the
resulting software system is considered to be a “semantically integrated caCORE-like
system” because the runtime-accessible data elements available through the exposed
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APIs will have been defined using controlled terminology. These elements will therefore
be easily understood and interpreted by other caCORE-like systems.

Semantic Integration Workbench (SIW)
The SIW is a tool designed to help UML model owners map the elements of their model
to metadata concepts already defined in the NCI Thesaurus and, where possible, to
data elements already registered in the caDSR. Essentially the SIW provides an easy
way to semantically bind the elements from one UML model to terms or definitions used
by elements in other systems’ models. The ultimate purpose is to see that systems use
the same terms for identical items, allowing those systems to more easily gather and/or
share data.

Enterprise Vocabulary Services (EVS)
EVS provides controlled vocabulary resources that support the life sciences domain,
implemented in a description logics framework. EVS vocabularies provide the semantic
raw material from which data elements are constructed.

Cancer Data Standards Repository (caDSR)
The caDSR is a metadata registry based upon the ISO/IEC 11179 standard. It is used
to register the descriptive information (metadata) needed to render cancer research
data reusable and interoperable. The caBIO, EVS, and caDSR data classes are
registered in the caDSR, as are the data elements used on NCI-sponsored clinical trials
case report forms, as well as from caBIG- and NCICB-sponsored UML models.

UML Loader
The UML Loader is a tool used by the NCICB to register the metadata elements from a
system’s UML model into caDSR. The UML Loader helps automate the process of
binding UML model metadata elements to registered caDSR components, and where
necessary, create new components that correspond to the elements in the model.

Cancer Bioinformatics Infrastructure Objects (caBIO)
The caBIO model and architecture is the primary programmatic interface to caCORE.
Each of the caBIO domain objects represents an entity found in biomedical research.

Unified Modeling Language™ (UML) models of biomedical objects are implemented in
Java as middleware connected to various cancer research databases to facilitate data
integration and consistent representation. Examining the relationships between these
objects can reveal biomedical knowledge that was previously buried in various primary
data sources.

Common Security Model (CSM)
The Common Security Model (CSM) provides a flexible solution for application security
and access control with three main functions:

e Authentication to validate and verify a user's credentials
e Authorization to grant or deny access to data, methods, and objects

e User Authorization Provisioning to allow an administrator to create and assign
authorization roles and privileges.
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Common Logging Module (CLM)
The Common Logging Module (CLM) provides a separate service under caCORE for
audit and logging capabilities. It also comes with a Web-based locator tool.

Client applications can use the CLM directly, without the application using any other
components such as the CSM.

About the caCORE Release Paradigm

In September 2007, the NCICB Infrastructure and Product Management Team made
the decision to separate the caCORE Components that had previously been bundled
and released together. This decision was geared toward allowing each of the
infrastructure product teams to be more responsive in addressing specific needs of the
user community.

This guide focuses on the 4.0 release of the SIW and UML Loader components of
caCORE.

For more details on other caCORE components, refer to the caCORE Overview web
page at http://ncicb.nci.nih.gov/NCICB/infrastructure/cacore_overview, which directs
you to other product-specific informational pages. You may also want to view the
caCORE Wiki (https://wiki.nci.nih.gov/x/BIAe), which provides overviews of the
caCORE toolset and links to product-specific documentation.

Introduction to Semantic Integration

Semantic integration refers to the aspect of creating a caCORE-like system that
addresses the mapping of data element metadata to controlled vocabularies using
concept codes.

For a UML model, proper semantic integration requires that each UML class and
attribute gets mapped to appropriate metadata concepts in a controlled vocabulary. At
NCICB, the preferred vocabulary is the NCI Thesaurus, maintained by the Enterprise
Vocabulary Services (EVS) staff. It is the association of a model’s elements with these
controlled concepts that allows for unambiguous interpretation of UML model objects
and mapping between objects from different domains. The resulting data elements are
more sharable and interoperable.

The SIW performs the association of the model's elements using an XMl file exported/
saved from the UML modeling program used to create the model. The mapping of the
elements in an XMl file to EVS concepts is called “annotation.”

While you can use manual annotation of the UML model to achieve semantic
integration, using the Semantic Integration Workbench (SIW) is the preferred method.
The SIW streamlines (and partially automates) the process of semantic integration, and
required detailed review and approval of each element before a model can be
registered into caDSR. Manual annotation has the potential to introduce human errors
that can cripple metadata registration and the UML Loader.

Once the annotated version of the model has been approved by the model owner and
the EVS curation team, the XMl file is sent to the NCICB caDSR team to be

transformed into caDSR metadata via the UML Loader. The caDSR metadata registry,
based upon the ISO/IEC 11179 standard, registers the descriptive information needed
to render cancer research data reusable and interoperable. For more information about
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the ISO/IEC 11179 standard, see_http://isotc.iso.ch/livelink/livelink/fetch/2000/2489/
Ittf Home/PubliclyAvailableStandards.htm??Redirect=1.

Workflow for Full Semantic Integration
The semantic integration process consists not only of annotating an XMl file and
mapping the model elements to other pre-existing elements, but also of adding the
appropriate items into the UML model before exporting the XMl file, and then of
reloading the mapped items from the annotated XMl file back into the UML model for
use in the next version of the system.

While this guide is designed to describe the SIW and the mapping process specifically,
it is important that as a model owner you understand the overall process needed to
achieve full semantic integration of your UML model.

Semantic integration is divided into four phases:

1. Phase One - the model owner creates the necessary tagged values for the
model elements, and if necessary, creates any local value domains to be used
by the model (local value domains are optional). When the model is complete,
the model owner creates an XMl file of the UML model (either by exporting from
Enterprise Architect, which creates an .xmi file or saving from ArgoUML, which
creates a .uml file).

2. Phase Two - using some or all of the five steps in the SIW, the elements in the
XMl file are semantically annotated using NCI Thesaurus concepts in an
iterative process between the model owner and the EVS curation team. Once
the XMl file is fully annotated, the model owner reviews the file and, if accepted,
submits the file, along with a submission form, to the NCICB to have the model
loaded into the caDSR.

3. Phase Three - the NCICB takes the file and the submission request form
information and loads the UML model to the caDSR Sandbox using the UML
Loader. If the model loads successfully, the model owner reviews and approves
the model for loading to Production. Once loaded to Production, the model
owner reviews it again and requests any necessary changes to the metadata.
After curation, the registered model is sent through compatibility review and
once approved, is released to the public.

4. Phase Four - after the model has been loaded to caDSR and released, the
model owner can use the Roundtrip mode of the SIW to bind the caDSR
metadata to the model elements in the XMl file. The model owner can then
import all of the XMl file annotations back into the UML model (they are applied
to the model as tagged values for each element). This readies the model for
reuse or for the next version. Model owners can also produce the final public
APIs using the SDK code generator.

At this point you should be starting to understand why semantic integration is useful. If
one developer registers their model in caDSR, then a different model owner can
compare their model against the registered model and reuse existing elements from the
registered model for those same elements in their model. Where the new model has
elements not used before, new metadata elements are created for caDSR, which are
then available for use by another system’s model owner.
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Eventually you have a large number and wide range of systems that are using the
same metadata for the same objects, making it possible for those systems to
communicate and share data with one another more easily than if those systems had
been created without using a common vocabulary.

Terms You Should Know

10

In order to understand the information being provided in this guide, it is important that
you understand certain terms as they are used within the context of the caCORE
environment and associated toolset. These terms also appear in Appendix 5, Glossary,
on page 121. However, they are important enough and pervasive enough in this text to
be called out separately and defined in relation to semantic integration.

Metadata —Metadata is data about data, or is sometimes is described as the definition
of a piece of information. For example, a person’s name might be “Joe Smith.” The data
about the person is “Joe Smith.” The metadata for that information is “name” and is
defined as “a term that specifically identifies the item to which it is attached.”

While “name” can function as a piece of metadata, the term “name” doesn’t mean much
by itself. The idea of a name can apply to a person, a drug, a facility, or any humber of
items. It is not the “name” that creates complexity but the attributes that can be
associated with “name.” If a person is filling out a form, there is probably a place for
“First Name” and for “Last Name” and possibly for “Maiden Name.” And while these
conventions are clear to some users, not all cultures use “first” as “given name” and
“last” as “family name.”

In order for systems to be able to assemble and share the same sort of information
from all participants, they need to be certain that the information exists in their systems
in the same way. This is done by using and reusing the same metadata tags for the
same information across systems.

The example provided here touches only slightly on the complexity of the terminology
used across disparate systems, even if those systems are all working with the same
kind of information (i.e., cancer research). Apply the idea of metadata to the collection
of information about patient symptoms or drug interactions or physical descriptions and
you can begin to understand why using a controlled vocabulary and a centralized
metadata repository is important for the sharing of research information.

UML Model —According to Wikipedia, UML or Unified Modeling Language is “a
general-purpose modeling language that includes a graphical notation used to create
an abstract model of a system, referred to as a UML model.” So that basically, a UML
model is a graphical representation (picture) of a software application.

Using UML to model your software lets you identify the individual pieces of the
application and relate them to one another. The caCORE toolset, including the SIW
and the UML Loader is compatible with .xmi files exported from Enterprise Architect
(EA) and with .uml files saved from ArgoUML. Throughout this guide, however, both
types of files are referred to as XMl files, regardless of file extension.

XMI—XMI stands for “XML Metadata Interchange” and is a standard for exchanging
metadata information via Extensible Markup Language (XML). The most common use
of XMl is as an interchange format for UML models.
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Class—According to Wikipedia, a class is “a programming language construct that is
used to group related attributes and methods...a cohesive package of a particular kind
of metadata.” For example, your model might contain a class “Patient” which is
described in your model as “A person being acted upon by a medical professional.” The
details of the object are defined by the attributes for the class (such as name or address
or gender). The class is defined in the model, but through semantic integration and the
SIW, is also defined using concepts from the EVS controlled vocabulary. The attributes
for the class (which are also mapped to EVS concepts) provide further details about the
class and are defined separately.

Attribute—An attribute defines the properties of an object. In terms of a UML model,
the attributes associated with a class provide details about the use of the class in the
system. For example, the model may have a class called “patient” and that class has
several attributes associated with it including “gender”, “race”, “ethnicity”, “id” or other
descriptors.

Each of the attributes in a model will be mapped to concepts or definitions so that each
time they are used in the same way, the same definition follows. For example “id” may
be defined as “Identifier - an item that uniquely identifies an object,” and “gender” may
be defined as “the assemblage of properties that determines reproductive role.”

Mapping UML model elements to EVS concepts ensures that whenever an object is
used in a particular way (even across models), the definition of the object for that use is
the same and is unambiguous; it means the same thing every time.

Value Domain—Value domains are defined as the “domain of possible values” for an
element in the model. This is typically expressed as the type of information that the
system can accept as valid data for an item. For example, your model has an attribute
“id” and the system that the model is based on has restricted all IDs to be numeric. The
value domain for that attribute might be “java.lang.Integer.” This identifies the type of
values that your use of “id” can have.

Value domains can be “enumerated” or “non-enumerated.” Non-enumerated value
domains mean that there are restrictions to the possible values for the item but the
possible values are not specified. Enumerated value domains mean that the possible
values for the item are explicitly stated. So for an attribute like “gender” the value
domain might be enumerated and limited to “male” and “female” or to “m” and “f”
depending on how the system recognizes the informational input.

Association—An association is simply the relationship between classes in a model,
and includes details about that relationship (multiplicity, directionality, etc.).
Associations also have “roles” which define how the element relates to the other
elements it is associated with.

Tagged Value—A tagged value is a UML construct that represents a name-value pair.
It can be attached to anything in a UML model and is used by UML modeling tools to
store specific information about the element to which it is attached.

The caCORE toolset uses a variety of tagged values from the UML model to perform a
variety of tasks. The SIW in particular uses element description tagged values to
identify the purpose or meaning of the element in the model. Specifically, the model
owner needs to add tagged values called CADSR_Description to each element in the
model to define or describe the element. These descriptions help the EVS curation

11
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team properly map the element to EVS concepts. For more information regarding the
tagged values used by the SIW and UML Loader, see the XMI Tag Reference wiki
page located at: https://wiki.nci.nih.gov/x/SYI8.

EVS Concepts—Each metadata term in the NCI Thesaurus has a code, a name, and a
definition for the term as well as an indication of the source of the definition. These are
called “concepts” and function as the controlled vocabulary that are mapped to the
elements in your UML model. Mapped concepts become tagged values for the
elements in the model.

Each element in the model must have at least one concept mapped to it. The first
concept mapped to an element is called the Primary Concept. The Primary Concept
must reflect the basic meaning or idea of the element. Each concept added after the
Primary Concept is called a Qualifier Concept. Each Qualifier Concept mapped to an
element provides more detailed information about the element.

For example, your model has an element named “patientBirthDate.” The fundamental
idea of the element is that it is a date. So the Primary Concept mapped to that element
might be the EVS concept called “date” indicating a point in time. The element then
might also have two Qualifier Concepts mapped to it called “birth” and “patient.” The
combination (referred to as Summary Concept) is then identified with the element as
“Patient Birth Date” and has three associated concept codes, three concept names and
three concept definitions, one for each mapped concept.

This concept mapping or linking through EVS acts as a bridge between the elements in
the UML model and the metadata elements in caDSR and provides a common
vocabulary for the use and definitions of terms across models.

Data Element/Common Data Element (DE/CDE)—A Data Element (DE) or Common
Data Element (CDE) is defined as the unique combination of a Data Element Concept
and a Value Domain. The terms data element and common data element (or the
abbreviations DE and CDE) mean the same thing and are used interchangeably.

Data Element

Data Element Concept

Object Class
[,Vs_

Property
EVS

Value Demain

Permissible Values
EVS

Figure 1.1 Graphical representation of a caDSR Data Element
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A Data Element Concept (DEC) is the unigue combination of an Object Class and
Property. Object Classes correspond to UML model classes, and Properties
correspond to UML model attributes. This means that if your UML model has a class
that has four attributes associated with it, there will be four DECs created for that item,
one for each attribute/class combination.

As each of those DECs is associated with a value domain, an existing data element is
reused or a new one is created. So if there are four DECs associated with a class (one
for each class/attribute combination), there will be four data elements also associated
(when the value domains corresponding to the datatypes associated with each attribute
are added to each DEC).

This means that each piece of metadata associated with your model is derived from a
combination of the definitions or descriptions established for the item the metadata
represents. Remember that each element in your model was defined using one or more
EVS concepts, so the full definition and intent of each element is understood,
unambiguous and given commonality through the controlled EVS vocabulary. So when
the elements of your UML model are mapped to caDSR metadata, you know that the
metadata accurately represents the characteristics of the model element (class,
attribute, value domain) to which it is mapped.

Graphically, the correlation between UML model elements and the component parts of
a DE looks like this:

Created a UML - caDSR Mapping

UML Model ISO/IEC 11179

Commeon Data Element

I UMLClass : DEC + Value Domain

Data Element Concept
Object Class + Property

|UMLAIttribute| : [UMLDataTypel

Object Class

h 4

EVS

Property

| Value Domain Enumerationf Vs

Y

Value Domain

Y

Permissible Values
EVS

Figure 1.2 Mapping between UML model elements and a caDSR CDE

This mapping or transformation of UML model elements into caDSR metadata is
performed initially by the UML Loader, using the concept information provided through
the annotation process. After your model has been loaded into caDSR, the Roundtrip
mode of the SIW can apply this mapping back into your XMl file for re-loading into the
UML model, to use for the next version of the system.

13
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Unannotated and Annotated XMI Files—An Unannotated XMl file is one that has
been exported from the UML modeling software but has not yet had all of its elements
mapped to either EVS concepts or caDSR CDEs.

When you select the SIW step to Review Unannotated XMl file, the SIW hides concept
annotation errors, because by definition, an unannotated file is missing concept
mapping. Reviewing an unannotated file allows you to focus on any syntactic errors in
the file (elements without definition or descriptions). This allows you to review and
(where necessary) change your model before doing the annotation.

An Annotated XMl file is one where all of the elements in the model have been mapped
to EVS concepts or to caDSR CDEs. The elements in the file have been annotated with
additional information.

When you select the SIW step to Review Annotated XMl file, the SIW shows all errors
in the file that will need to be fixed before the model can be loaded into caDSR. These
include elements where concept information is missing, where duplicate mapping
exists, or where invalid value domains have been used for elements, among other
items.

Recommended UML Model Pre-requisites

Since the XMl file you export from your UML modeling software may be used across
the caCORE toolset, you want to be sure that the model and the elements within it meet
the conventions either recommended or required by the various caCORE tools.

The purpose for this section of this guide is to identify those things that need to be done
or verified in the model before exporting the XMl file for use.

The topics in this section include:
¢ Modeling Constraints, below
e Naming Best Practices on page 16
e Using Local Value Domains on page 17

As a final note, Enterprise Architect (EA) and ArgoUML are the officially supported UML
modeling tools for use with the caCORE suite of products. Throughout this guide you
will notice the use of XMI to describe the file exported/saved from the UML modeling
software and processed by the caCORE tool. XMl is simply the format of the file being
processed. It is understood that EA can create an .xmi file and that ArgoUML creates a
file with a .uml extension.

Modeling Constraints
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Some of the caCORE tools have recommendations and constraints for the UML
models to be used with the programs. Those constraints most pertinent to the SIW and
UML loader are identified below.

Constraint 1: Ignored UML Elements—While UML class elements are recognized by
caCORE tools, and those classes may contain both attributes and operations,
operations are ignored by the caCORE tools.

Constraint 2: Attribute Types—Each attribute must have a type assigned to it, and
the type must be a Java primitive data type or one of the Java wrapper classes. Each
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Java wrapper class must be defined within the model under the appropriate java
package (e.g., java.lang.String).

In accordance with object-oriented design principles, attributes of a class that are of a
complex type should be modeled as associations. The only exception is if you create a
“caDSR Value Domain” stereotyped class in your UML model. For a UML attribute to
use this value domain, the model owner must add the tagged value “CADSR Local
Value Domain” / “My Value Domain” as described later in Pointing a UML Attribute to a
Local Value Domain on page 19.

Constraint 3: Recognized Relationships—The caCORE tools recognize association
and generalization (inheritance) relationships. In addition, the UML Loader records
aggregations and compositions when registering metadata, but for the purposes of
generating CDEs, these types of relationships are treated as simple associations.

Constraint 4: Association End Role Names—Both ends of each association should
be given a role name (source role and target role).

Constraint 5: Association End Multiplicity—The multiplicity of each association end
must be specified at both ends.

Constraint 6: Association End Navigability (Directionality)—The navigability of
each association must be specified.

Constraint 7: Packages and the Logical Model—Each model should be placed
under the Logical Model package. Classes in the model need to be placed under at
least one package under the Logical Model package (for example, add a package
named “domain” and place the classes under that). There can be any number of
packages under the Logical Model package and you may add them to whatever level
depth you choose. Note that all packages under the Logical Model package must
conform to Java package limitations (e.g., ho spaces).

Constraint 8: UML Descriptions —LL classes and attributes must have textual
descriptions associated with them. This means that a definition for each class and each
attribute must be entered into the model using the CADSR_Description tagged value.
The SIW will present an error for any element that does not contain descriptions for an
element. This information is necessary to let the EVS curators know what the purpose
of the element is and therefore to properly map it to an EVS concept.

The text provided in the CADSR_Description tagged value is the information that
appears in the UML Class Definition or UML Attribute Description field of the SIW.

You may have up to eight CADSR_Description tagged values for each element
(CADSR_Description, CADSR_Description_2, CADSR_Description_3, etc.). If you
have multiple CADSR_Description tagged values, the text is concatenated, up to a
maximum of 2000 characters. If you are using EA, you are limited to 256 characters per
tag.

The SIW will still recognize the legacy tagged values for classes and attributes
(“documentation” and “description” respectively), however the CADSR_Description
tagged value is preferred.

Constraint 9: Java Limitations—Because the SDK produces a Java-based system,
class and attributes names are subject to the conventions defined by the Java

15



caCORE SIW and UML Model Loader Technical Guide

language. UML models should not use Java reserved words as class or attribute
names (i.e., int, long, class, interface, void, etc.). Also, model elements must
not use hyphens, angle brackets or other reserved characters that will result in Java
compilation errors.

Naming Best Practices

16

To ensure semantic interoperability, you should pay close attention to the class and
attribute naming conventions established by the Sun Microsystems Java Bean
Specification. Decisions as to the names you apply to your UML element can affect
many things, including the automated mapping of the elements to EVS concepts
through the Semantic Connector, the mapping of the elements to common data
elements through the Roundtrip step, as well as the generation of the system code by
the SDK Code Generator.

The following list, while not exhaustive, provides some broad outlines regarding naming
best practices that you should consider during modeling.

Adopt a consistent naming convention, using camel case for class and attribute
names—Where a term is used and re-used within the model, you should make sure
that if the intent and use of the term is the same, that the naming convention and
description for the term is also consistent throughout the model. In addition, the Sun
Microsystems Java Bean Specification establishes the use of camel case for classes
and attributes, and is briefly described below:

e Classes
° One word class names are capitalized (e.g., “Patient” or “Location”).

°  Multiple word class names should have no space between words and the
first and subsequent words are all capitalized. (e.g., SequenceVariant or
PatientAddress).

e Attributes

°  One-word attribute names should be all lowercase (e.g., “name” or
“gender”).

°  Multiple word attribute names should have no space between words and the
first word should be lowercase, while the first letter of second and
subsequent words should be capitalized (e.g., streetNumber or
initialDiagnosisDate).

The camel case convention is not simply a “nice to have” because it enhances
readability; the Semantic Connector step of the SIW parses element names based on
camel case, mapping each part of the name it finds to EVS concepts. In this way, using
camel case in the model helps to automate the annotation process.

Avoid abbreviations and acronyms—To the extent possible and reasonable, avoid
the use abbreviations and acronyms and use full terms instead (e.g., use
‘DatabaseReference’ instead of ‘DbRef).

Do not use jargon—Avoid the use of ‘jargon’ terms where standard terms exist (e.g.,
use “microarray” not “chip”).
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For the above two items, all you have to do is keep in mind that jargon, abbreviations
and acronyms tend to be industry-specific or regionally-based and are not universal.

Do not repeat class names in attributes —Since the attribute is already associated
with the class, repeating the class name is not necessary.

For example, for a class element called “Gene” you would use the attribute “name” not
“geneName.” Using the latter format causes the Semantic Connector to unnecessarily
map the concept code(s) for “Gene” multiple times for a single element, which is
semantically undesirable. While any repetitive naming should be caught during the
curation process, it is good practice to keep these out of the model in the first place.

Do not use Java reserved words as class or attribute names—Using Java
reserved words prevents the SDK Code Generator from compiling the generated
system code. This is also stated as Constraint 9: Java Limitations on page 15.

Using Local Value Domains

Note:

Most model owners use existing caDSR value domains to map to their attributes, and
and you are strongly encouraged to use caDSR value domains whenever possible.
However, you may create local value domains (LVD) within your model by creating
classes and stereotyping them with the proper tagged values (as noted in this section).

In order to use LVDs for attribute mapping, you must create the value domains in the
model, apply value meaning annotations to the value domains, and annotate the
appropriate attributes with the intended value domain mapping before exporting the
XMl file. The SIW cannot be used to map attributes to LVDs.

If you are using LVDs, when your model is submitted for registration into caDSR, the
UML Loader will try to match the LVD to an existing value domain with the same long
name and permissible values, or create new value domains where there is no match.

You also have the option to map an LVD to a caDSR value domain. Doing so will make
reloading easier because the UML Loader will no longer try to find a match based on
long name. However the value domain in caDSR will not be changed in any way to
reflect any changes to the LVD that might be in your model.

Creating Local Value Domains

For the UML Loader to create an LVD for use with the model’s attributes, the model
owner must first create a UML class in the model and stereotype it as a “CADSR Value
Domain” or an “enumeration.” When a UML class is stereotyped as “CADSR Value
Domain” the SIW identifies it as a value domain rather than an Object Class. The name
of the stereotyped class will become the name of the value domain in caDSR, unless
you map the class to EVS concepts, in which case the class will take on the naming
convention mapped through those concepts.

caDSR naming conventions specify that the representation type should be the last term
in the value domain name, such as in “State Code” where the representation term is
“Code” and not “State.”

LVDs should be created in a separate package from the regular domain objects.

The following six tagged values must be present in the “CADSR Value Domain” or the
“enumeration” class in order to be recognized as a valid value domain.
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CADSR_ValueDomainDefinition - Used as the Value Domain Preferred
Definition.

CADSR_ValueDomainDatatype - Used as the underlying datatype for the
value domain and must be one of the valid caDSR datatypes.

CADSR_ValueDomainType - Used as the underlying value domain type and
must be one of 'E' (for Enumerated value domains) or 'N' (for Non-enumerated
value domains).

CADSR_ConceptualDomainPubliclD - The combination of conceptual
domain public id and version must point to an existing conceptual domain in the
caDSR.

CADSR_ConceptualDomainVersion - The Conceptual Domain tagged value
for this class should be entered as either a whole number or a decimal e.g. 1 or
1.0 for “Version 1.0".

CADSR_RepresentationPubliclD - The Representation Public Id tagged value
for this class should be entered as the public id of an existing caDSR
Representation Term.

CADSR_RepresentationVersion - the Representation Version tagged value
for this class should be entered as either a whole number or a decimal e.g. 1 or
1.0.

The list of optional tags listed below are used to indicate a “top level” concept for a
value domain. This is also referred to as a “referenced value domain.”

In a non-enumerated (N) value domain, the reference to a top level concept indicates
that the values are not explicitly listed as attributes of the value domain class, but that
data values for the attribute are constrained to children of the top level concept.

When a top level concept is present for an enumerated domain (E), this indicates that
the permitted data values are listed explicitly as attributes of the value domain class
and are children of the top level concept.

The following is a list of the optional tagged values for value domains:

ValueDomainConceptCode
ValueDomainConceptDefinition[_n]
ValueDomainConceptDefinitionSource
ValueDomainConceptPreferredName
ValueDomainQualifierConceptCodeN
ValueDomainQualifierConceptDefinitionN[_n]
ValueDomainQualifierConceptDefinitionSourceN

ValueDomainQualifierConceptPreferredNameN

For more information on mapping value domains in caDSR, see Mapping a UML Class
to a Value Domain on page 104
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Value Meanings
Each attribute within a “CADSR Value Domain” or “enumeration” class is considered a
“permissible value.” Mapping concepts to those attributes creates “value meanings.”
Adding permissible values (attributes) to a value domain class and then mapping them
to concepts is the preferred way to create value meanings. Annotation for permissible
values is done the same way as it is for attributes with the exception that the tag names
are different:

e ValueMeaningConceptCode

¢ ValueMeaningConceptDefinition[_n]

¢ ValueMeaningConceptDefinitionSource

e ValueMeaningConceptPreferredName

¢ ValueMeaningQualifierConceptCodeN

e ValueMeaningQualifierConceptDefinitionN[_n]

e ValueMeaningQualifierConceptDefinitionSourceN
¢ ValueMeaningQualifierConceptPreferredNameN

The value meaning name is created by concatenating the concepts mapped to the
permissible value. The value meaning description is created by concatenating the
concept definitions mapped to the permissible value.

Pointing a UML Attribute to a Local Value Domain
In order to indicate that a UML attribute should use a value domain defined within the
model, the model owner should add a tagged value of type “CADSR Local Value
Domain” to the attribute in the model. The value is the name given to the LVD.

For example, the model owner has created a class that has been stereotyped “CADSR
Value Domain” with a name of “MyValueDomain.” For a UML attribute to use this value
domain, the model owner adds a tagged value called “CADSR Local Value Domain” /
“MyValueDomain” to the attribute.

Again, this must be done in the model before exporting the XMl file for processing
through the SIW.

Generating the XMI file for the SIW

The SIW uses a pre-processor called the XMI Handler to extract the XML tags needed
to perform a semantic annotation of UML classes, attributes and associations from the
UML model. It also extracts various other model features and any caCORE specific
tagged values that were entered by the model owner.

If you are exporting from EA, you must be sure that the DTD option is not checked and
that the EA Roundtrip option is checked. The extension for the exported file must be
-Xmi.

If you are using ArgoUML as your modeling tool, save your model as a file with a -uml
extension.
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Note: The “Fix XMI” task is no longer needed to prepare the file for use with SIW or
caAdapter. Therefore the XMI file can be imported and exported from your modeling
tool to make changes without losing any existing SIW concept annotations.
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CHAPTER

USING THE SEMANTIC INTEGRATION

WORKBENCH (SIW)

This chapter provides information regarding how to open the Semantic Integration
Workbench (SIW), an overview of the options available in the SIW, how to navigate the
SIW Viewer, and how to customize the viewer to your personal viewing preferences.
The last sections of this chapter provide instructions for saving changes to your XMl file
and for updating your UML model with the changes made through the SIW.

Topics in this chapter include:

Introduction

Introduction on page 21

Pre-Requisites to Using the SIW on page 22

Launching the SIW on page 23

Using the SIW Viewer on page 27

Setting Viewer Preferences on page 36

Saving Changes to a File on page 39

Updating UML Model Definitions with SIW-Generated Changes on page 40

The Semantic Integration Workbench (SIW) is designed to help UML model owners
work through the semantic annotation process, and to remove (whenever possible) the
need for users to understand the more complicated details of semantically integrating
their model to other models registered in the caDSR. The caDSR is a metadata
repository managed by the NCICB that is designed to provide consistently managed
metadata for use by other research systems and data repositories.
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The SIW essentially helps UML model owners bring the metadata for their models into
line with the models used by other facilities. To do this, the SIW contains the following
capabilities:

e Automates the searching for and (where possible) the matching of UML
elements to items already resident in a controlled vocabulary (EVS).

e Streamlines semantic annotation by offering direct queries to the NCI
Thesaurus, inserting the concept information from the search into the user’s file
in the SIW, creating the appropriate tag names automatically. This eliminates
syntax errors in the final XMl file.

e Allows for curation of the XMl file which maps existing or new EVS concepts
(not yet in NCI Thesaurus) to classes and attributes. (Curation is performed by
NCICB personnel.)

e Allows for mapping of attributes to existing caDSR data elements, either
automatically through the Roundtrip step or manually through the SIW viewer.

e Allows review of the final XMl file before it is loaded, providing for individual
review and acceptance of each entry.

e Ensures that files submitted for loading into the caDSR have been checked for
missing information and validated using Silver Level Compatibility rules.

Pre-Requisites to Using the SIW

Note:

Using the SIW requires that you have a valid XMl file exported from either Enterprise
Architect (EA) or ArgoUML and that you have the Java Web Start application installed
on your computer. For more information, see the sections that follow.

Throughout this guide, the term “XMI” refers to the type of file output from either
your UML modeling software or the SIW itself. If you are using Enterprise Architect,
the output file will have an .xmi extension; if you are using ArgoUML, the output file
will have a .uml extension. In either case, these are referred to as XMI files.

Possessing a Valid XMI File

Note:

Before you can use the SIW, you need to have a valid file for the SIW to work with. If
you are starting with an un-annotated file, be sure you have a valid export of an .xmi file
from EA or have saved a .uml file from ArgoUML. If you have not generated this file yet,
see Generating the XMl file for the SIW on page 19. If you are using EA and your file
was not exported using the appropriate options, the SIW will not be able to parse the
file properly for use.

The “Fix XMI” task (used in previous versions) is no longer needed to prepare the file
for use with SIW. Therefore the XMI file can be imported and exported from your
modeling tool to make changes without losing SIW concept annotations.

Installing/Verifying Installation of Java Web Start

22

The SIW is a Java Web Start application. If Java Web Start is installed on your
computer, the SIW will launch when you open the SIW URL. SIW always to checks to
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be sure you are using the most current version of Java Web Start. If you are not, the
SIW automatically retrieves the update for you.

If you do not have Java Web Start installed, you will receive a File Download box when
you attempt to access the SIW URL.

File Download @

Do you want to save this file?

MName: uml-loader.jnlp
Type: Unknown File Type, 1,86 KB
From: cadsr-dev.nci.nib.gov

Save ] I_ Cancel ]

‘While files from the Internet can be useful, some files can potentially
harm your computer. If you do not trust the source, do not save this
file. What's the risk

Figure 2.1 SIW File Download dialog box

If you receive this dialog box, it means that the SIW did not find the application needed
to open the SIW file. Click Cancel, and go to the Sun web site (http://java.sun.com) to
download and install Java Web Start.

Launching the SIW

Once you have a valid UML model file to use, and that you have Java Web Start
installed, you can begin using the SIW.

The instructions in this section and throughout this chapter use the “browser-launch”
method of accessing the SIW. This is done purely for convenience and you do not need
a browser to access the SIW. If you prefer, you may use any of the following methods:

e On UNIX or LINUX, type jJavaws at the command prompt

¢ On Windows, launch the JavaWebstart application (the program may appear in
your Start menu)

e Save the siw. jnlp file to your computer and double-click it to launch the SIW.

e Open the SIW URL: http://cadsrsiw.nci.nih.gov/.
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To launch the SIW:

1. Access the following URL using your browser: http://cadsrsiw.nci.nih.gov/.

2. The Java Web Start dialog box appears, showing the Semantic Integration
Workbench start-up progress. If you have never used the SIW or not used it in
some time, this may take a few minutes.

Java Web Start rz|
Downloading application.

Name: Semantic Integration Workbench 4.0.0.0
Publisher: MNCI
From: http: ficadsrsive.nci.nib,goy

Estimated time remaining: 29 seconds
T | Eanel ]

Figure 2.2 Java Web Start dialog box and progress bar

3. If you receive a Security Warning dialog box, enable the Always trust content
from this publisher checkbox and then click Run.

Warning - Security P§|

The application's digital signature cannot be verified.
Do you want to run the application?

Name: Semantic Integration Workbench 4.0.0.0
Publisher: Christophe Ludet

From: http: ficadsrsiv,nci,nib.gov

Run Cancel

[T ] The digital signature cannat be verified by a trusted saurce, Crily

! Infarmation...
W run if wou trust the arigin of the application, ore Snmrmatian

Figure 2.3 Security Warning dialog box requesting approval to run the application

Note: During installation, portions of the application are downloaded to cache, but the entire
application itself is not downloaded.
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After the start-up process completes, the SIW opens, starting with the SIW Welcome
screen.

B semantic Integration Workbench 4.0.0.0 @

welcome ta the Semantic Integration Workbench 4.0.0.0

Chaose From the Following SIW Cptions:

(&) 1. Review Unannotated %MI File (Model Swnerk

() &, Perform %MI Roundtrip (Model Owner)
() 3. Run Semantic Connector (Model Owner)
() 4. Curate ¥MI File (Vocabulary Reviewer)

() 5. Review Annotated XMI File (Madel Owner)

) The private AP is offered as an atemative to the caCORE public AL
Use Private API
[ T T requizes that the userbe inside the NCI network or use VPN,

Figure 2.4 Semantic Integration Workbench Welcome Screen

The top of the SIW Welcome screen shows which version of the SIW you are working
with (it should be the latest release version). The main portion of the screen lists the
five options or steps for using the SIW.

For the most part, the SIW steps should be performed in the order in which they appear
on the Welcome screen. However, some of the steps are optional and only apply if you
are working with a new version of a previously loaded XMl file, or if you intend to have
your model uploaded to the caDSR.

The options available through the SIW include:

Review Unannotated XMI File (Model Owner)—This step allows the model owner to
view the XMI representation of their UML model. It provides an easy way to check the
model for missing object definition tags or other problems with the file that will require

changes before continuing. This step should be performed with all newly exported files
before running any other SIW options.

When you view an XMI file in “Unannotated” mode, the errors listed include only
syntactic errors, such as missing element descriptions. This allows you to easily see
where additional information must be added to or changed in the model in order for the
SIW to successfully annotate the model (map to EVS concepts or caDSR data
elements) in later steps.

See Reviewing an Unannotated XMI File on page 42 for more information on
performing this step.

Perform XMI Roundtrip (Model Owner)—This step automatically annotates the XMl
file (or updates existing annotations) based on another previously loaded model. The
Roundtrip task can save model owners a considerable amount of time because it

automatically maps the XMl file's attributes to existing caDSR common data elements
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(CDEs). The automated matching is based on the new model having used exactly the
same attribute names as a previous model.

See Using the XMI Roundtrip Mode on page 48 for more information on performing this
step.

Run Semantic Connector (Model Owner)—This step launches the Semantic
Connector, which performs an EVS search against the name of each element in the
XMl file (using recognition of camel case to identify those elements with multiple parts).
When matches are found, the SIW attaches one or more EVS concepts to each
element. This process produces an annotated XMl file (with “FirstPass” appended to
the front of the file name) that can then be reviewed by the owner (if desired) before
being submitted for curation.

See Running the Semantic Connector on page 54 for more information on performing
this step.

Curate XMI File (Vocabulary Reviewer)—This step is performed by the EVS concept
curation team. During this step, the EVS team uses new or existing EVS concepts to
annotate the model, and adds and removes concepts as they determine necessary.
The curated XMl file is then returned to the model owner for review and final approval.

This and the next step of the SIW process are typically the most iterative, meaning that
very often, the file is returned to the curation team after model owner review, and then
back to the model owner after re-curation and verification.

See Curating XMI Files on page 58 for more information on this process.

Review Annotated XMI File (Model Owner)—This step, along with the Curate XMl
File step (above) will likely be performed several times until all of the model elements
are mapped properly. This step allows model owners or model reviewers to review
element annotations, search EVS for concepts, and where necessary, change the
mapping between a class or attribute and their EVS concept(s). Users may also choose
to map annotated elements to existing caDSR CDEs and/or value domains.

This mode of the SIW also provides the ability to run validation checks to ensure that
the concept information in the XMl file corresponds with EVS concept information, or
that any differences between the XMl file and EVS are determined (by the model
owner) to be appropriate and valid.

After curation and review, the model owner can “verify” each element in the file. Once
all elements have been verified by the model owner, the file is considered to be
complete. The final outcome of this step is a fully annotated XMI file that can be used to
register the model into caDSR, and which can also be used as input to the next version
of the model.

See Reviewing an Annotated XMI File on page 74 for more information on performing
this step.

Use Private APl —At the bottom of the Welcome screen is a checkbox that allows you
to select to use a Private API for SIW processing. Using the Private API performs
somewhat faster than using the public API, but you must be connected to the local NCI
LAN via VPN or from behind the firewall to use it.
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Package Filtering—All of the SIW options can be run on a full XMl file, or you may
choose to run each step on only selected elements of the file. When you identify the file
to parse, you may select to Choose Classes and Packages. Selecting this option
adds a screen to the processing wizard that lists the Packages within the XMl file.
Expanding a Package shows the classes contained within that package and lets you
identify only those you want to process for that step.

Using the SIW Viewer

The SIW viewer is the window that appears whenever you select to review or curate
your XMl file. The viewer shows the model elements parsed from your XMl file and
details about each of those elements. What details you see depends on several things,
including the current state of your XMI file (unannotated, annotated, curated). However,
the basic attributes of the SIW viewer remain the same, regardless of where you are in
the semantic integration process.

This section discusses navigation as well as the functionality available through the SIW
viewer, including setting Viewer Preferences. Since the viewer is used to both review
and make changes to your XMl file, detailed information regarding how to use specific
functionality in the viewer resides in the sections that discuss the steps in which those
actions should take place.

Topics in this section include:
¢ Navigation Tree on page 28
e Detail View on page 29
e Errors/Log Panel on page 34

e Setting Viewer Preferences on page 36.
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The SIW viewer window has three sections: the navigation tree, the detail view and the
errors/log panel.
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Figure 2.5 SIW Viewer with sections labeled

As is typical of “Windows Explorer-like” applications, you can change the size of the
sections of the window by hovering your mouse over the border of that section until the
mouse cursor becomes a two-way arrow, and then clicking and dragging the border in
the direction of the change you want to make.

Navigation Tree
The navigation tree, located on the left side of the viewer, is a tree-view of all of the
elements resident in the model (or packages if only a portion of the file was processed).
Selecting an element from the Tree opens a tab in the detail view of the window,
showing detailed information for the selected item.
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If you are viewing a curated or annotated file, the navigation tree may include
checkmarks on elements in the file indicating that the mappings for those elements
have been reviewed and checked as “Human Verified” or “Model Owner Verified.”
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Figure 2.6 Navigation Tree showing fully verified and partially verified classes

When the viewer first opens, all nodes of the tree are expanded to display all internal
nodes, however each node can be expanded or collapsed by clicking the + (plus) or -
(minus) sign to the left of the node.

By default, navigation tree items are listed in the order of the structure of your model as
indicated in your XMl file. In addition, classes are listed first, with associations
appearing at the bottom of the tree. You can change these aspects of the navigation
tree display using SIW Viewer Preferences (available through the Edit menu in the
viewer). See Setting Viewer Preferences on page 36 for more information.

Detail View
The detail view is located in the top-right section of the viewer and is blank when the
viewer first opens. Highlighting an element in the Navigation tree opens a tab for that
item in the detail view. What information appears in the tab depends on what type of
item is selected (class, attribute or association) and the current state of the file you are
working with (annotated, unannotated, curated, reviewed, etc.).

For example, if you click on a class or attribute node, the detail view may show only
UML Class Documentation text or it may show concept and value domain information,
depending on whether or not the selected item has been annotated with concept
information yet.

Navigation Note—The detail view can contain multiple tabs at any given time, and will
open a new tab for different types of elements selected in the navigation tree. The title
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on each tab corresponds to the node information it contains. To close a tab, click the
“X" located to the right of the node name on the tab.
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Figure 2.7 SIW Viewer with multiple tabs open in the Detail View

Besides definition and/or concept information about the node selected, the detail view
also contains buttons that perform a variety of tasks. Some buttons, like Map to CDE,
do not appear until the file and/or the node selected has reached a certain level of
annotation. Other buttons always appear and function as follows:
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Previous - Changes the selection in the navigation tree to the item immediately
preceding (above) the currently displayed element.

Next - Changes the selection in the navigation tree to the item immediately
following (below) the currently displayed element.

Add - Opens blank fields for entering concept information, allowing you to add a
Primary Concept or Qualifier Concept (if a Primary Concept is already mapped)
to the item.

Search EVS - Opens a search box allowing you to search the NCI Thesaurus
for concept information to add or update for the item. The Search EVS button
always appears next to concept code field, either for existing mapped concepts
or as a function of clicking the Add button (to populate blank concept
information fields).

Apply - Applies the changes made to the concept information. The Apply button
is disabled until all concept fields are populated for newly added concepts, or
until a change is made to existing concept information.

You must click Apply before navigating away from the changed item’s node, or
your changes will be discarded. The SIW prompts you to apply your changes if
you attempt to view another node before clicking Apply.
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Chapter 2 Using the Semantic Integration Workbench (SIW)

Clicking Apply is not the same as saving the file. Apply simply applies your changes to
the currently open session. You must still save the file (File > Save or File > Save As)
to create an updated XMl file containing the applied changes.

The following sections describe what information appears in the detail view and how
that information is displayed, depending on the type of node selected and the
information available for the selected item.

Viewing an Unannotated XMI File

An “unannotated” XMl file is one where none or some of the classes and attributes in
the file have been annotated with EVS concepts. If you are working with a new version
of a new system that has never been through the caCORE semantic integration
process, it is likely that your file contains no annotation. If a previous version of your
UML model has been through semantic integration, some (even most) of your model
elements may be mapped to either EVS concepts or to caDSR data elements, however
there are likely new elements that need to be annotated.

When viewing an unannotated file, if you select a class or attribute from the navigation
tree and the detail view remains empty (no information appears), this indicates that the
element does not have a description tag in the model. Model owners must provide
descriptions for each element in the model.
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Figure 2.8 Class element selected, with no concept information or UML definition

UML element descriptions are required because they allow EVS curators understand
the model owner’s purpose and intent for the element. This provides for more accurate
mapping of the element to existing EVS concepts and for easier creation of new
concepts when applicable.

A note about UML element descriptions—The description tagged values in the UML
model should describe the element to which they are attached. Model owners can now
use a tag called CADSR_Description to tag these elements in their model. If this tag is
present, the SIW automatically uses this information to populate the UML element

description field. This allows model owners to differentiate caDSR-specific descriptions
from other descriptors used for the element in the model. If the model element does not
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have any CADSR_Description tags, the other existing description tags are used (as
previous versions did) to provide a description for the element.

If you select a class or attribute node and a UML description appears, but there is no
concept information, this means that the element contains a description in the UML
model, which has been exported into the XMl file, however the item has not yet been
mapped to an EVS concept.
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Figure 2.9 Class element selected showing a UML definition but no concept information.

From this point, you can manually add concept information to the element (by clicking
Add), or wait to process the file through the Semantic Connector to have the element
mapped for you (using the closest match to the element name found in EVS).

Viewing an Annotated XMI File

An “annotated” XMl file is one where all of the elements in the file have been mapped to
either EVS concepts or directly to caDSR data elements. If you select a class or
attribute from the navigation tree and the detail view displays concept information for
the element, this means that the class or attribute has been mapped to one or more
concepts in EVS or “annotated.”

By default, concept information appears in “semantic order” meaning that it appears in
an order consistent with how the concept names will be positioned when forming the
name of the element in caDSR.

For example, if the element is a class titled “Date” it will likely have a single concept
mapped to it — a Primary Concept called “Date.” However, if the element is an class of
the Date class titled “diagnosisDate” then the element will likely have two concepts
mapped to it — a Primary Concept called “Date” and a Qualifier Concept called
“Diagnosis.”

In this example, the detail view will show the Qualifier Concept first and the Primary
Concept second because that is how the element is to be named: “diagnosisDate.”
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Figure 2.10 Attribute element selected, showing mapped concept information

The detail view shows the original UML definition at the top, followed by the Qualifier
Concept items (if there are any) with the Primary Concept below that. The value
domain (if mapped) is listed at the bottom. Notice that the Concept Summary Code and
the Concept Summary Name are the codes and names of each of the mapped
concepts in semantic order (qualifier(s) + primary = concept nhame). This Concept
Summary Name should match or closely match the actual name of the element.

If necessary, you can change the order in which the concept information appears in the
detail view using options available in the Viewer Preferences. See Setting Viewer
Preferences on page 36 for more information.

Navigation Note—The concept information section of the detail view will likely scroll
(and may scroll significantly) because it contains more information than can be
displayed at once. Figure 2.10 above shows an expanded detail view, in order to
display as many pieces of the concept information as possible. However, if you cannot
see concept information in the detail view for an element, scroll to see if the information
lies above or below the portion of the view being shown.

The detail view also contains additional buttons located to the right of the concept
definition fields: up and down arrows and an “X” button. More detailed information
about these buttons appears in Changing Concept Information in Review Mode on
page 78.
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Viewing Associations

By default, associations appear at the bottom of the navigation tree. If you select an
association node from the navigation tree, four tabs appear in the detail view: Detall,
Role, Source, and Target. The elements defined for an association (the Role, the
Source and the Target) can be annotated with concepts just like other elements in the
model, although this is not required for the file to be considered fully annotated.

The Detail tab shows the connection details for the association, including direction,
source class, source role, source multiplicity, target class, target role and target
multiplicity.

If the associated elements are annotated with concept information, the tabs
corresponding to those elements display that concept information. Those tabs also
contain the same buttons as other element detail tabs (Previous, Next, Add, Apply,
and Search EVS where applicable). This allows you to manually map those association
elements to EVS concepts if desired.

While you can manually map an association’s elements to EVS concepts, you cannot
change an association’s connection information through the SIW.

Errors/Log Panel

34

Located in the bottom-right section of the viewer, the errors/log panel provides two tabs
containing information about the file currently open in the viewer. The Errors tab lists all
errors and warnings flagged during processing of the XMl file.

Located behind the Errors tab in the bottom-right section of the viewer is the Log tab,
which provides a log of the file parsing process.

Errors Tab

One valuable feature of the SIW is the ability to quickly isolate and identify errors in the
source files, primarily where there is missing or inaccurate information. When the SIW
encounters issues while processing a file, those items are flagged as either errors or
warnings, and are then displayed in the Errors tab at the bottom of the SIW viewer. The
Errors tab provides a description of the error and identifies the source of the error.

Errors are presented using a tree-structure in order to make it easier to locate the
source of the error in the navigation tree.

e Errors relevant to a class are shown as a child node to that class’ node.

e Errors relevant to an class appear with the full path of the attribute (package/
class/attribute/error).

Note: The error tree does not appear if the file contains no errors.
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Figure 2.11 SIW Viewer showing an expanded Errors tab

The information in the Errors tab can be exported by right-clicking in anywhere in the
Errors tab and selecting Export Errors.

The SIW performs checks for four basic types of errors:

Concept Errors - There are several validation rules that are applied to each
model. Any violations of these rules appear in the Errors tab with the source of
the error and a description of the problem. Concept errors are most often
triggered by missing class or attribute information (missing UML description
tagged values or missing concept information).

Duplicate Errors - If two Object Classes (OCs) have the same Public Id or
Preferred Name a duplicate mapping error will appear. A duplicate mapping
error can also occur if two data elements belonging to the same OC have the
same Preferred Name.

Association Errors - Associations that are missing names on the end of the
association that has an arrowhead will cause an error. For example, you need a
target name for source-->destination associations; you need a both a target
name and a source name for bi-directional associations (source <->
destination).

Value Domain Errors - If a definition, Vdtype, datatype, Public Id, or Version
are either missing or invalid, an error will appear. If a value domain is in the
model but is not used by a data element in the model, this will cause a warning
message to appear. Finally, if two value domains are mapped to the same
concepts this will also cause an error.

Important Note about updating the Errors tab—The Errors tab information is
generated at the time you open the file; the SIW does not update the error list while you
are editing. If you have made changes want to regenerate the error listing, save the file
and exit the SIW. Then re-open the SIW and select the file you saved. This will update
the Errors tab information to reflect the status of the updated file.
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Log Tab
The Log tab provides detailed parsing and runtime information about the currently open
file. Each log event is represented as a line in the log tab. Log events are organized into
four categories:

e Errors: These include errors encountered in the SIW, in the model being parsed
or both.

e Warnings
e Info: Events that may be helpful to users
e Debug: Information that may be useful to developers.

Right-clicking in the Log tab allows you to add or remove any of these categories
from the tab. This may be useful if you need to see only certain types of log information.

Setting Viewer Preferences

The SIW viewer allows users to set preferences for using the SIW. Most of the
Preferences options available have to do with how the information in the viewer is
presented, however a few of the options control the functionality of certain features
available through the viewer.

To open the SIW Viewer Preferences dialog box:

¢ From the main menu of the SIW Vlewer, select Edit > Preferences.

[] ¥iew Assaciations in Class Tree

|:| Display UML Description Last
Sutomatically Search EVS on EXS link
[ Use Private Api  [] Display Primary Concept First
[] Display Inherited Attributes
[] Sart Elements by Mame

[]Use Pre-Thesaurus to Yalidate Concepts

[ [a]4 H Cancel H Apply l

Figure 2.12 SIW Viewer Preferences dialog box

By default, only the Automatically Search EVS on EVS Link option is enabled. All
others are disabled by default. Each of the available options is described in more detail
in the sections that follow.

View Associations in the Class Tree

By default, model associations are listed all together at the bottom of the navigation
tree. Enabling the View Associations in the Class Tree option in the SIW Viewer
Preferences changes the navigation tree view so that associations appear as children
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to (nodes beneath) their related classes. This is useful when trying to identify the
associations for a particular class.

[@ Semantic Integration Workbench 4.0.0.0 - C:/Documents and Settings/BronwyniMy Documents/AlLLNIH_Doc_Downloads/U... Q@@
File Edit Element Run Help

= @ Assaciations La :
) % :z:gz(cf)”ed“’”m‘-*)"59"““’ Patient Class node with
related Associations

= Patient 4
] ethriccroup / listed as part of the
Class node in the tree.

patientBirthDate
_l patientId
i ,_l patienthame
j patientSex
=[] Assodations

Q subjectCallection{..*): :patient(1)
Q studyCollection(d, . *): :patient(1)
Q patientCallection(d. *): :dataProvenanc
B E patient(1)
—--Q Equipment:

15) deviceserialumber
-5 id
-|Z] institutionAddress
;l institutionkame
-] manuFacturer

1) manufacturerModelrlame
j softwarelersions

j statianMame =
=) [T Associations Errors | Log
. seriesCollertion(0. .*): :equipmenti1) o[ Classes A
=3 dlinicalTrislsponsor - =3 curationData

-|Z]) coordinatingCenter i 1= cderd

3 id b Concept: C9684 is missing its ConceptDefinitionSource,
-j sponsorhlame b - Concepk: C9684 is missing its ConceptDefinition.
< >

S
oo nih.nci. ncia . domain

Figure 2.13 SIW Viewer with Associations listed under the Class nodes in the Navigation
Tree

The View Associations in the Class Tree option does not appear in the Curate XMI
mode of the SIW because EVS curators do not work with association elements, and
therefore associations do not appear in the SIW viewer in this mode.

Display UML Description Last

As noted in the Detail View section of Using the SIW Viewer on page 29, by default the
UML descriptions for each element are listed first in the detail view, followed by the
concept and value domain information where present.

Enabling the option Display UML Description Last in the viewer Preferences changes
the display so that the UML description appears at the bottom of the detail view instead
of the top.

Automatically Search EVS on EVS Link

Note:

The Automatically Search EVS on EVS Link option is enabled by default. This
means that if there is text in the Preferred Concept Name field when you click Search
EVS, the SIW automatically searches EVS for a synonym of that term and returns the
results if any are found.

When this preference is disabled, the search dialog box appears, but no search is run
without manually entering search criteria and clicking Search.

If you disable this option and then click Search EVS, the previous search information
may appear in the search dialog box. This information is NOT cleared between
searches. Replace the Search text box text and click Search to search EVS.
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Use Private API

Enabling the Use Private API Preferences option simply ensures that the Use Private
API option on the SIW Welcome screen is always checked. This is useful if you
typically run the SIW while connected to the NCI LAN (either through VPN or from
within the NCI network). It simply removes the need for you to check the checkbox on
the Welcome screen.

Display Primary Concept First

As noted in the Detail View section of Using the SIW Viewer on page 29, by default the
Primary Concept information for each element is listed below any Qualifier Concepts
mapped to the item, which mimics the semantic order for the name of the element.

Enabling the option Display Primary Concept First in the viewer Preferences
changes the display so that the Primary Concept appears above the mapped Qualifier
Concepts. In addition, if there are multiple Qualifier Concepts for the item, they are now
listed in numerical rather than semantic order.

The UML description still appears at the top of the Detail view for each element unless
you have enabled the Display UML Description Last option (see Display UML
Description Last above).

Display Inherited Attributes

Enabling the Display Inherited Attributes changes the navigation tree to show the
inherited attributes for any class that inherits attributes from a super class. The
attributes appear in an Inherited Attributes node below the class.

Enabling this option is useful for if you know you have inherited attributes for class
items, in order to call attention to them.

Sort Element by Name
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As noted in the Navigation Tree section of Using the SIW Viewer on page 28, by default
the elements in the navigation tree appear in the order in which they exist in the UML
model (as indicated in the exported XMl file).

Enabling the option Sort Element by Name in the viewer Preferences changes the
display so that the elements in the navigation tree are sorted alphabetically. Each class
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appears in alphabetical order (by name), with each of the elements within the class also
listed alphabetically.

G - o/x)
File Edit Element Run Help
= [ Classes ~

—Q Annatation
=1 [ Assodations 4+———— Tree elements sorted
i 15 annatationFie(1) alphabeteally by Class name
/5] series(1)::annotationCollection(D..*) 3
- [5] annetationType with sub-nodes also sorted
= FilePath
=) filesiee
(=) id
-4 =) seriesInstancelID
=) submissionDate
=5 dlinicalTrialProtocol
= [0 Assodiations [@ Preferences El
Q protocolCollection(D. . *): krial(1)
/5] subjectCallection(d. *4::pratocol{1) [ ¥iew Assaciations in Class Tree
~{Fid
- j :)rotoco\ld D Display UML Description Last
= pratocolame Automatically Search EVS on EVS link
=2 dlnicalTrialsite:
=3 Associations [[] Use Private Api ] Display Primary Concept First
Q site(1):isubjectCollection(D, . *)
J id [] Display Inherited Attributes
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Deselecting this option resets the navigation tree to again display the classes and their
associated elements to their order in the XMl file.

Use Pre-Thesaurus to Validate Concepts
By default, if you select Validate Concepts from the Run menu (available in either the
Curate XMI File mode or Review Annotated XMI File mode), the SIW validates the
concept information in the XMl file against the information in the NCI Production
Thesaurus. Enabling the Use Pre-Thesaurus to Validate Concepts option causes the
SIW to use the Pre-Production NCI Thesaurus to validate concepts instead.

The Pre-Thesaurus is pre-release version of the next release of the NCI Thesaurus,
publicly accessible through the DTS server. As is implied, the Pre-Production
Thesaurus is more recent than the Production version and as such contains newer
concepts. Changing this option in your Viewer Preferences may be useful if you are
working with an XMl file that you know contains mapping to newer EVS concepts.

Saving Changes to a File

Clicking Apply after making changes to an element is not the same as saving the XMl
file. Apply simply applies your changes to the currently open session. You must still
save the file using the File > Save or File > Save As commands to create an updated
XMl file containing the applied changes.

Use File > Save to overwrite the original file you opened in the SIW viewer. Use File >
Save As to specify a different name or location for the file.

The Status Bar at the bottom of the SIW viewer window informs you whether or not the
file was successfully saved.
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XMl files that were created using Enterprise Architect are always saved using an “.xmi”
file extension. XMl files created using ArgoUML are always saved using a “.uml” file
extension.

Curated and verified files should be saved with the term “annotated” appended to the
front of the filename. For example, if the original file name was
FirstPass_myModel .xmi then you would save the file as

Annotated_ FirstPass_myModel .xmi.

Reviewed and verified files should be saved with the term “approved” appended to the
front of the filename. For example, if the original file name was
Annotated_FirstPass_myModel .xmi, then you would save the reviewed file as
Approved_Annotated_FirstPass_myModel .xmi.

Updating UML Model Definitions with SIW-Generated Changes

40

One problem frequently encountered in the semantic integration process is the
discovery that the element description tags from the UML model are not present, or that
they need to be updated. Prior to the SIW, there was no way to conveniently get these
changes into the XMl file for loading to caDSR. Since these tags are mandatory, these
tags must be present and should be as accurate as possible.

With the SIW and careful planning, you can change or update the element description
tags in the UML model, export them to XMI and go back through the SIW process,
while preserving the EVS concept curation before loading the model into caDSR.

In summary, the workflow is as follows:

1. The new UML documentation and description tagged values have to be added
to the XMl file using your UML modeling program (EA or ArgoUML). In order to
get this information back into the model, import the XMl file you have been
working with in SIW.

2. Add the needed information to the model, and then the export the model again.

3. Open the newly exported file in Review Annotated XMI File mode. Notice that
the SIW contains the new UML description information and still maintains all of
the existing EVS concept and caDSR CDE mapping.

As stated in UML Element Descriptions and Annotations on page 46, the SIW now
recognizes the CADSR_Description tag for use as element description tagged values.
You can have up to eight of these tags per element if needed (EA imposes a limit of
255 characters per tag). When re-importing the XMl file back into your UML modeling
software, the elements in the model will be annotated with these tagged values.



CHAPTER

SEMANTICALLY INTEGRATING YOUR

UML MODEL

This chapter provides detailed information on how to use the SIW to semantically
integrate your UML Model, making it compatible with other registered systems. The
SIW contains five steps or options, and which of those you run depends on the level of
caBIG compatibility you wish to achieve and whether you are starting with a new model
or you are working with a previously loaded version of your model.

Regardless, the information in this chapter will allow you to use the SIW to create a fully
annotated XMl representation of your UML model that can subsequently be loaded into
the caDSR (using the UML Loader). The final annotated XMl file can then be used as
input to the next version of your system model.

Topics in this chapter include:

Reviewing an Unannotated XMI File on page 42
Using the XMI Roundtrip Mode on page 48
Running the Semantic Connector on page 54
Curating XMI Files on page 58

Reviewing an Annotated XMI File on page 74

Troubleshooting on page 89
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Reviewing an Unannotated XMI File

42

The first option listed on the SIW Welcome screen is the Review Unannotated XMl
File (Model Owner) option. As indicated, this step is performed by the owner of the
UML model.

Reviewing an unannotated XMl file is the process of reviewing an XMl file that has
been exported from your UML modeling program (either EA or ArgoUML).

The purpose of viewing your unannotated XMl file through the SIW is so that the
program can flag any problems it finds in the model. This allows you to easily review
and fix those issues before continuing, and to confirm that the XMl file you may be
using for the caCORE SDK is valid for use with the SIW. Typically the errors reported in
this mode are due to missing tagged values (e.g., UML description tags).

Input To Step: The original UML model in XMI format, exported from either EA
(saved with an .xmi file extension) or ArgoUML (saved with a .uml file extension).
The filename can be anything you like, as long as you can browse to and select it.

Example: myModel .xmi for an EA export; myModel .uml for an ArgoUML export.

Output From Step: If you make changes to the file during this step, you can save
the file using the File > Save or File > Save As command. As is typical, using File
> Save will overwrite the existing file. However, you may want to use File > Save
As in order to identify that this file differs from the actual UML model output.

While you can save the file using any name you like, we recommend using a naming
convention consistent with the naming convention already established for prior
releases (if applicable), or a naming convention that will carry to future versions.

To Review an Unannotated XMl file:

1. Be sure you have a valid UML model export file to review. For information on
exporting your UML model, see Generating the XMl file for the SIW on page 19.

2. Open the SIW URL: http:\\cadsrsiw.nci.nih.gov.

3. From the SIW Welcome screen, select option 1. Review Unannotated XMl File
(Model Owner) and click Next. The file selection screen appears.
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B semantic Integration Workbench 4.0.0.0 -- Review Unannotated XMI File @

Please choose a file to parse
The file: must be in XMI or Argo) UML Format

Click. browse to search For an %MI ar (Argo) UML File

EBrowse

Recent Files:
annotated_training_data_rmodel_v 1_rv13.xmi
FirstPass_roundtrip_NCIA_v3_0_rv2.ami
employes-1-cde ami

cads3-2_01_25_2007 i

[] choose Classes and Packages

Figure 3.1 Select a file for SIW to parse and display for review

If you have used this mode of the SIW before, the last five files used for this option
appear in a Recent Files list located below the filename text box.

4. Identify the file you want to review. You have the following options:

° If the file you want to review appears in the Recent Files list, click on the file
name to populate the filename field with the path/filename.

°  Type the full path and filename into the text box.

° Click Browse to browse for and select the file exported from EA or
ArgoUML.

Note: The Browse function defaults to selecting (showing) only files with an
xmi file extension. If you are using a .uml file, select UML Files from the
Files of Type drop-down list at the bottom of the Open dialog box.

5. If you want to review only portions of the file, enable the Choose Classes and
Packages checkbox. Otherwise the SIW will parse the entire file for review.
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6. Click Next. If you enabled the Choose Classes and Packages checkbox, the
package selection screen appears, listing all of the packages in the file.

B semantic Integration Workbench 4.0.0.0 - Review Unannotated XMl File El

Please select which classes or packages
wou would like to open by check-marking & node.

ﬁ goy. nih.nei, cadsr . domain
ﬁ gow.nih.nci. cadsr.umlproject, domain
ﬁ gow.nih.nei. cadsy . YalueDomain

[ <Back ] [ Next> | [ Cancel ]

Figure 3.2 Package selection screen - lists the packages resident in the file

7. All packages listed are checked by default. Click a checkmark to open a list of
the items contained within the package, and then click to clear the checkmarks
next to any items you do not want the SIW to parse for review. Then click Next.

The SIW displays the file selection screen with a progress bar at the bottom
showing the current action and overall progress. How long this process will take is
determined by the size of the XMl file or packages you are using as well as the
number of errors or warnings the SIW must generate.

B semantic Integration Workbench 4.0.0.0 -- Review Unannotated XMI File rg|

Please choose a file to parse
The file musk be in ¥MI or {Argo) UML Formak

Click browse to search For an %M1 or {Argo) UML file

Recent Files:

-------------------- )
Parsing name

Figure 3.3 Screen and progress bar showing SIW processing of XMI file
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When the SIW is finished, you may receive a Fatal Error in Model dialog box. This lets
you know that there are errors in the file that must be fixed before further semantic
integration can take place.

Fatal Error in Model §|

L ] A

\_“/ DataType is missing For gov.nib.nci.cadsr, domain, Function, symbol

DataType is missing For gov.nib.nci.cadsr . domain, DesignationClasssc
DataType is missing For gov.nib.nci.cadsr , umlproject, domain, UMLALER
DataType is missing For gov.nib.nci.cadsr , umlproject, domain, UMLALER
DataType is missing For gov.nib.nci.cadsr, domain, Permissiblevalue, ve
DataType is missing For gov.nib.nci.cadsr . domain, Address, state
DataType is missing For gov.nib.nci.cadsr, domain, DataElementRelatic
DataType is missing For gov.nih.nci.cadsr . umlproject, domain, TypeEnt 4
< ¥

Figure 3.4 Fatal Error dialog box identifies the errors found in the XMI file

If the Fatal Error in Model dialog box appears, you have two options:

e Click No - This exits the SIW completely. If you know what the problems are,
you can fix the errors in your model, re-export and attempt to review the
unannotated file again.

e Click Yes - This opens the SIW viewer, with the errors and warnings appearing
in the Errors tab.

If your file contains no errors, the SIW viewer appears automatically when parsing is
finished.

[@ Semantic Integration Workbench 4.0.0.0 - C:/Documents and Settings/Bronwyn/My Documents/ALL NIH_Doc_DownloadsfUnZips/fcad... @@]B\
File Edit Elsment Help

= [ Classes ~
) perivedatatlement

3 validvalus

5] DefinitionClassSchemeltem

) objectClass

5 classificationscheme

) perivationType

= Module

5] DesignationClassschemeltem
5] DataElementrelationship

= Form

3 question

) pesignation

5] DataElementConcept

5 classificationschemeRelationshi
5 MonenumeratedyalusDomain
5 DataElement

5 conceptDerivationkuls

5 questioncondition

5 classificationschemeltemRelatic
5 componentLevel

5 FormElement

5 AdministersdComponentClassSe
5 organization

= Concept

5] ReferenceDocument

=] person Errors [ Log

= Instruction =@ Classes s

5 DataElementDerivation &5 organization

(2] dministeredCompanentCantac! @ Class gov.nih.nci.cadsr, domain, Organization is missing a valid description tagged walue.

(] valueDomainkelatianship = (=) administeredComponentContact

] DataElementCanceptRelatianshi @ Class gov.nih.ndi cadsr, domain, AdministeredCompanentConkact is missing @ valid description tagged value.

5] QuestionRepetition = (@ Classes

=] Administeredomponent = B UMLARributetetadata

[ conditiontessage @ Class gov.nih.nci.cadsr umlproject. domain, UMLAttributeMetadata is missing a valid description tagged value,

] ContactCommunication = (@ Classes

[ QuestionConditionComponents =] ConditionMessageshlame

(5] classschemetlassschemeltem o 2= Frrew e
) i 3 )= :

Figure 3.5 SIW Viewer - showing an unannotated XMI file with errors

Use the SIW viewer to review the errors encountered in the exported file, and to
determine what changes need to be made in your UML model. Once you have made
those changes, you can re-export the XMl file and open it again in the SIW to see if
further changes need to be made before continuing.
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See Using the SIW Viewer on page 27 for more information on how to navigate the SIW
viewer to view the various components of your XMl file.

Annotation Basics and Viewing an Unannotated File

46

The point of viewing an unannotated file in the SIW is to see what items need to be
changed in the model (and a new file exported) before you can continue using SIW to
annotate the file. This mode of the SIW allows you to be sure that the information
resident in the file is clear and accurate and that you have addressed the errors
reported by the SIW. This may mean several iterations of file review along with
changes to the UML model and re-export to review the new file.

Once the unannotated file is complete, it can move forward through the semantic
integration process, providing annotations for the model elements.

The purpose of annotating an XMl file is to map the elements in the file to concept
information from EVS. This mapping can only be done if the names of the elements are
accurate and the element descriptions provided in the model are sufficiently clear as to
the meaning, purpose, or intent of the element.

The following sections provide basic information regarding the relationship between the
elements in your UML model and the concept information to which those items will
ultimately be mapped.

UML Element Descriptions and Annotations

Each element in the model must have a UML element description. These descriptions
are provided through the use of tagged values in the model. The purpose of these
descriptions is to provide the EVS concept curators with some understanding as to the
model owner’s intended meaning of an attribute or class. This allows the curators to
more accurately map each element to the appropriate EVS concept(s).

Historically these tagged values were defined as “documentation” tags for classes and
“description” tags for attributes. However a new tag has been defined for the SIW called
CADSR_Description and can be used as a tagged value for either classes or attributes.

If the UML model contains CADSR_Description tags, that information appears in the
SIW as the UML element description. This allows model owners to provide caDSR-
specific definitions for each model, which are then pulled into the SIW (and ultimately
the caDSR during registration). If the model does not contain these tags, the legacy
documentation and description tags are still used.

If there are multiple description tags for an element, the SIW concatenates these tags
to display a single UML definition in the SIW. For this concatenation to occur, the
format you must use for the CADSR_Description tags is as follows:

e CADSR_Description
e CADSR_Description_2
e CADSR_Description_3

You may add up to eight CADSR_Description tags if necessary (EA has a limit of 255
characters per tag). The UML definition field can include up to 2000 characters.

These descriptions, along with the naming convention used for the elements in the
model, provide the information necessary to properly annotate the XMl file.
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For a file to be considered “annotated,” each UML element, classes as well as
attributes, must be mapped to at least one EVS concept. A concept is made up of the
fields described in Table 3.1.

Concept Fields Example

Code Cl16612

Name Gene

Definition The physical and functional unit of ...
Definition Source NCI-GLOSS

Table 3.1 UML element concepts

The process of mapping to EVS concepts is done in two ways:

e Automatically through the Semantic Connector, which uses the name of the
element to determine what concepts are appropriate for mapping (applying
camel case logic to recognize segments of an element name);

e Manually through the curation process, which is done by the EVS curation team
using the element descriptions as a guide to the intended definition, intent, or
meaning of each element, mapping the concepts appropriately.

Keep this information in mind as you review your unannotated XMl file. The more
accurate and complete the information in the file is, the smoother the annotation
process will be.

Association Annotations
Associations are the relationships between items in the UML model. The relationship
information for an association can be viewed in the SIW, although it cannot be
changed. However, each of the items involved in the relationship (Role, Source, and
Target) can have concept information associated with them.

Like all concept annotations, associations elements can have a primary concept with
gualifier concepts (as applicable). However, because these concepts are linked to
association elements, the tagged values created for each item differ from those created
for classes and attributes.

You should consider annotating your associations in order to provide semantic clarity
for the associations. In addition, the SIW will return a warning if there are more than two
associations between two given classes.

For reference, the following tagged values are used for annotating associations:
1. To annotate the role:
° AssociationRoleConceptCode
° AssociationRoleConceptPreferredName
°  AssociationRoleConceptDefinition[_n]
°  AssociationRoleConceptDefinitionSource

° AssociationRoleQualifierConceptCodeN
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° AssociationRoleQualifierConceptPreferredNameN

° AssociationRoleQualifierConceptDefinitionN[_n}

° AssociationRoleQualifierConceptDefinitionSourceN
2. To annotate the source:

° AssociationSourceConceptCode

°  AssociationSourceConceptPreferredName

°  AssociationSourceConceptDefinition[_n]

°  AssociationSourceConceptDefinitionSource

° AssociationSourceQualifierConceptCodeN

° AssociationSourceQualifierConceptPreferredNameN

°  AssociationSourceQualifierConceptDefinitionN[_n}

°  AssociationSourceQualifierConceptDefinitionSourceN
3. To annotate the target:

° AssociationTargetConceptCode

° AssociationTargetConceptPreferredName

° AssociationTargetConceptDefinition[_n]

° AssociationTargetConceptDefinitionSource

° AssociationTargetQualifierConceptCodeN

° AssociationTargetQualifierConceptPreferredNameN

°  AssociationTargetQualifierConceptDefinitionN[_n}

° AssociationTargetQualifierConceptDefinitionSourceN

Using the XMI Roundtrip Mode

The XMI Roundtrip option is performed by the model owner in an attempt to
automatically annotate his or her model with existing data from caDSR. Using this step,
a model owner can automatically annotate a new version of a model based on existing
mappings located in a previously loaded model. The automated matching is based on
the new model having used exactly the same names for the classes and attributes as
the previous model.

The XMI Roundtrip is an optional step in the semantic integration process but can save
time in the following two situations:

1. A prior version of this model was previously loaded and parts of the models
have not changed, specifically when no changes have been made to the names
of the classes and attributes.

2. The model shares class and attribute names with another, previously loaded
model.
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Where possible, the XMI Roundtrip task maps new or updated UML attributes to
existing caDSR CDEs rather than to EVS concepts.

Input To Step: The original UML model in XMl format, exported from either EA
(saved with an .xmi file extension) or ArgoUML (saved with a .uml file extension)
and reviewed through the Review Unannotated XMI File step.

Example: myModel . xmi for an EA export; myModel .uml for an ArgoUML export.

Output From Step: A partially annotated XMl file with the term “Roundtrip”
appended to the beginning of the filename (roundtrip_${filename}.xmi. or
roundtrip_${filename}.uml).

The file output from this step differs from a file output from the Semantic Connector in
that the Roundtrip XMl file is annotated with caDSR public IDs rather than EVS
concepts.

After performing this step, the model owner should review the automated mapping
using the Review Annotated XMI File option. See Reviewing an Annotated XMl File
on page 74.

To Perform XMI Roundtrip:
1. Open the SIW URL: http:\\cadsrsiw.nci.nih.gov.

2. From the SIW Welcome screen, select option 2. Perform XMI Roundtrip
(Model Owner) and click Next. The Project Search screen appears.

B semantic Integration Workbench 4.0.0.0 -- Perform XMI Roundtrip @

Please click the Search button

to select praject for Roundtrip operation.
Please dlick the Search button
to select project For Roundtrip
operation,

Figure 3.6 Search for an existing Project to use for Roundtrip
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3. Inthe project search screen, click Search. This opens a Search for
Classification Schemes window (Figure 3.7) that allows you to search caDSR
for an existing project and version to use for the Roundtrip processing.

Search for Classification Schemes

Search: l:l Search By |L0ng Mame v| [ Search ]

LongMarme ‘Workflow Status | Public Id

ersion Preferred Definition | Context Mame Registration St. ..

Results Per Page Search Preferences

Figure 3.7 Search for Classification Schemes (project) to use for Roundtrip processing

Enter a classification scheme name in the Search text box and click Search.

You may use the asterisk (*) as a wildcard along with a portion of a name, to
return a list of projects to choose from.

Search for Classification Schemes

Search: |*caCORE* Search By |L0ng Mame v| | Search |

Longharme ‘Workflow Status | Public Id Version Preferred Definition Context Mame Reqistration Status
calCORE 3.2 RELEASED 2528431 3.2 Wersion 3.2 of caCORE .., |caCORE
calCORE 3.0 RETIRED ARCHIL... 3.0 caCORE Description calORE
caCORE Reload ... [RETIRED WITHD. ., 2552422 3.1 caCORE caDSR 3.1 mo.., [caCORE
calCORE 3.1 RELEASED 2528431 3.1 caCORE 3.1 models calORE

0-4 of 4 Results Per Page Search Preferences

Figure 3.8 Search for Classification Schemes - result set

From the result set, find the project and version of the project you want to use
for processing your new file through Roundtrip, and double-click on that entry.
The select project window returns, showing the details of the selected project.
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Semantic Integration Workbench 4.0.0.0 -- Perform X#l Roundirip

Please click the Search button
to select project for Roundtrip operation,

Please click the Search buttan
to select project For Raundtrip
operation.

Preferred Name
Version
‘orkflow Status

Context Mame

cal3SRTraining
1.0
RELEASED

caCORE

[ < Back ] [ Next = ]

[ Cancel ]

Figure 3.9 Project selection screen showing selected Roundtrip project details

Click Next.

In the Select file to parse window, identify the file you want to process. You
have the following options:

° If the file you want to review appears in the Recent Files list, click on the file
name to populate the filename field with the path/filename;

°  Type the full path and filename into the text box;

° Click Browse to browse for and select the file exported from EA or

ArgoUML.

Note: The Browse function defaults to selecting (showing) only files with an
xmi file extension. If you are using a .uml file, select UML Files from the
Files of Type drop-down list at the bottom of the Open dialog box.
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Semantic Integration Workbench 4.0.0.0 -- Perform XMl Roundirip

Please choose a file to parse
The file: must be in XMI or Argo) UML Format

Click browse to search For an MI ar (Argo) UML file

Browse

Recent Files:

annotated_training_data_rodel_v 1_rv13.xmi

[] Choose Classes and Packages

Figure 3.10 Select the file to process through XMI Roundtrip

8. If you want to process only portions of the file, enable the Choose Classes and
Packages checkbox. Otherwise the SIW will submit the entire file through the
Roundtrip process.

9. Click Next. If you enabled the Choose Classes and Packages checkbox, the
package selection screen appears, listing all of the packages in the file. All
packages are checked by default.

Semantic Integration Workbench 4.0.0.0 -- Perform XMI Roundtrip

Please select which classes or packages
wou would like to open by check-marking & node.

ﬁ edu.duke.cabig.tumarregistry . domain
2 java lang
o Javs.util

[ < Back ] [ et = ] [ Cancel ]

Figure 3.11 Package selection screen - lists the packages resident in the file

10. Click a checkmark to open a list of all items contained within the package, and
then click to remove the checkmarks next to any items you do not want
submitted through Roundtrip. Then Click Next.
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The Roundtrip step begins to process your XMl file against the project you selected.

B semantic Integration Workbench 4.0.0.0 -- Perform X#I Roundtrip @

Please choose a file to parse
The file: must be in XMI or {Argo) UML Farmat

Click browse to search For an MI ar (Argo) UML file

Recert Files:

] )

Looking up CDEs

Figure 3.12 SIW performs the Roundtrip process on the selected file against the selected
project

For each UML attribute in the XMI file being processed, the SIW attempts to find a CDE
with an Alternate Name in the selected Project/Version that is similar to the fully
qualified attribute name in the model. If a match is found, the attribute in the XMl file is
annotated with the matching CDE public ID/Version from caDSR. Note that mapping an
attribute to a CDE also maps the class to a caDSR OC and the datatype for the
attribute to a caDSR value domain.

When the Roundtrip process is complete, the SIW saves a new version of the XMl file
into the same directory as the source file, appended with the term “Roundtrip” on the
front of the filename. For example, if the processed file’s path/name was
c:\myXMIfiles\Version2\myModel . xmi the newly saved file will be
c:\myXMIfiles\Version2\Roundtrip_myModel .xmi.

After performing this step, the model owner should review the automated mapping
using the Review Annotated XMI File option. After that, if there are UML elements in
the file that are not mapped, the model owner may want to process the XMl file through
the Semantic Connector to map those elements to EVS concepts.

For more information, see Running the Semantic Connector, below, and Reviewing an
Annotated XMI File on page 74.
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The Semantic Connector option of the SIW performs an EVS search against each
element in the XMl file (or package), and attaches one or more EVS concepts to each
element. The search is performed using the element names. If the elements in the file
are named properly using the “camel case” convention, the SIW can separate the parts
of each element based on the capitalization in the element name, and perform an EVS
search on each part. The Semantic Connector then maps the parts of each element to
EVS concepts as appropriate.

For example, the XMl file contains an attribute called “initialDiagnosisDate.” Because
the element name uses camel case, the Semantic Connector recognizes three parts to
the element: initial, diagnosis and date. Each of those terms is then searched against
the NCI Thesaurus, and three matching EVS concepts are returned.

Because “date” appears last in the series, the Semantic Connector identifies that as
being the main idea of the element, and therefore maps the Primary Concept as “date.”
The Qualifier Concept #1 is mapped as “diagnosis” and Qualifier Concept #2 is
mapped as “initial.” The element is now annotated with a primary and two qualifier
concepts.

When the Semantic Connector step is finished, the SIW automatically creates the
Semantic Connector Report and saves it as a new file to the same directory where the
source file resides. The model owner should review this file before submitting it to the
EVS curators for the Curate XMl File process.

Although the Semantic Connector will add concepts to anything not marked as
“reviewed” (even those items already mapped to a CDE), those concepts are ignored
during validation and loading, in favor of the mapped CDEs.

Input To Step: The original UML model in XMI format, exported from either EA
(saved with an .xmi file extension) or ArgoUML (saved with a .uml file extension)
and reviewed through the Review Unannotated XMl File step. Or the input could be
an XMl file that has been processed through the XMI Roundtrip step.

Example: myModel .xmi for an EA export; myModel .uml for an ArgoUML export;
or roundtrip_myModel .xmi or roundtrip_myModel .uml for a Roundtrip
processed file.

Output From Step: The Semantic Connector Report, saved as an XMl file with the
term “FirstPass” appended to the front of the file name (e.qg.,
FirstPass_myModel .xmi or FirstPass_Roundtrip_myModel .xmi).

After performing this step, the model owner should review the automated mapping
using the Review Annotated XMI File option. See Reviewing an Annotated XMI File
on page 74.

The file output from this step is sent to the EVS curation team as the input for the
Curate XMI File step of the SIW.
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To run the Semantic Connector:

1. Open the SIW URL: http:\\cadsrsiw.nci.nih.gov.

2. From the SIW Welcome screen, select option 3. Run Semantic Connector
(Model Owner) and click Next.

3. Inthe Select file to parse window, identify the file you want to process. You
have the following options:

° If the file you want to review appears in the Recent Files list, click on the file
name to populate the filename field with the path/filename.

°  Type the full path and filename into the text box.

° Click Browse to browse for and select the file exported from EA or
ArgoUML.

Note: The Browse function defaults to selecting (showing) only files with an
xmi file extension. If you are using a .uml file, select UML Files from the
Files of Type drop-down list at the bottom of the Open dialog box.

B semantic Integration Workbench 4.0.0.0 -- Run Semantic Connector, @

Please choose a file to parse
The file must be in ®MI or {Argo) UML Format

Click browse to search For an MI ar (Argo) UML file

Browse

Recert Files:
emnployee-1-cde xmi

FirstPass_roundkrip_MCIA_v3_0_pv2 ami

[[] Choose Classes and Packages

Figure 3.13 Select the file to process through the Semantic Connector
4. If you want to process only portions of the file, enable the Choose Classes and

Packages checkbox. Otherwise the SIW will submit the entire file through the
Semantic Connector.
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5. Click Next. If you enabled the Choose Classes and Packages checkbox, the
package selection screen appears, listing all of the packages in the file. All
packages are checked by default.

B semantic Integration Workbench 4.0.0.0 - Run Semantic Connector El

Please select which classes or packages
wou would like to open by check-marking & node.

ﬁ goy. nih.nei,neia.domain
2 java lang

2 Java.util

[ <Back ] [ Next> | [ Cancel ]

Figure 3.14 Package selection screen - lists the packages resident in the file

6. Click a checkmark to open a list of all items contained within the package, and
then click to remove the checkmarks next to any items you do not want to
process through the Semantic Connector. Then click Next.

The Semantic Connector begins to process the XMl file against the NCI Thesaurus.

B semantic Integration Workbench 4.0.0.0 -- Run Semantic Connector,

Please choose a file to parse
The file musk be in ¥MI or {Argo) UML Formak

Click browse to search For an %M1 or {Argo) UML file

Recent Files:

( ]
Searching studyDate

Figure 3.15 SIW performs the Roundtrip process on the selected file

If the process is successful, the Semantic Connector maps the elements to EVS
concepts and inserts them into the XMI file. When the Semantic Connector is done, the
SIW saves a new version of the XMl file, which is referred to as the Semantic
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Connector Report. A final screen appears confirming completion of the process and
identifying the location of the newly generated file. Note the location and click Finish.

B semantic Integration Workbench 4.0.0.0 - Run Semantic Connector @

Corfirmation

Annotation of file
C:fDacuments and SettingsfBranwyniy
Documents/all_NIH_Dac_DownloadsfUnZips{FirstPass_roundtrip_WCIA_w3_0_rv2. xmi
was completed.,

The Annotated XMI can be found here:
C:fDacuments and SettingsfBranwyniy
Documents/Al_NIH_Dac_Downloads/UnZips FirstPass_FirstPass_roundtrip_MCIA&_v3_0_rv2. xmi

Figure 3.16 Semantic Connector process complete - displays location of new XMI file

This new file is saved into the same directory as the source file and is appended with
the term “FirstPass” on the front of the filename. For example, if the processed file’s
path/name was c:\myXMI1Files\myModel . xmi the newly saved file will be
c:\myXMIFfiles\FirstPass_myModel .xmi. If the example file had been submitted
through the Roundtrip process first, the newly saved file would be nhamed
c:\myXMIFfiles\FirstPass_ Roundtrip_myModel .xmi. If your source was
exported from ArgoUML, the extension on the filename would continue to be .uml.

After performing this step, the model owner should review the Semantic Connector
Report (new XMl file) using the Review Annotated XMl File option. For more
information, see Reviewing an Annotated XMI File on page 74.

After reviewing the changes, the file should be submitted to the EVS curation team to
perform the Curate XMI File step of the SIW process. The EVS curation team reviews
the file, removes extraneous mapped concepts, inserts new concepts, and reorders the
mapped concepts to match the UML class and attribute entities and the intent identified
for the element by the owner (through the element description tags).

If the Semantic Connector process was not successful, an error message may appear, or
the process may simply not complete. The most likely cause for this is that the XMI file
is not in the expected format. This issue should be corrected before re-running the
Semantic Connector and may require re-export of the XMI file from EA.
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Note:

The Curate XMI File step is performed by the EVS concept curation team at the
NCICB. During this step, the EVS team adds and removes concepts from the XMl file,
and indicates recommended semantic mappings for the UML model. The EVS team will
use existing EVS concepts where possible, or create new EVS concepts to reflect new
items being introduced by the model.

EVS curators have the authority to change any concept field and to use concepts that
are not in the NCI Thesaurus. Model owners, on the other hand, should only change
concept information by picking an EVS concept from the Thesaurus or entering one
supplied by EVS. New EVS concepts cannot be verified using the Search EVS feature,
so new concepts should only be used by EVS curators during the Curate XMI File step.
However if the EVS curation team supplies the model owner with a new EVS concept
to use, they can be added during the Review Annotated XMI File step.

The end result of the curation process is an Annotated XMl file that is returned to the
model owner who can then review the annotated file and either accept or change the
mappings performed by the curators. Frequently, if the model owner makes changes to
the file, they will return it to the EVS curation team for re-review and curation.

Input: The Semantic Connector Report, which is the file that the SIW saved after
completing the Run Semantic Connector step. The file should be appended with
“FirstPass” at the front of the filename.

Example: FirstPass_myModel .xmi or
FirstPass_ Roundtrip_myModel .xmi (if the file was processed through the
Roundtrip step before the Semantic Connector).

Output: An curated XMl file. The file should be appended with “annotated” at the
front of the filename. For example: Annotated_ FirstPass_myModel .xmi or
Annotated_ FirstPass_Roundtrip_myModel .xmi.

The curated XMl file is the input to the Review Annotated Model step. For more
information, see Reviewing an Annotated XMI File on page 74.

The procedural information in this section is directed specifically at EVS curators,
though model owners are strongly encouraged to review this section in order to
understand the process of curation. Be advised however, where the text in this section
refers to “you” or “the user” performing a task, it is referring to the EVS curator.

To Curate an XMI File:
1. Open the SIW URL: http:\\cadsrsiw.nci.nih.gov.

2. From the SIW Welcome screen, select option 4. Curate XMI File (Vocabulary
Reviewer) and click Next.

3. Inthe Select file to parse window, identify the file you want to process. You
have the following options:

° If the file you want to review appears in the Recent Files list, click on the file
name to populate the filename field with the path/filename.

° Type the full path and filename into the text box.
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° Click Browse to browse for and select the file exported from EA or
ArgoUML.

B semantic Integration Workbench 4.0.0.0 -- Curate XMI File E|

Please choose a file to parse
The file: must be in XMI or Argo) UML Format

Click browse to search For an %MI ar (Argo) UML file

s{UnZips/FirstPass_roundtrip_MNCIA_v3_0_rv2.=mi

Recent Files:
fixed_gridPIR_domain_madel.rmi
annotated_FirstPass_PSC_w2_rv2ami

annotated_gidPIR vl _2_relami

FirstPass_roundtip_MCIA_v3_0_pw2 aroi

Choose Classes and Packages

[ <Back ] [ Mext > ] | cancel |

Figure 3.17 Select the XMI file to curate

If you want to process only portions of the file, enable the Choose Classes and
Packages checkbox. Otherwise the SIW will open the entire file for curation.

Click Next. If you enabled the Choose Classes and Packages checkbox, the
package selection screen appears, listing all of the packages in the file. All
packages are checked by default.

B semantic Integration Workbench 4.0.0.0 - Curate XM| File El

Please select which classes or packages
wou would like to open by check-marking & node.

ﬁ goy. nih.nei,neia.domain
2 java lang
2 Java.util

[ <Back ] [ Next> | [ Cancel ]

Figure 3.18 Package selection screen - lists the packages resident in the file
Click a checkmark to open a list of all items contained within the package, and

then click to remove the checkmarks next to any items you do not want to open
for curation. Then click Next.
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When the SIW is finished parsing the file, the SIW viewer appears.

[ Semantic Integration Workbench 4.0.0.0 - C:/Documents and Settings/Bronwyn/My Documents/AlL_NIH_Doc_Dow... E@@

File Edit Element Run Help

=3

s

= [ Classes A

ClinicalTrialSice

-{Fid

= siteld

-1 =] sitellame

Image

__| acquisitionDate

__| acquisitionDat etirne
__| acquisitionMatriz
J acquisitionhumber

'__i acquisition Time

-1 ) anatomicRegionZeq

=) columins

-1 =] conkentDate
__| contentTime
__| contrastBolusAgent
=] conkrastBolusRaute

=) corwolutionKerne!

-+ ZJ ckPitchFactor

=) dataCollectionDiame

- =) exposure
-+ =] exposureInticrofs

{5 id

'__i imageCamments

-1 =) imageL aterality
-+ =] imageCrientationPal
- =) imagePositionPatien

~{Z) exposureTime Errors | Log
{E] Focalspotsize = [ dlasses
=) gantryDetector Tk H = E CurationData

=1+ =) cdeld

Vo & Concept: C9684 is missing its ConceptDefinitionSource.
@ Concept; C9654 is missing its ConceptDefinition,
cdehlame

@ Concept: C9684 is missing its ConceptDefinitionSource,

J imageType & Concept: C4705 is missing its ConceptDefinitionSource.
= instanceMumber “ ¢ - Concept: C4705 is missing its ConceptDefinition,
< m S ¢ g Conceph: C9684 is missing its ConceptDefinition. v

Figure 3.19 SIW Viewer - showing an XMI file ready for curation

Any element not already mapped to a caDSR CDE or OC must be mapped to one or
more EVS concepts. The Semantic Connector process did some of the concept
mapping automatically, however it likely mapped multiple concepts for more common
elements (such as “id”) or did not find any matching concepts for some elements.
Furthermore, additional concepts may need to be added to an element, some mapped
concepts may need to be removed, or the semantic order of the concepts may need to
change.

The SIW viewer allows you to add, remove, edit and re-order the EVS concepts for the
elements in the XMl file. The sections that follow provide information on how to perform
these tasks.

If necessary, see Using the SIW Viewer on page 27 for a basic overview on navigating
the SIW viewer and on using the Previous, Next, Add, Apply and Search EVS
buttons.

Adding EVS Concepts to an Element in Curate Mode

60

If an element does not have an EVS concept mapped to it, you must add one. If an
element has an EVS concept mapped to it, you may add one or more Qualifier
concepts to the existing concept(s).

The first concept added to an element is called the “Primary” concept. Subsequent
mapped concepts are called “Qualifier” concepts. Concepts are added and then listed
in semantic order, meaning that the Primary concept is always added first and must
reflect the basic point of the element (typically the last item in the element hame).



Note:

Chapter 3 Semantically Integrating Your UML Model

For example, an element is named “initalDiagnosisDate.” The item itself reflects a date,
while the rest of the information reveals details about the date. In this case, the Primary
concept for the element should be mapped to an EVS concept named “date.”

If the element already has a Primary concept mapped, it may require further mapping of
Quialifier concepts. In the example above, once the Primary concept is mapped, you
would add a Qualifier concept mapped to an EVS concept named “diagnosis” and then
add a second Qualifier concept mapped to an EVS concept named “initial.”

The procedures for adding concepts to an element are the same, regardless of whether
you are adding Primary or a Qualifier concepts. Furthermore, adding concepts only
applies to elements that are not already mapped to caDSR CDEs or OCs.

To add a concept:
1. Inthe SIW viewer, select an element from the navigation tree.

2. Inthe detail view, click Add. A set of empty concept fields appears, along with a
Search EVS button.

Note: If you have changed your viewer Preferences to Display Primary
Concept First, the new concept fields will appear below any existing
mapped concepts, meaning you may need to scroll down in the detail
view to see the new fields. See Setting Viewer Preferences on page 36 for
more information on setting your viewer preferences.

[@ semantic Integration Workbench 4.0.0.0 - C:/Documents and Settings/Bromwyn/My Documents/AlL_NIH_Doc_Downloads/UnZips/Firs. .. @@@
File Edit Element Run Help

—J timsPointDescription A | TrialpataProvenance project Q}
—J timePoint1d

=5 ClricalTrisFratarol UML Attribute Description

Jid

=] protocalid in nawe chosen by the image submitter to identify the

—J protocaliames collection that the iwmage is a part of.
=5 CurationData

= cdeld
=) cdefuame
=) cdevalue

=) cdeversion

=) curationTimestamp UML Concept Code Summary:  C47885
j L] ‘ UML Concept Name Summary:  Project
trislHame:
..... :‘ userld Qualifier Concept #1
=] Series
—J bodyPartExamined Concept Code: Search EVS

Concept Preferred Nams:

) seriesDate Concept Definition: 3
=) seriesDascription

=) serieshiumber

..... =) synchronizationFrameo
—J symefronizationframe Coneept Definition Source:

]

Yerified Previous ][ et ] [ Map to CDE
Errors | Log
= Classes =
©{Z) annotationType 3 = (3 Curationbata
F 5 T cderd =

IChanges Applied

Figure 3.20 SIW Viewer in Curate XMI mode, showing new blank concept fields.

3. Enter the appropriate information into all four text fields. You have the following
options:

° Manually type the information into the text boxes,
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° Click Search EVS to perform a search for the appropriate concept to map.
Double-click on a search result item to populate the concept fields with
the needed information. For more details on using the EVS search to
populate the concept fields, see Searching EVS for Concept Information,
below.

4. When the fields are complete, click Apply. This applies the new concept to the
the element. (You will still have to save the file after all of your changes are
made. See Saving Changes to a File on page 39.

5. If necessary, after applying your changes, you can click Add again and
complete the above steps to add another concept to this element.

Searching EVS for Concept Information

62

Whether adding or editing concept information, the detail view of the SIW viewer
provides a Search EVS button that allows you to search the NCI Thesaurus for existing
concepts and if a match is found, to automatically map the concept to the element.

The Search EVS button appears next to each mapped concept and next to the empty
concept information fields when you select to Add a new concept.

[ semantic Integration Workbench 4.0.0.0 - C:/Documents and Settings/Bronwyn/My Documents/All_NIH_Doc_Downloads/Un... @@@
File Edit Element Run Help

=) instiwwtionaddress ] Study,additionalPatientHistory [ I

= institutioniame:

=) manufacturer Concept Defintion Source: |NCI

=) manufacturertModeliam

5 softwareversions

=] stationhlame Prinary Concept

= =) diinicalTrizlsponser
=) courdinatingtenter Concept Code: 42687 Search EV5 | M

=id

=) sponsortiame Concept Freferred Nams: | Concept History

The iracking of concept evalution over the lifetime of a e @
vacabulary, includes concept creation, modification,

=) admittingDiagnosesDesc Concept Definition: .
Sid merges, splits, and retirements.
=) occupation
=] patientAge
=] patientsize

= Concept Definition Source: |NCT
=] patientWeight

=) studyDate *
=J studyDescription
= studyd Hurman
5} srtptstance gy Previous ] [ Mext ] [ Map to CDE
=) studyTime
=] timePaintDescription
=] timePointId Errors | Log
== ClinicalTrizPratocol I 6 Classes ~
= = 5 curationData
=) protocolld = '_‘ cdeld
ZJ protocaliame - @ Concept: CI684 is missing s ConceptDefinition,
=3 CurationData * @ Concept: C9684 is missing its ConceptDefinitionSource.
=) edeld ={Z) cdeMame

=) edehlame v - @ Concept: C4705 is missing its ConceptDefinitionSource,
< > @ Conceot; C4705 is missin its CenceotDefinition,
btudy. scdtionalPatientHistory

Figure 3.21 The Search EVS button appears next to concept information fields

By default, if the Concept Name field is populated when you click Search EVS, the
EVS search automatically performs a synonym search of the NCI Thesaurus for the
concept name listed. If you have changed your viewer Preferences to not automatically
perform an EVS search, then you will need to manually enter search criteria. See
Setting Viewer Preferences on page 36 for more information.

To search EVS/NCI Thesaurus for concept information:

1. Inthe SIW viewer, click Search EVS, located to the right of the Concept Code
field. The Search Thesaurus dialog box appears in one of two states:
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° If the Concept Name field was populated when you clicked Search EVS
(and your Viewer Preferences are set to automatically search EVS), the
concept name appears in the Search text box, a search is automatically
performed, and the results appear in the Search Thesaurus dialog box.

Search Thesaurus &l
Searchi [Orgsmization| | SearchBy |Synomyms v [ Inchide Retirsd?

Code Concept Name  Preferred N... | Synonyms Definition Source
[Organization  [Organizational unit ke 2 laboratory, institute or consortium,
(Organizational

Uit et
[Organizational
oRG & Formal group of peaple that: constitute an identifiable social unit with a
‘Outside Bodies  [collection of responsibilities defined by one or more shared goals, who
Organization  |coordinate their activities ko achieve these goals.

Professional

41167 (Organizationa... [Organizationa. ..

C19711 Professional_... Professional ... MCT

t-20f 2 Resu\tsParPaqe 10 v

Figure 3.22 Search Thesaurus dialog box with automatic search results

° If the Concept Name field was blank when you clicked Search EVS (for
example, if you are adding a new concept), the Search Thesaurus dialog
box appears but is blank.

B Search Thesaurus El
Search: || SearchBy |Synomyms v [ Inchuds Retirsd?

Code Concept Name | Preferred N... | Synonyms Definition Source

ResultsPerPage 0 -

Figure 3.23 Blank Search Thesaurus dialog box - enter criteria for search

The Search Thesaurus dialog box contains the following items:

— Search text box: Use this field to enter your search criteria. You may
use an asterisk (*) as a wildcard. The search is not case-specific.

— Search By drop-down list: Use this option to select whether you want
to search on the Synonym field or Concept Code field in EVS.

— Include Retired checkbox: Use this to select whether to include
Retired concepts in the search results. Retired concepts are excluded
by default, as active concepts are preferred for mapping.

— Search button: Click to execute the search based on the criteria you
entered.
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— Close button: Click to close the search dialog box without mapping any
concepts.

— Previous and Next buttons: These buttons only become active if your
search results cover more than one page. Use these to page through
the result set. Between these buttons is an indicator that lets you know
which results are currently displayed along with the total number of
items returned.

— Results Per Page drop-down list: Use this option to change how many
results appear on each page.

If an automatic search was run and the concept you want to map appears in the
results, double-click the item. The information for the new concept replaces
the information that had been in the concept information fields in the SIW.
Otherwise, continue with the steps below to search for concepts.

Enter your search criteria into the Search text box. You have the following
options:

° Type in the term you are looking for;

° Type in part of the term you are looking for along with an asterisk (*) as a
wildcard character. This method will return more results but also typically
take longer because the result set is more inclusive;

° Type in the concept code you want to find. You may NOT use a wildcard to
search for concept code. Concept code searches return exact matches
only.

In the Search By drop-down list, select the NCI Thesaurus field to search in:
Synonym or Concept Code.

Each concept in the NCI Thesaurus has at least one synonym associated with

it, and many concepts may share a synonym. For example, a search for “ID” will
return multiple results because there are several concepts that have ID listed as
a synonym (e.g., Identifier, Idaho, Indonesia). Conversely a search for “Genes”
will return “Gene” as its only result because “Genes” only exists as a synonym

for “Gene” in the NCI Thesaurus.

Check the Include Retired? check box if you want the results to include Retired
items. Retired concepts are excluded by default.

Click Search. The results appear below the search options, listed in
alphabetical order by concept name. If there are multiple pages of results, the
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Previous and Next buttons are enabled, allowing you to scroll through the
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Figure 3.24 Search Thesaurus (EVS) dialog box with search results

If needed, you can resize the Search Thesaurus dialog box as well as resizing
the columns within the dialog box, to better view the result set details. If you
cannot sufficiently resize the box to see the information you need, hold your
mouse cursor over each field to display the full text of the field in the mouse-
over tool-tip that appears.

7. If the concept you want to map appears in the result set, double-click
anywhere in the row for that concept. This closes the Search dialog box and
enters the information for the selected concept into the concept information
fields in the SIW viewer.

8. If the search returns no results (the Search dialog box remains empty) or the
concept you want to map does not appear in the result set, alter your search
criteria to be more inclusive by using the wildcard or by removing terms from the
Search text box if multiple terms appear.

After making changes to the concept information, you can click Apply to apply those
changes to that element, or select Edit > Apply to All to apply your changes to every
instance of that element in the model. For more information, see Applying Changes to
All Similar Nodes on page 70.

Note: The search result list is limited to 100 terms. If your search returns 100 terms, there may
be more concepts available that match your criteria. Alter your search results to be
more restrictive or specific to the concept information you are looking for.

Editing Concept Information in Curate Mode
Besides adding concepts to elements, EVS curators can also edit the existing concept
information for an element. Editing concept information consists of replacing mapped
concepts with different concepts, changing the semantic order of mapped concepts,
editing the text in the concept information fields, and where necessary, removing
concepts from an element’s mapping.

65



caCORE SIW and UML Model Loader Technical Guide

66

Note: If you accidentally make changes to concept information that you did not intend to

make or don’t want to keep, click Previous or Next before clicking Apply. The SIW
prompts you regarding whether or not to save the change. Click No and the element’s
concept information is returned to its original state.

Replacing Mapped Concepts in Curate Mode

Replacing mapped concepts uses the same steps as adding concepts except that the
concept information fields are already populated, and if you use the Search EVS button
to search the NCI Thesaurus, the existing concept name will be used to launch the
initial search for concepts.

Some mapped concepts may need to be replaced because the Semantic Connector
did not parse the element name properly and performed a search on a term that is not
applicable to the element, or returned a result that simply isn’'t in line with the intent of
the element. In this case, one or more of the existing mapped concepts may need to be
replaced with more accurate concepts from EVS.

To replace a mapped concept:

1. Select an element to view, and if necessary scroll through the detail view to find
the concept you need to replace.

2. Click Search EVS located to the right of the Concept Code field. The Search
Thesaurus dialog box appears and should contain search results based on the
concept name of the concept you are replacing.

3. Since the automated search is probably what mapped the incorrect concept in
the first place, change the text in the Search field to return results that better
reflect the element concept you are trying to map.

4. Click Search.

5. Review the search results. If the concept you want to replace the existing
concept with appears in the list, double-click anywhere in that row. The new
concept information replaces the old concept information.

If the search results do not return any concepts you want to use, revise your search
criteria and search again, or consider creating a new concept for the model. For
information on creating a new concept for the model, see Editing Concept Information
While Changing the Concept Code on page 69.

After making changes to the concept information, you can click Apply to apply those
changes to that element, or select Edit > Apply to All to apply your changes to every
instance of that element in the model. For more information, see Applying Changes to
All Similar Nodes on page 70.

Changing the Order of Mapped Concepts in Curate Mode

As stated earlier in this section, every element must have a Primary Concept that
reflects the basic point or meaning of the item, and then may have Qualifier Concepts
that reflect additional details about the element. This is often true of attributes, which
can reflect multiple details about the class element they belong to.

The order in which the concepts are mapped is reflected in the order given to those
concepts in the SIW. This means that the first concept mapped is always the Primary
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Concept, while subsequently mapped concepts become Qualifier concepts with
numbers that reflect when they were added (respectively). The order of these Qualifier
concepts must reflect the intended semantic meaning of the element to which they are
mapped.

The Semantic Connector uses the names of elements to map those elements to EVS
concepts, parsing the names into individual parts based on the camel case naming
convention. However, while curating the file you may discover that the concepts for an
element are not mapped in an order that reflects the purpose for the element. In this
case you will want to change the semantic order of the mapped concepts.

Once an element has more than one concept mapped to it, up and/or down arrow
buttons appear to the right of the Concept Definition field in the detail view of the SIW
viewer.
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Figure 3.25 An attribute element with multiple concepts and the order control buttons.

The arrow buttons move the concept information either up or down (as indicated by the
arrow selected) one position in semantic order for that item. The X button removes the
concept from the element.

For example, an attribute named “initialDiagnosisDate” has a primary concept of Date,
with two qualifying concepts: “Initial” and “Diagnosis”. But for whatever reason, the
Qualifier concept #2 is “Diagnosis” and the Qualifier concept #1 is “Initial.” You believe
these need to be switched in order to be mapped in proper semantic order.

In this case, clicking the “down” arrow next to Qualifier Concept #2 (“Diagnosis”)
causes this concept information to switch places with Qualifier Concept #1 (“Initial”).
This changes the semantics of the concept information, though the element itself is still
mapped to those EVS concepts. (Be sure to click Apply to apply your change.)

The ability to rearrange the semantic order for concepts is most useful if you have to
add or replace mapped concepts for the element. In that case, you can simply use the
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Search EVS button to find and add/replace concept information in any order you like,
and then use the arrows to put the mapped concepts into the proper order, based on
the attribute name and the UML element description provided by the model owner.

To change the semantic position of a concept:

1. Select an element from the navigation tree, and if necessary scroll through the
detail view to find the concept you need to move.

2. Click the Up Arrow or Down Arrow located to the right of the Concept
Definition field.

Notice that the concept is not simply moved; the concept switches places with the
concept located next to it. This means that you will probably have to repeat these steps
multiple times to get the concepts into the proper semantic order, moving concepts up
and down in the list as necessary.

After making changes to the concept information, you can click Apply to apply those
changes to that element, or select Edit > Apply to All to apply your changes to every
instance of that element in the model. For more information, see Applying Changes to
All Similar Nodes on page 70.

Deleting Mapped Concepts in Curate Mode

Note:

The Semantic Connector will typically map multiple concepts to an element when it
finds multiple matching names for an element. In this case you will need to remove the
mapped concepts that do not apply to that element.

For example, if the model contains a class or attribute with a name “id” it is quite likely
that the Semantic Connector will map several different concepts to that element,
including “identifier,” “ldaho” and “Indonesia” because the Semantic Connector cannot
know what the intent of the element is. Therefore it selects and maps all matches it
finds.

To remove a concept from the element:

¢ Click the X located next to the Concept Description field of the concept you want
to remove. The concept is deleted.

After making changes to the concept information, you can click Apply to apply those
changes to that element, or select Edit > Apply to All to apply your changes to every
instance of that element in the model. For more information, see Applying Changes to
All Similar Nodes on page 70.

If you accidentally delete a concept that you did not intend to remove, click Previous
or Next before clicking Apply. The SIW prompts you regarding whether or not to save
the change. Click No and the concept information is returned to its original state.
Please note that this “undo” action does NOT apply if you select Apply to All.

Editing Concept Information Without Changing the Concept Code

Within a model, two concepts with the same concept code must have the same concept
name, definition and definition source. This means that if you change any of the
properties of a concept without also changing the concept code, the SIW applies the
property changes you made to all other elements within the model that use the same
concept code.
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For example, two classes “Person” and “Animal” have the “Name” attribute in common,
because both elements have names. The “Name” attribute is annotated with the
following concept information:

e conceptCode: C25192
e conceptPreferredName: Name

e conceptDefinition: A word or group of words indicating the
identity of a person usually consisting of ...

e conceptDefinitionSource: NCI Thesaurus

You change the concept definition to state, “A term consisting of a word or group of
words that indicates the specific identity of the item to which the term is applied.”
However, you do not change the concept code. When you click Apply, the change you
made is also made to every instance of that concept in the model.

The SIW does this for two reasons: first, concept code is a unique identifier, and
everywhere a term in the model is identified with that code, it must reflect the same
information. Second, if some aspect of a concept (like definition) within EVS changes
for a particular term, that change needs to be applied across all systems (which is the
point of semantic integration). Automating this type of change makes curation of XMl
files a much more efficient process.

Editing Concept Information While Changing the Concept Code

Caution:

Since the concept code is a unique identifier, if you change some aspect of the concept
information for an element, but you don’t want that change to cascade to all instances
of that concept, you must also change the concept code. Changing concept information
while also changing the concept code essentially creates a new EVS concept. This is
useful if the model contains an element that while is similarly named to other elements,
does not map neatly to any existing EVS concepts and therefore requires its own
description and definition.

If you make changes to the concept information and change the concept code to a new
one, only the element you are editing is modified (as long as you are using a code that
is not used elsewhere in the model). Those changes do not cascade to other elements.

For example, the model has a class named “Animal” that contains an attribute called
“Breed.” The Semantic Connector mapped this to an EVS concept whose definition
reflects the noun form of the term “breed” rather than the verb form. This model intends
for the attribute to reflect the act of breeding instead of a type of animal.

During curation, you (the curator) can tell the intent of the attribute because of the UML
definition provided by the model owner (see why these are important?). So you change
the definition for the concept and also change the concept code so that your changes
are only applied to this element. Once entered into EVS, there will be two EVS
concepts called “Breed” with two different concept codes and two different concept
definitions.

If you do change the concept code for a mapped concept, be sure you are using a new
code and not an existing one. If you change the code to one that is in use in the model,
your changes will cascade to all elements mapped to the concept with that code.
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You may find that you need to apply your concept changes to all similar elements in the
model. For information on this feature, see Applying Changes to All Similar Nodes
below.

Applying Changes to All Similar Nodes

Caution:

In some cases, an attribute is reused several times across the model. A common
example is the attribute “id.” Typically, this attribute represents the same type of
information everywhere it is used across the model. As noted in an earlier example, the
term “id” may apply to a list of different types of information, and therefore the Semantic
Connector may have mapped several different concepts to this element. These extra
concept mappings will need to be removed from every instance of the “id” attribute.

The Apply to All command, located in the Edit menu, allows you to apply the changes
made to an element to all similar items in the model.

Apply to All is used in place of Apply. If you click Apply first, the Apply to All option is
grayed out and no longer available.

Using the example of the “id” attribute, in the model, “id” occurs 27 times, and 25 of
those times, refers to “Identifier.” All 27 instances of “id” have been mapped to the
concept “Identifier” but they have also been mapped to “ldaho” and “Indonesia” by the
Semantic Connector. You can remove these unnecessary concepts from one of the “id”
attributes in the model, then select Edit > Apply to All. This removes those concepts
from all instances of the attribute “id.”

You can then go back and manually update or replace the concept information for the
two instances of “id” that refer to something other than “Identifier.”

The Apply to All feature is also useful if you are adding concepts to an element or
reordering the concepts in an element and need to apply those same changes to all or
most of the other instances of the element in the model. For information on adding
concepts, see Adding EVS Concepts to an Element in Curate Mode on page 60. For
information on editing concept information, see Editing Concept Information in Curate
Mode on page 65.

If you use Apply to All you will no longer have the ability to “undo” your changes by
selecting a different element in the model and then selecting not to apply the changes.

Once Apply to All is used, all similar elements are changed to reflect the changes made
in the currently active element. If you need to undo those changes, you can exit the SIW
without saving the changes to the file, and then reopen the file. You will, however, lose all
of your changes since you last saved the file.

Remember that applying changes is not the same as saving the file. You must still use
the File > Save or File > Save As commands to save your changes to the file. For
more information, see Saving Changes to a File on page 39.

Validating XMI File Concept Information Against EVS
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The Validate Concepts option, located under the Run menu, performs a comparison
of the Concept Code, Concept Name and Concept Definition fields for each mapped
element in the currently open XMl file to the “official” information located in EVS. This
allows you to easily see where there are differences or where there is concept
information in the model that is not resident in EVS.
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To Validate the XMI concepts against EVS concepts:

1. With the annotated XMl file open in Review Annotated XMI File mode, select
Run > Validate Concepts.

2. A confirmation dialog box appears, informing you that the validation process
may take some time to complete, and asking if you want to continue. Click Yes.

3. An empty Validate Concepts window appears, with a progress bar at the bottom
informing you of the status of the validation process.

Validate Concepts @

EVS Cancept By Name

EVS Concept By Code

Element Concept

alidating Age

Figure 3.26 Validate Concepts window showing progress of the validation

When the validation process completes, the progress bar spans the bottom of
the window, and a status of Done appears below the progress bar. In addition,
the left side of the window will list all elements in the XMl file that contain
concept information that differs from what appears in EVS.

If the left side of the window is empty, there are no disparities between the XMi
file and EVS.

4. Select one of the elements from the list on the left side of the Validate Concepts
window. This populates the other areas of the window with concept name,
concept code and concept definition information as follows:

° EVS Concept by Name - The area located on the top-right of the Validate
Concepts window shows the entry in EVS for the concept name that
matches the concept name used for the selected element in the XMl file.

If this area is empty, it means that no match was found in EVS for the
concept name listed for the selected element.

° EVS Concept by Code - The area located in the middle-right of the Validate
Concepts window shows the entry in EVS for the concept code that
matches the concept code used for the selected element in the XMl file.

If this area is empty, it means that no match was found in EVS for the
concept code listed for the selected element.
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Note:

° Element Concept - The area located on the bottom-right of the Validate
Concepts window shows the concept information resident in the XMl file that
corresponds with the EVS concept(s) appearing in the upper two boxes.
This allows you to directly compare what is in the XMl file with the
corresponding information in EVS.

In addition to these informational areas, the top of the Validate Concepts window
shows the type of element and type of disparate concept currently selected (e.g., Class
Primary Concept or Attribute Qualifier Concept #2).

The Validate Concepts window highlights the fields where there are differences
between the information in EVS and in the XMl file.
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COUE, 27907
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Additional
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W?rd in XMI Preferred Name: Address 2
file's definition | 1 g tion: 4 stangarcized
for this representation of the
element h geographical location of a
person, business, building, or
organization. 3

Dons

Figure 3.27 Validate Concepts window showing a difference in concept definition

You can make changes to the information in the Element Concept section of the
Validate Concepts window, which makes those changes to the element in the XMl file.

In addition, when you select an element in the Validate Concepts window, the same
item is also selected in the navigation tree of the main SIW viewer window. This allows
you to review all of the other concept information for that element if needed.

Typically the EVS information in the top two boxes of the Validate Concepts window is
the same, however it is possible that the element in the XMI file has a EVS concept code
that differs from the EVS concept name associated with that code. In this case, the
search performed by the validation would return different results for these areas of the
window. The Validate Concepts window will highlight these differences.

Verifying the Curated XMI File
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Once you have reviewed and updated the concept information in the file to your
satisfaction, you can use the Human Verified checkbox to mark that curation for this
element is complete. As is logical, the Human Verified checkbox is not available for any
element that does not contain concept information or which is not already mapped to a
CDE or OC.
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Once an element has been checked as Human Verified, a checkmark also appears
next to the element in the navigation tree. This makes it very easy for you to identify
which elements still need to be reviewed and verified.
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Figure 3.28 SIW Viewer in Curate XMI File mode, with human verified elements

After the file is fully curated, you must mark all elements as Human Verified, to mark
the elements in the navigation tree are marked with a checkmark. This includes the
elements that you either mapped or verified the mapping of concept information for,
and the elements that are already mapped to CDEs or OCs.

To verify an element:

1.
2.

Select an element from the navigation tree.

Review the information in the detail view to verify that all of the necessary
information is mapped to the element.

Click the Human Verified checkbox to enable it. One of the following occurs,
depending on the element you are verifying:

[o]

If you have selected a class element and there are un-verified attributes
associated with that class, the next item in the tree is automatically selected
for you to verify.

If you have selected an attribute, a checkmark appears on the attribute in
the navigation tree and the next item in the tree is automatically selected.

If you have selected the last attribute in the class to be verified (all others
have already been verified), and the class has already been verified, a
checkmark appears on the attribute you are verifying and on the class
element, and the next item in the tree is automatically selected.

The automatic movement of the SIW to the next element during element verification is
simply a navigational aid, so that you do not have to continually click Next to move to

the next item. Once an element is verified, the SIW assumes that you are finished with
that item.
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Once you have reviewed all items in the file, and cleared all of the errors listed in the
Errors tab (which may require multiple launches of the SIW and the XMl file to update
the Errors tab), you must save the file using the File > Save As command. Curated and
verified files should be saved with the term “annotated” appended to the front of the
filename. For example, if the original file name was FirstPass_myModel .xmi then
you would save the file as Annotated_ FirstPass_myModel .xmi. If the original file
had a .uml extension (exported from ArgoUML) then the curated file must also be
saved with a .uml extension.

For further instructions on saving a file, see Saving Changes to a File on page 39.

The curated file should be ready for Review. The curated XMl file is used as input to the
Reviewing an Annotated XMI File step.

Reviewing an Annotated XMI File
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The Review Annotated XMI File step is performed by the model owner after the EVS
curation team finishes annotating the file and returns the annotated file. During this
review step in the semantic integration process, the model owner can make corrections
and/or simply verify the mappings contained in the annotated XMl file. Users can
search EVS for concepts to change the concept mapping for a class or attribute, or
users may choose to map UML attributes to existing caDSR value domains or data
elements where valid, applicable caDSR items already exist.

The main difference between working with a file in the Review Annotated XMl File
mode as opposed to the Review Unannotated XMI File or Curate XMI File mode is that
the Review mode shows all of the items from the UML model that will be uploaded into
caDSR. The Review mode also shows concept errors and other problems with the file
that were not relevant to an unannotated file.

When opening a file in the Review Annotated XMI File step, the SIW performs a
number of validation checks to ensure that the XMl file can be correctly transformed
into caDSR metadata. For each UML class and attribute in the file, the SIW checks for
the presence of at least one of each of the following:

° Concept code

°  Concept hame

° Concept definition

°  Concept definition source
° Valid datatype

Furthermore, when the file passed the Curate XMl File step, each element was
checked as Human Verified. When the annotated file is opened in Review Annotated
XMI File mode, those checkmarks are reset so that the model owner can review each
element in the file and when satisfied that the element is complete, check the element
as Model Owner Verified.

If any of the elements in the file are missing any of the required mapping items, the SIW
lists an error in the Errors tab, allowing the model owner to review the error and make
changes to the element mapping as appropriate.



Note:

Note:

Chapter 3 Semantically Integrating Your UML Model

All errors must be corrected before a model can be loaded to the caDSR.

Reminder about the Errors tab—The SIW generates the Errors tab information when
the file is opened; it cannot update the error listing dynamically. This means that as you
make changes, you will need to save the file, exit the SIW, then reopen the saved file in
the Review Annotated XMI File mode to see an updated error listing.

Input: The Annotated XMI file as curated by the EVS concept curation team. The
file is returned to the model owner with the term “Annotated” added to the beginning
of the file name.

Example: Annotated_FirstPass_myModel .xmi or
Annotated_FirstPass_Roundtrip_myModel .xmi for EA generated models.
For ArgoUML-generated models, the file names would end with a .uml extension.

Output: An Approved Annotated XMl file. When you save the file, you should
append it with the term “approved” at the front of the filename. For example:
Approved_Annotated_ FirstPass_myModel .xmi or
Approved_annotated_ FirstPass_ Roundtrip_myModel .xmi. For ArgoUML
generated models, the file names would end with a .uml extension.

If you need to return the file to the EVS curation team for an additional curation pass at
the file after review, you may choose to save the file with the term “fixed” appended to
the front, rather than “approved.” In addition, you may also want to employ the use of
revision numbering in the file name, so that you can delineate between the different
versions of processed files (e.g., fixed_r2_annotated_FirstPass_myModel.xmi).

The end result of the Review XMl file step is a file that contains no errors, and where all
of the elements in the file have been checked as “Model Owner Verified.” Once you
have reviewed the concept mappings for each element in the file and mapped elements
to caDSR CDEs where appropriate, you can then finally verify all of the elements in the
file and save the file as an “Approved Annotated” version of the XMl file. The approved
annotated XMl file is the file that will be passed on to NCICB for logging into CVS and
loading to caDSR.

To Review an Annotated XMl file:

1. Be sure you have saved the annotated (curated) XMl file you received from the
EVS curators.

2. Open the SIW URL: http:\\cadsrsiw.nci.nih.gov.
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3. From the SIW Welcome screen, select option 5. Review Annotated XMI File
(Model Owner) and click Next. The file selection screen appears.

B Semantic Integration Workbench 4.0.0.0 -- Review Annotated XMI File @

Flease choose  file to parse
The File must be in XMI or (Argo) UML format

Click browse to search for an %MI or (Argo) UML fiie

Zipsifized_annotated_FirstPass_PSC_v2_rvZ.xmi

Recent Files:

annotated_gridPIR_wi_2_rv1ami

|_FirstPass_PSC_w2_rv2.ami

|_annotated_grdPTR w1 2_rv2.mi

[[] Chaase Classes and Packages

[[<Back ] [ mext> | [[Cancel |

Figure 3.29 Select a file for SIW to parse and display for review

If you have used the SIW before, the last five files used for this option appear in a
Recent Files list located below the filename text box.
4. ldentify the file you want to review. You have the following options:

° If the file you want to review appears in the Recent Files list, click on the file
name to populate the filename field with the path/filename.

° Type the full path and filename into the text box.

° Click Browse to browse for and select the file exported from EA or
ArgoUML.

Note: The Browse function defaults to selecting (showing) only files with an
xmi file extension. If you are using a .uml file, select UML Files from the
Files of Type drop-down list at the bottom of the Open dialog box.

5. If you want to review only portions of the file, enable the Choose Classes and
Packages checkbox. Otherwise the SIW will parse the entire file for review.
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6. Click Next. If you enabled the Choose Classes and Packages checkbox, the
package selection screen appears, listing all of the packages in the file.

B Semantic Integration Workbench 4.0.0.0 -- Review Annotated XMI File g|

Please selsct which classes or packages
you would like ta apen by check-marking  node.

@ edu northwestern.biainformatics. sudyealendar domain. delta

2 edu northwestern. biainformatics.studyealendar. domain,scheduledactivitystate
 edu northwestern.bisinformatics.studyealendar. domain

@ javalang

2 java.uti

[ <gack | [Het> | [ concel |

Figure 3.30 Package selection screen - lists the packages resident in the file

7. All packages listed are checked by default. Click a checkmark to open a list of
all items contained within the package, and then click the checkmarks next to
any items you do not want the SIW to parse for review. Then click Next.

The SIW displays the file selection screen with a progress bar at the bottom showing
the current action and overall progress. How long this process will take is determined
by the size of the XMl file or packages you are using as well as the number of errors or
warnings the SIW must generate.

When the SIW is finished parsing the annotated file, the SIW viewer appears showing
the selected file (or selected packages/classes).
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Figure 3.31 SIW Viewer - showing an Annotated XMI file with errors
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Use the SIW viewer to review the mappings for each element, and where listed, the
errors encountered in the file, to determine what changes need to be made in the file
before it can be considered “approved” and then uploaded to caDSR.

If necessary, see Using the SIW Viewer on page 27 for a basic overview on navigating
the SIW viewer and on using the Previous, Next, Add, Apply and Search EVS
buttons.

You are also strongly encouraged to review the Editing Concept Information in Curate
Mode section beginning on page 65. This section provides detailed information on
making changes to the concept information of your file, including searching EVS,
replacing mapped concepts, reordering concepts, and removing concepts for an
element.

Changing Concept Information in Review Mode

78

Note:

While reviewing the annotated file you received from the EVS curation team, you may
find that you need to make changes to the concept information mapped to some of the
elements. The information in this section provides basic procedures for how to add,
replace, reorder and remove concept information for an element. For more detailed
information on these features, see Adding EVS Concepts to an Element in Curate
Mode on page 60 and Editing Concept Information in Curate Mode on page 65.

If you do make changes to the concept information in your model, you may want to
validate the concepts in your XMl file against those in EVS. The Validate Concepts
option, located under the Run menu, performs a comparison of the concept information
in your XMl file against the concept information in EVS. For more information on using
this feature, see Validating XMl File Concept Information Against EVS on page 70.

If you accidentally make changes to concept information that you did not intend to
make or don’t want to keep, click Previous or Next before clicking Apply. The SIW
prompts you regarding whether or not to save the change. Click No and the element’s
concept information is returned to its original state.

Adding EVS Concepts to an Element in Review Mode

Even though your file has been curated, you may find that it requires further addition of
Qualifier concepts.

To add a concept:
1. Inthe SIW viewer, select an element from the navigation tree.

2. Inthe detail view, click Add. A set of empty concept fields appears, along with a
Search EVS button.

Note: If you have changed your viewer Preferences to Display Primary
Concept First, the new concept fields will appear below the existing
mapped concepts, meaning you may need to scroll down in the detail
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view to see the new fields. See Setting Viewer Preferences on page 36 for
more information.
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Figure 3.32 SIW Viewer in Curate XMI mode, showing new blank concept fields.

Click Search EVS and perform a search for the appropriate concept to map.

Enter the item you want to search for into the Search text box, select whether
you are searching for a Synonym or Concept Code, then click Search.

When the concept you want to add appears in the search result set, double-
click on the item to populate the concept fields with the information. For more
details on using the EVS Search to populate the concept fields, see Searching
EVS for Concept Information on page 62.

When the concept fields are complete, click Apply. This applies the new
concept to the element. (You will still have to save the file after all of your
changes are made. See Saving Changes to a File on page 39.

If necessary, after applying your changes, you can click Add again and
complete the above steps to add another concept to this element.

Replacing Mapped Concepts in Review Mode

Note:

Some mapped concepts may need to be replaced because the concept information
mapped to them is not exactly what you intended for the item. In this case, you can
search EVS for a better match and replace the existing concept.

Replacing mapped concepts is the same as adding concepts to an element, except that
the concept information fields are already populated. Unless you have changed your
default viewer Preferences, clicking Search EVS automatically launches a search of
the NCI Thesaurus using the existing concept name of the item. See Setting Viewer
Preferences on page 36 for more information.

If you cannot find a matching concept in EVS, contact the EVS curation team to work
with them on finding an existing concept or creating a new one.
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To replace a mapped concept:

1. Select an element to view, and if necessary scroll through the detail view to find
the concept you want to replace.

2. Click Search EVS, located to the right of the Concept Code field of the concept
you want to replace. The Search Thesaurus dialog box appears and should
contain search results based on the text in the Concept Name field of the
concept you are replacing.

3. Since the automated search may be how the incorrect concept was mapped in
the first place, you will probably want to change the text in the Search field to
return results that better reflect the element concept you are trying to map.

4. Click Search.

5. Review the search results. If the concept you want to use appears in the list,
double-click anywhere in that row. The new concept information replaces the
old concept information.

If the search results do not return any concepts you want to use, revise your search
criteria (using a wildcard [*] if necessary) and search again. If you cannot find a
matching concept in EVS, contact the EVS curation team to work with them on finding
an existing concept or creating a new one.

After making changes to the concept information, click Apply to apply the changes to
that element. If you attempt to navigate away from the element without applying your
changes, the SIW prompts you to apply or discard your changes.

Changing the Order of Mapped Concepts in Review Mode

Every element must have a Primary Concept that reflects the basic point or meaning of
the item, and then may have Qualifier Concepts that reflect additional details about the
element. This is often true of attributes, which can reflect multiple details about the
class element to which they belong.

The order in which the concepts are mapped reflects the order given to those concepts
in the SIW. This means that the first concept mapped is always the Primary Concept,
while subsequently mapped concepts become Qualifier concepts with numbers that
reflect when they were added (respectively). The order of these Qualifier concepts
must reflect the intentional semantic meaning of the element to which they are mapped.

However, you may discover that the concepts for an element are not mapped in an
order that reflects your purpose for the element. In this case you will want to change the
semantic order of the mapped concepts.

For more information on the semantic ordering of mapped concepts, see Changing the
Order of Mapped Concepts in Curate Mode on page 66.
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buttons appear to the right of the Concept Definition field in the detail view of the SIW

viewer.
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Figure 3.33 An attribute element with multiple concepts and the order control buttons.

The arrow buttons move the concept information either up or down (as indicated by the
arrow selected) one position in semantic order for that item. The X button removes the
concept from the element.

The ability to rearrange the semantic order for concepts is most useful if you have to
add or replace mapped concepts for the element. In that case, you can use the Search
EVS button to find and add/replace concept information in any order you like, and then

use the arrows to put the mapped concepts into the proper order, based on the

intended purpose of the element in the model.

To change the semantic position of a concept:

1. Select an element to view, and if necessary scroll through the detail view to find
the concept you need to move.

2. Click the Up Arrow or Down Arrow located to the right of the Concept

Definition field.

Notice that the concept is not simply moved; the concept switches places with the

concept located next to it. This means that you will probably have to repeat these steps
multiple times to get the concepts into the proper semantic order, moving concepts up
and down in the list as necessary.

When finished, look at the Summary Concept Name listed for the element, and be
sure it reflects your intended meaning or use of the element within the model.

After making changes to the concept information, click Apply to apply the changes to

that element.
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Deleting Mapped Concepts in Review Mode

Note:

If you have added unnecessary or inaccurate concepts to an element, or find that the
curation process left concepts that should not be mapped to an element, you can delete
them. However you may only remove concepts if there are multiple concepts mapped
to an element (because each element must have a Primary concept). If your element
contains only one concept, you must add a new concept before you can delete the
existing one. See Adding EVS Concepts to an Element in Review Mode on page 78.

To remove a concept from an element:

e Click the X located next to the Concept Description field of the concept you want
to remove. The concept is deleted.

After making changes to the concept information, click Apply to apply those changes to
the element.

If you accidentally delete a concept that you did not intend to remove, click Previous
or Next before clicking Apply. The SIW prompts you regarding whether or not to save
the change. Click No and the concept information is returned to its original state.
Please note that this “undo” action does NOT apply if you select to Apply to All. In
that instance you must exit the SIW without saving your changes and re-open the file.
You will lose all of your change since the last time you saved the file.

Mapping UML Attributes to caDSR CDEs

82

Note:

Each UML attribute in your model can either be mapped to one or more EVS concepts
or mapped to a caDSR CDE. Mapping an attribute to a CDE automatically maps the
class element to the caDSR OC of the CDE and the datatype for the attribute to the
value domain of the CDE. For more information on the relationship between UML
model elements and caDSR CDEs, see Terms You Should Know on page 10 and
Using Pre-mapped CDEs (Common Data Elements) on page 101.

While you are reviewing your annotated file, you may find that you can map some of the
attributes in your model to CDEs. This mapping provides direct connectors between the
items in your model and caDSR metadata, and improves the semantic integration of
your model with other caCORE-compatible systems.

When viewing an attribute in Review Annotated XMl File mode, for any attribute not
already mapped to a CDE, the detail view provides a Map to CDE button. Clicking Map
to CDE displays a different detail view including a Search Data Element button that
allows you to search the caDSR for CDEs to map to the selected attribute.

When you click Map to CDE, notice that it turns into a Map to Concepts button. This
allows you to toggle between the CDE mapping and EVS concept mapping views for
the selected attribute. Once you have applied to mapping of the attribute to a CDE
however, the concept information no longer appears, in favor of the CDE mapping.

The Map to CDE button is not available if the attribute uses a LVD. This is because
mapping an attribute to a CDE automatically maps the caDSR value domain as well.
For more information on creating and using LVDs for your model instead of caDSR
value domains, see Using Local Value Domains on page 17.
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Mapping a UML Attribute to an Existing Common Data Element
Any attribute in the UML model can be mapped to an existing caDSR CDE. In addition,
you can replace a CDE mapping if it is incorrect or needs to be updated to use a newer
version of the CDE.

To map an attribute to a CDE:

1. Select an attribute in the navigation tree. If the attribute has not already been
mapped to a CDE, concept information appears in the detail view along with a
Map to CDE button. If the element is already mapped to a CDE, skip to Step 3
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Figure 3.34 SIW Viewer Detail View showing Map to CDE button

2. Click Map to CDE. The detail view changes to show empty data element fields.
In addition two new buttons appear: Search Data Element and Clear. Also
notice that the Map to CDE button has changed to Map to Concepts.
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Figure 3.35 Detail View after the Map to CDE button is clicked
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3. Click Search for Data Element. This opens the Search for Data Element dialog
box, allowing you to search the caDSR for CDEs to map your attribute.

Search for Data Element g|
Search: | | | Freestyle Search | [ Suggest ]
LongMarme Wworkfl.., PublicId = Wersion | Preferr... Conte... Regist...

Results Per Page Search Preferences

Figure 3.36 Search for Data Element dialog box

Note: If you have conducted a previous search for a data element during the
current session, the Search for Data Element dialog box will be
populated with the previous search information/results.

4. In the Search for Data Element dialog box you have two choices:

° Enter aterm in the Search field and click Freestyle Search. This search
takes advantage of the Freestyle search engine which searches a variety of
fields in the caDSR for the term entered (http://freestyle.nci.nih.gov/
freestyle/do/search). You may use the asterisk (*) as a wildcard character.

° Click Suggest. This searches the caDSR for any element with an alternate
name that matches the attribute name you are attempting to map. Suggest
uses only the attribute name ignoring any information in the Search text box.

The results appear below the search options.

Search for Data Element E|

Search: |b\ackuut munth\ | [ Freestyle Search l [ Suggest ]

LongMame ‘orkflow 5... | Public Id Version Preferred De...  Context Mame  Registration...
Felative Yalue Recurrence Blackout .., [DRAFT NEW 2732816 1.0 Considered inc. .. |caBla
Blackout Specified Date Month java.l... [DRAFT MEW 2732828 1.0 A suspension o.., |caBIG
Elackout Date Description javalang.... [DRAFT MEW 2732792 1.0 A suspension o... |c3BIG
Blackout Specified Date Description j... |[DRAFT MEW 2732831 1.0 A suspension o.., |caBIG
Elackout Specified Date Year javaua,.. [DRAFT MEW 2732829 1.0 A suspension o... |caBIG
Blackout Specified Date Day java.lan... DRAFT MEW 2732827 1.0 A suspension o, |caBIG
Wisit Report Month Caunt RELEASED 2002280 3.0 the month, aft... |[CTEP Qualified
Month Humber APPRVD FOR .., 2005202 3.0 the month num. .., |CTEP Qualified
Last Menstrual Cycle Period Manth D... |RELEASED 2606075 1.0 Mumeric value ... [caBIG Qualified
Prescription Medication Last Month ... |[RELEASED 2634994 1.0 A numeric code, ., [MHLEL Cualified
Alpha DYG Manth RELEASED 2163184 2.0 (Cracle's Alpha ... |DCP Qualified
Cigarette Smoking Cessation by Month |RELEASED ZZEEEEZ 1.0 The identificati,.. |PS8CC Qualified
Alcohol 5 of More Drinks Month Freq... |RELEASED 2202067 1.0 The frequency ... |[DCP Qualified
Alcohol Past Month Average RELEASED 2202062 1.0 The average p... [DCP Qualified
Alcohol Past Month Intake Indicator RELEASED 2202060 1.0 A question as .., [DCP ualified
Alpha DYG Maonth RETIRED AR... (2183184 1.0 Cracle's Alpha ... |DCP Superceded
Patient Crack Posterior Tooth Therap... RELEASED 2449302 1.0 the number of .., [NIDCR
Post Brachytherapy Month Period Du... |APPRYD FOR ... 2201439 1.0 the post-brach... |[CTEP
Month Year Day DRAFT NEW 2005378 .0 PLEASE PROWI... |CTEP
hat month is it now? RETIRED AR... 2003175 3.0 PLEASE PROVI... |CTEP
day month year RETIRED DEL... 2005120 3.0 PLEASE PROYI,.. [CTEP
0-21 of 21 Results Per Page Search Preferences

Figure 3.37 Search for Data Element dialog box with search results
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If there are multiple pages of results, the Previous and Next buttons are
enabled, allowing you to scroll through the results pages. In addition, you can
resize both the search window and the columns within the results table, if
necessary, to see more information in each field.

If the search returns no results (the Search dialog box remains empty), the

element you want to map does not appear in the result set, or the search
returns too many results, alter your search criteria and/or use the wildcard (*) to
return different results. You may also choose to click Close to close the Search
dialog box without mapping the attribute.

If the CDE you want to map appears in the result set, double-click anywhere in

the row for the item. This closes the Search dialog box and enters the
information for the selected CDE into the fields in the SIW viewer. It also maps
(or verifies) the OC to the class associated with the attribute and the value
domain to the datatype for the attribute.

Note: Itis recommended that only data elements with a status of “Released” be
used to map to model attributes.

You may receive an invalid selection error informing you that the DE you selected is
mapped to a different OC than the current class element. This means that the selected
element cannot be used for this mapping, and you must select a DE containing an OC
that corresponds to the OC already mapped for the class element.

Another error you may encounter is that mapping the attribute to the selected DE
causes a duplicate mapping. A duplicate mapping occurs when a different attribute in
your model has already been mapped to the selected CDE.

If you select a valid CDE, the data element information appears in the detail view for the

attribute.
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Once you have selected the CDE to map to the attribute, you have the following
options:

e Click Map to Concepts to return to the concept information view. You may
toggle between the concept and the CDE view for the attribute until the CDE
mapping is applied. Once an attribute is mapped to a CDE, the concept
information no longer appears.

e Click Clear to undo the choice of the CDE and then click Apply. This removes
the CDE information mapping from the attribute.

e Click Apply to map the CDE to the attribute.

When an attribute is mapped to a CDE, the class that the attribute belongs to is
mapped to the OC for the CDE selected, and the datatype for the attribute is mapped to
the value domain for the CDE. If this is the first attribute for the class being mapped to a
CDE, the SIW pops up a note informing you of the OC-to-class mapping.

Please note

i Please note that mapping this attribute to a Data Element
\) automatically maps the owning class to
that Data Element's Object Class.

Figure 3.39 Pop-up dialog box informing you of the mapping of the class to the DE’s Object
Class

Like the CDE mapping for the attribute, the OC mapping for the class replaces the
concept information displayed for the class.
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Figure 3.40 Viewer showing a class element mapped to a caDSR Object Class

Mapping a UML Attribute to an Existing Value Domain
Mapping an attribute to a CDE automatically maps the datatype for the attribute to the
value domain for the CDE. If an attribute is not mapped to a CDE, you can still map the
attribute’s datatype to a value domain from caDSR.
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The option for mapping an attribute to a value domain appears below the concept
information for the attribute in the detail view.
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Figure 3.41 The Value Domain information box is located below the concept information

Clicking the Search Value Domain button opens the Search for Value Domain dialog
box.

Search for Value Domain Pz|
Search: Search By |L0ng Mame | | Search |
LongMarme ‘Workflow Status Public 1d ersion Preferred D.., | Context Mame
Tubule Formation ... [DRAFT MEW 2432055 1.0 Scores the de... [caBIG
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Gleason Score For .. [DRAFT MEW 2434127 1.0 The score deri.., [caBIG
Percentage Integer [DRAFT MEW 2434147 1.0 Percentage; a... [caBlG
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COther Breast Can... [DRAFT MEW 2435614 1.0 A number with, .. [caBIG
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0-9af 9 Results Per Page Search Preferences

Figure 3.42 Search for Value Domain from caDSR to map to the selected attribute

The Search for Value Domain dialog box functions similarly to other search functions in
the SIW, allowing for the use of an asterisk (*) as a wildcard, and for resizing the dialog
box and columns as necessary to better view the information.

By default, the search looks for a LongName that matches the information entered into
the Search text box. You can also select to search by Public ID.

As with the other search functions, double-clicking an item in the result set maps the
selected value domain to the selected attribute in the model.
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After making changes to the value domain mapping, click Apply to apply those
changes to the element.

Re-Verifying the Reviewed XMI File
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Once you are finished reviewing the concept information in the file and where possible
mapping elements to caDSR CDEs, and the XMl file is annotated to your satisfaction,
you can use the Model Owner Verified checkbox to mark that the annotation for each
element is complete.

Once an element has been checked as Model Owner Verified, a checkmark also
appears next to the element in the navigation tree. This makes it very easy for you to
identify which elements still need to be reviewed and verified.
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Figure 3.43 SIW Viewer in Review Annotated XMI File mode, with model owner verified
elements

Once you are satisfied with the annotations for all of the elements in the file, you must
mark all elements as Model Owner Verified. This includes the elements that you
mapped to CDEs and those you simply verified the concept mapping for.

To verify an element:
1. Select an element from the navigation tree.

2. Review the information in the detail view to verify that the element is mapped to
your satisfaction (either to one or more concepts or to an OC or CDE).

3. Click the Model Owner Verified checkbox to enable it. One of the following
occurs, depending on the element you are verifying:

° If you have selected a class element and there are un-verified attributes
associated with that class, the next item in the tree is automatically selected
for you to verify.
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° If you have selected an attribute, a checkmark appears on the attribute in
the navigation tree and the next item in the tree is automatically selected.

° If you have selected the last attribute in the class to be verified (all others
have already been verified), and the class has already been verified, a
checkmark appears on the attribute you are verifying and on the class
element, and the next item in the tree is automatically selected.

The automatic movement to the next element during element verification is simply a
navigational aid, so that you do not have to continually click Next to move to the next
item. Once an element is verified, the SIW assumes that you are finished with that item.

Once you have reviewed all items in the file, and cleared all of the errors listed in the
Errors tab (which may require multiple launches of the SIW and the XMl file to update
the Errors tab), you must save the file using the File > Save As command. Reviewed
and verified files should be saved with the term “approved” appended to the front of the
filename. For example, if the original file name was
Annotated_FirstPass_myModel .xmi, then you would save the reviewed file as
Approved_Annotated_FirstPass _myModel .xmi. If the original file had a .uml
extension (exported from ArgoUML) then the reviewed file must also be saved with a
.uml extension.

For further instructions on saving a file, see Saving Changes to a File on page 39.

The reviewed approved annotated XMl file is used as input to the UML Loader by the
NCICB staff. You can use the approved annotated XMl file as the input to the next
version of your model, or to update the current version of the model with the SIW-
generated annotations. See Updating UML Model Definitions with SIW-Generated
Changes on page 40 for more information.

Troubleshooting

In addition to the troubleshooting tips listed below, the caDSR team maintains a list of
commonly asked questions and tips about the SIW and UML Model Loader on the UML
modeling FAQs wiki page located at: https://wiki.nci.nih.gov/x/7wFy.

The Status Bar
At the bottom of the main viewer window, the Status Bar displays confirmation and
informative messages. Use it to confirm that a file was saved, that changes were
applied or need to be applied.

Apply Changes vs. Saving Changes
Apply - Applies the changes made to the concept information. The Apply button is
disabled until all concept fields are populated for newly added concepts, or until a
change is made to existing concept information.

You must click Apply before navigating away from the changed item’s node, or your
changes will be discarded. The SIW prompts you to apply your changes if you attempt
to view another node before clicking Apply.

Clicking Apply is not the same as saving the file. Apply simply applies your changes to
the currently open session. You must still save the file (File > Save or File > Save As)
to create an updated XMl file containing the applied changes.
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Multiple Tabs Open

Each type of element in the SIW viewer will open in its own tab. this means that if you
select different types of elements from the navigation tree to view, you will likely have
multiple tabs open at once. Click the element title on each tab to see the information
about that element; use the “X” on the tab to close the tab. See Detail View on page 29
for more information on tabbed viewing.

Search Dialog Box

90

The SIW contains several different search functions, including the EVS search, the
data element search and the value domain search. The different search functionality for
each item is similar but not identical. Furthermore, when you open a search dialog box
to perform a search, you may find the previous search information still located in the
dialog box and/or result set. Not all of the searches clear their information between
search sessions.

All of the search features, however, allow you to resize both the dialog box and the
column width of the result set, providing better visibility of the items listed. In addition,
the Previous and Next buttons always function as “page turners” when there are
multiple pages of results, and the Close button always closes the dialog box without
performing any mapping.

For more information about the different search capabilities, see the following sections
of this chapter:

e Searching EVS for Concept Information on page 62
e Mapping a UML Attribute to an Existing Common Data Element on page 83
e Mapping a UML Attribute to an Existing Value Domain on page 86.



CHAPTER

CACORE UML LOADER AND
REGISTERING METADATA

The UML Loader is a Java application that transforms UML domain models into caDSR
metadata, reusing existing caDSR administered components or creating new ones as
needed. This process is also referred to as registering the UML model in caDSR.

This chapter describes how the UML Loader transforms the UML model data from an
annotated XMl file into caDSR metadata while also mapping the registered metadata
back to the UML model that uses it.

Metadata registration into the caDSR is performed by a team at the NCICB, working
with model owners to be sure that the information from their model is registered
properly. The information in this chapter is designed to help model owners understand
how their annotation work translates into caDSR content so that they can accurately
predict the outcome of the loading of their model into caDSR.

Beyond the basic mapping of UML model elements to caDSR registered objects, this
chapter also contains basic information about how association and inheritance
relationships translate into caDSR content.

Topics in this chapter include:
e Overview of UML Loader Process on page 92
e Relating (Classifying) Metadata Items to UML Models on page 94
e Using Pre-mapped CDEs (Common Data Elements) on page 101
e Creating and Updating Concepts in caDSR on page 101
e Mapping a UML Class to an Object Class on page 102
e Mapping a UML Attribute to a Property on page 103
e Mapping a UML Class to a Value Domain on page 104
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e Mapping Data Element Concepts on page 107

e Mapping Data Elements on page 108

e Mapping UML Associations to Object Class Relationships on page 109
e Mapping UML Inheritance on page 110

¢ Reviewing and Verifying Registered Metadata on page 113

Note: Before continuing, you are encouraged to review Terms You Should Know on page 10
regarding the definitions of data elements and data element concepts, how they are
formed, and how UML model elements relate to caDSR components.

Overview of UML Loader Process

Once the UML object model is annotated with EVS concepts and the annotated version
of the model has been approved, the model owner sends the annotated XMl file to the
NCICB caDSR team for processing. The EVS concept annotations contained in the file
are the basis for determining whether each of the UML elements can be represented
using existing caDSR components or if new ones must be created.

These EVS concept annotations function as the semantic bridge between the elements
in the class model and the components in caDSR. This is why the UML Loader will not
load XMl files that do not contain the mandatory EVS concept tags for all UML classes
and attributes.

UML model element to caDSR component mapping is summarized in Table 4.1.
Specifically, the UML Loader transforms UML model attributes and classes, including
inheritance and association links, into caDSR metadata. UML class operations and
other types of UML elements are not transformed. In addition, the UML Loader does
not transform UML data models.

UML Model caDSR Administered - :
Additional Information
Element Component
Mapped EVS caDSR Concept (Concept The UML model concept information
Concept Class). is correlated to caDSR concept
(concept tagged | caDSR maintains its own information. If the model contains a
value) concept data, corresponding to | €ONcept not resident in caDSR, a new
the information in EVS/NCI caDSR Concept is created for use.
Thesaurus
Class Object Class (OC) Using the concept codes mapped to
the class element, an existing caDSR
OC is used or a new one is created.
Attribute Property Using the concept codes mapped to
the class element, an existing caDSR
Property is used or a new one is
created.

Table 4.1 Transformation Mappings from UML Model Elements to caDSR Components
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UML Model caDSR Administered - .
Additional Information
Element Component
Datatype (Attribute | Value Domain) This is the datatype associated with
Datatype) the attribute in the model. Typically

the datatypes used are common Java
datatypes and as such already exist in
caDSR. However, some models
define their own local datatypes (as
classes in the model) and associate
those with the attributes in the model
using tagged values.

Locally defined datatypes are referred
to as “local value domains” or “LVD.”

Class-Attribute
combination

Data Element Concept (DEC)

A DEC is the combination of an
OC and a Property.

After the OC and the Property are
mapped (to the class and attribute),
they are combined to form a DEC. If
the combination already exists in
caDSR the existing DEC is used. If
the combination is new, a new DEC is
created.

One DEC is formed for every class-
attribute combination in the model. So
if the model has a class element
“Gene” that has four attributes, four
DECs are formed.

Class-Attribute-
Datatype
combination

(The datatype is
the datatype
identified for the
attribute.)

Data Element (DE) or Common
Data Element (CDE).*

A DE or CDE is the
combination of a DEC with a
value domain.

*The terms DE and CDE are
used interchangeably.

After the DEC is formed, the value
domain is determined and added to
the DEC to form the DE.

If the combination already exists in
caDSR the existing DE is used. If the
combination is new, a new DE is
created.

One DE is formed for every class-
attribute-datatype combination in the
model.

So if the model has a class element
“Gene” with four attributes, there will
be four DECs formed. Each of those
DECs will be combined with the value
domain corresponding to the datatype
for each attribute, forming four DEs.

Table 4.1 Transformation Mappings from UML Model Elements to caDSR Components

So for every element in the UML model, a corresponding metadata component (also
referred to as an administered component) in caDSR is either mapped or created (and
then mapped). The “mapping” of caDSR components involves adding information
about the project and the model to the component information in caDSR. This process
of relating caDSR metadata to the models that use them is described in more detail in
Relating (Classifying) Metadata Items to UML Models on page 94.
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Submitting a UML Model to caDSR

When you have completed the semantic integration process and are ready to submit
your UML model (via fully annotated and approved XMl file) to NCICB for registering,
contact the NCICB help desk at: ncicb@pop.nci.nih.gov.

You will either be provided with the submission form and instructions, or pointed to the
location of the form on GForge: http://gforge.nci.nih.gov/docman/
index.php?group_id=64&selected_doc_group_id=184&language_id=1

You may want to follow the link to the submission form before you are ready to submit
the file, in order to review the pre-requisite instructions included with the form.

Your model will initially be loaded to the caDSR Sandbox environment, allowing you to
review the loading of your model and work with the caDSR curators to make any small
changes needed. For more information on reviewing your model's elements after they
are loaded, see Reviewing and Verifying Registered Metadata on page 113.

Relating (Classifying) Metadata Items to UML Models

94

Whenever caDSR metadata items are created or reused for a UML model, certain
information about the model is appended to the item in the caDSR. This is done for two
reasons:

1. It allows the information to be cross-referenced by Project Name and/or model
information (class or attribute name);

2. It provides detailed information about how the Project/Model uses that particular
caDSR component.

The relationship mapping is done by “Classifying” each component and by assigning an
“Alternate Name” and “Alternate Definition” to each component.

The following table identifies the relationship between the information added to each
component in caDSR and the UML model item that provides that information. Keep in
mind that the more common caDSR components (“gene name” or “patient”) is likely to
have several of each of these associated with it, because each time a model uses the
component, the relationship information is added to the component in caDSR.

caDSR Component

. UML Model Information Used to...
Information
Classification Scheme | Project Name All caDSR components derived from
(CS) Provided by the model UML models are “classified” during
Identifies the project in | owner in the form submitted | Model load. Classification identifies
caDSR. with the model to NCICIB. | Which projects use that caDSR

component in their model.

Classification also provides a method
of categorization for caDSR items.
You can search caDSR for a
particular component or you can look
for all components in a CS.

Table 4.2 Relationship between caDSR component information and UML model
information.


ncicb@pop.nci.nih.gov 
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caDSR Component
Information

UML Model Information

Used to...

Classification Scheme
Item (CSI)

Identifies the sub-
project, project alias or
package name in
caDSR

Sub-Project, Project Alias or
Package Name

Provided by the model
owner or detected by the
UML Loader (packages
only).

The CSl is used as an additional
classification or identification
mechanism for when projects are
divided into sub-projects or
packages.

Also like CS, CSils provide an
additional level of categorization for
caDSR components.

Object Class Alternate
Name

Class Name

Provides the exact name of the class
element as used in the project’s
registered model, which has been
mapped to this particular caDSR OC.
The CS identifies the project.

Object Class Alternate
Definition

Class description - Text is

pulled from the description
tagged value for the class

element in the model.

Relates the identified project’s
intended use or definition of the class
mapped to this particular caDSR OC.
The CS identifies the project.

Data Element
Alternate Name

Two are created:

Class Name & Attribute
Name (connected with a
colon);

Package Name & Attribute

Name (referred to as a “fully
qualified attribute.”)

One provides the project’s specific
name for the class/attribute
combination used to form this
particular caDSR DE; the other
provides the fully qualified attribute
information for the attribute used to
form the DE.

The CS identifies the project; the fully
qualified attribute name identifies the
package or sub-project of the model
containing the attribute.

Data Element
Alternate Definition

Attribute description - Text is
pulled from the description
tagged value for the attribute
element in the model.

Relates the project's intended use or
definition for the attribute used to
form this particular caDSR DE. The
CS identifies the project.

Table 4.2 Relationship between caDSR component information and UML model

information.

Note: Alternate Names and Alternate Definitions are also created for Property and Data
Element Concept components, however these are not visible through the CDE Browser
and they reiterate the Alternate Name/Definition information for Object Classes and
Data Elements. They can be viewed through the CDE Admin Tool if necessary.

The sections that follow provide more detailed explanations for how and why caDSR
metadata is classified, how and why alternate names and definitions are added to
caDSR elements, and where you can view that information.
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Classitying UML Model Metadata (Classification Schemes and Classification
Scheme Items)

96

A Classification is a grouping of items related to a specific project or model. A
Classification Scheme identifies the project and version associated with the registered
model. A Classification Scheme Item identifies any sub-projects, packages, or aliases
included in the project (since UML class models are commonly organized into
packages). The UML Loader uses one classification scheme (CS) and at least one
classification scheme item (CSI) for each UML domain model. Unless otherwise
specified, all CS are created in the caBIG context.

The CS and CSI(s) for the domain model act as both a cross-referencing mechanism
for viewing only a specific model and as an identifier for which projects are using what
caDSR components in their models. Furthermore, classification schemes are used to
identify whether or not that grouping of components is ready for general access through
the CDE Browser. A CS will not appear in the CDE Browser until the workflow status is
set to “Released.” This allows model owners and curators to review and edit their
caDSR content before allowing full public visibility.

The CS for the project is created using the information provided on the form submitted
with the XMl file to NCICB. This information includes Project Abbreviated Name,
Project Long Name, Project Definition, and Version.

The CSI(s) for the project are created in one of two ways:

1. The UML Loader can be configured to create a CSI corresponding to each
package in the UML model, using the package names from the XMl file and
associating each CSI with the CS.

2. The UML Loader can be configured to ignore the separate packages in the UML
model and instead have only one CSI specified for the entire model. The UML
Loader then creates only one CSI associated with the CS.

When viewing caDSR components through the CDE Browser, the classification
information can be viewed in two ways: in the tree view of the main CDE Browser page,
and in the Classifications tab for a selected data element.

The CDE Browser tree view lists all Contexts that contain caDSR metadata. Expanding
a Context (click the + sign to the left of the folder) displays the components of the
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context, including a node for classifications. Expanding the Classifications node
provides a list of all classifications that have been loaded to that context.
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Figure 4.1 CDE Browser tree-view with node items labeled

Selecting a CS or CSl in the tree-view allows you to search or browse for only the
metadata elements used by that project/sub-project.

If you select to view a data element, one of the available tabs is called Classifications
and lists all of the CS and CSI that are mapped to that data element.
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|modals. |
Virsion 3 2 of caGORE

gov.nih.nci cabio domain miodels. (25284013 2

gev.nih.nei cabso damainicabld modal 271466110

1-5af5 v
I 2 Lol {oerion’
cabIo [UML_PACKAGE_ALIAS 27367271.0

gov nih ner cabno domam UML_PACKAGE NAME 273615641 0

caBIo UML_PACKAGE ALIAS 273672110

sgav.nith.nci.cabio domain UML_PACKAGE_MAME 2736156410
\gav.nih.nci.cabio. domain UML_PACKAGE_MAME 2736156:1.0

Figure 4.2 CDE Browser showing the Classification Tab for a Data Element

The classifications listing shows every CSI that uses the selected data element. This
means that the CS may be listed several times, once for each CSl it contains that uses

that DE.

CS and CSl information is also listed with each Alternate Name and Definition in the
main Data Element tab. These are discussed in more detail in the section below.
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Alternate Names and Alternate Definitions

Alternate Names and Alternate Definitions are used to provide specific meaning for
how or why a particular model used a particular piece of metadata. This is done by
providing both the exact name of the element(s) involved (class hame and/or attribute
name) and the element description resident in the model.

Because this information is specific to a particular project’s model, Alternate Names
and Definitions are always listed with the CS and CSI for the model.

Alternate Names and Alternate Definitions are created for all caDSR components,
however the CDE Browser only displays this information for Object Classes and for
data elements. The caDSR Admin Tool shows all associated alternate information.

Creating Alternate Names and Alternate Definitions for Object Classes
Each time a UML model class element is mapped to a caDSR OC, two Alternate
Names are created for that OC:

e A UML Class type Alternate Name: Provides the exact class name of the
element in the model. The project is identified by the CS/CSI listed with the
alternate name. The Type column shows UML Class.

e A UML Qualified Class type Alternate Name: Provides the exact package
name and class name combination for the class element. The project is
identified by the CS/CSI listed with the alternate name. The Type column shows
UML Qualified Class. For example, the class name “Gene” in the domain
“gov.nih.nci.cabio.domain” would become an Alternate Name of
gov.nih.nci.cabio.domain.Gene” with a Type of UML Qualified Class.

Alternate Names

Name Type Context
eduwust| geneconnect domain Gene 44— Package name and Class element name UML Qualified Class caBIG
Classifications as used in this project's model {CS)
C5* Long » €5 eg
CS* Definition Public . |CSIF Name CSI* Type
ame D \Version

GeneConnect is the mapping senice that will facilitate interoperability by interlinking VCDE approved genomic

identifiers. To interlink all of these identifiers, database annotations will be used to construct pair wise

connections, and then all-to-all relationships will bs calculated by traversing all possible combinations of edges in |54 o |1 o
the graph using every node as the starting point. Mext, using reciprocality calculations performed over the data :
sources. the set of non-commutable results will be determined with each record given a confidence score based

on the ratio of commutable results to all possible combinations for set of the genomic identifiers under question.

GeneConnect edu wustl geneconnect domain UML_PACKAGE_NAME|

Name Type Context
Gene #—— Exact Class name used in |UML Class caCORE
Classifications these project's models (CS)

cs )
CS5* Long Name  |C5* Definition Public 35 . |CSI* Name CSI* Type
D ersion
The lack of a common genomic identifier in biomedical databases results in an interoperability problem
in the caBIGTM environment. The question of how to deal with the problem of multiple identifiers (e.g.
Genomic Identifiers [RefSeq ID, GenBank D, Entrez Gene ID. Ensembl ID, UniProt D} all pointing to the same object 1.0 edu upenn med UML_PACKAGE_NAME
needed to be addressed at the metadata level. The purpose of this UML madel is to create CDEs for the
most common Genomic Identifiers for use by different projects within the ICR workspace.
Function Express Server is a tool that will annotate probes on microarrays using publicly available
biomedical databases and will automatically update these annotations on a regular basis. This data can
be viewed using a web-based query interface or may be accessed pregrammatically using the provided
caFE Sener 11 |Application Programmers Interface (API). Function Express Server can be used to create and populate a 2514015 |11 edu wustl fe UML_PACKAGE_NAME
database that will store interrelated gene annotation data. The web pages allow the user to display a
gene literature network in a tabular format, to search for genes on various annotations like Entrez Gene,
UniGene, Gene Ontalogy term. etc
caArmray \Version 2.0 caArray Model 2726654 2.0 gov.nih.nci.caaray.domain.array  |UML_PACKAGE_NAME

Cancer Bioinformatics
caCORE 3.0 caCORE Description 3.0 Infrastructure Objects (caBI0) UML_PACKAGE_ALIAS

Figure 4.3 CDE Browser - Object Class View showing Alternate Names for the OC.
For common classes, such as Gene, many different projects are likely to have used the

same class name for the item. In this case, the UML Class type Alternate Name will list
all projects, packages, and versions where a class element with that name exists.

98



Chapter 4 caCORE UML Loader and Registering Metadata

A single Alternate Definition is created for each class element mapped to a caDSR OC.
This definition is given the type UML Class and comes from the element description
tagged value(s) associated with the class element in the model. As with all alternate
information, the project is identified by the CS/CSI listed with the definition.

Alternate Definitions

Definition Type Context
Cantains gene genomic identifiers. = UML element description for this class element (Gene)  |UML Class caBIG
oot rms contained in this project's model
- cs «
C5"Long e g pofinition Public |55 |cSI* Name CSI* Type
ame D \Version
GeneConnect is the mapping senice that will facilitate interoperability by interlinking VCDE
approved genomic identifiers. To interlink all of these identifiers. database annotations will be
used to construct pair wise connections. and then all-to-all relationships will be calculated by
GeneGonnect [@ersing all possible combinations of edges in the graph using every node as the starting bsommha edu st geneconnect domain UML_PACKAGE NAME
paint. Next, using recipracality calculations performed aver the data sources, the set of non-
commutable results will be determined with each record given a confidence score based on the
ratio of commutable results to all possible combinations for set of the genomic identifiers under
question.
Definition Type |Context
|A hereditary unit consisting of a sequence of DNA that occupies a specific location an a and a particular ic in an organism. The  [UML | o\
funstional and physical unit of heredity passed from parent to offspring. Genes are pieces %, Class
Classifications UML element description for this class element (Gene)
£5* Lon tained in this project's model cs* cs
N 9 |cs* Definition ‘ (different C5ls contain the same class) Public A CSI* Name  |CSI* Type
ame D Version

The lack of a common genomic identifier in biomedical databases results in an interoperability problem in the

caBIGTM environment. The question of how to deal with the problem of multiple identifiers (e.g. RefSeq ID.

GenBank ID, Entrez Gene ID, Ensembl ID, UniProt ID) all pointing to the same object needed to be addressed at 10 edu upenn med| UML_PACKAGE_NAME
the metadata level The purpose of this UML model is to create CDEs for the most common Genomic Identifiers for

use by different projects within the ICR workspace.

The lack of a common genomic identifier in biomedical databases results in an interoperability problem in the

caBIGTM environment. The question of how to deal with the problem of multiple identifiers (e.g. RefSeq ID.

GenBank ID. Entrez Gene ID. Ensembl ID, UniProt ID) all pointing to the same object needed to be addressed at 1.0 UPenn UML_PACKAGE_ALIAS
the metadata level The purpose of this UML model is to create CDEs for the most common Genomic Identifiers for

use by difierent projects within the ICR workspace.

Genomic
Identifiers

Genomic
Identifiers

Figure 4.4 CDE Browser - Object Class View showing Alternate Definitions for the OC.

Many Alternate Definitions will have only one CS/CSI listed, while others will have
several. If the class is used either by multiple versions of a project and/or by multiple
packages within a model, each of those uses is listed because the class element is
defined the same way throughout the model; all of the CS/CSI listed use the exact
same element description within the model.

Creating an Alternate Names and Alternate Definitions for Data Elements
Alternate Names and Alternate Definitions for data elements are created using a
combination of the class and attribute element details from each model.

Each time UML model elements are mapped to form a caDSR DE, two Alternate
Names are created for that DE:

e AUML Class:UML Attr type Alternate Name: Provides the exact class/attribute
name combination of the mapped elements in the model, separated by a colon.
The Type column shows UML Class:UML Attr.

For example, the class element “Gene” having an attribute “name” would
become an Alternate Name of Gene:name with a Type of UML Class:UML
Attribute.

e A UML Qualified Attr type Alternate Name: Provides the exact package name,
class name and attribute name combination for the mapped elements in the
model, separated by periods. The Type column shows UML Qualified Attr.

For example, the class element “Gene” having an attribute “name” in the

domain “gov.nih.nci.cabio.domain” would become an Alternate Name of
gov.nih.nci.cabio.domain.Gene.name” with a Type of UML Qualified Attr.
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A single Alternate Definition is created for each class/attribute combination mapped to
a caDSR DE. This definition is given the type UML Class:UML Attr and comes from
the element description tagged value(s) associated with the attribute element in the
model.

The UML attribute description was chosen as opposed to the combination of the
description of the class and attribute because, in practice, when defining an attribute for
a class, the notion of the class is generally incorporated in the attribute’s description.

For DEs each CS/CSI is listed with the associated alternate information, as opposed to
listing the Alternate Names and Alternate Definitions separately as is the case for OCs.

Alternate Names and Definitions

CS”* Long Name Cs* Definition CSI* Name CSI* Type

caBlO caBIO model gov.nih_nci_cabio_domain UML_PACKAGE_NAME

/Alternate Names

Name Type Context Language
gov.nih.nci.cabio.domain. Gene.fullName UML Qualified Attr caCORE ENGLISH
Gene-fullName UML Class:UML Attr caCORE ENGLISH
|Alternate Definitions

Name Type Context

The title of the gene. UNML Class:UML Attr caCORE

cs*

Long | CS* Definition CSI* Name|CSF* Type
Name

Function Express Senver is a tool that will annatate probes on microarrays using publicly available biomedical databases and will automatically

update these annotations on a reqular basis. This data can be viewed using a web-based query interface or may be accessed programmatically

using the provided Application Programmers Interface (API). Function Express Server can be used to create and populate a database that will store  |edu wustl fe UML_PACKAGE_MNAME
interrelated gene annotation data. The web pages allow the user to display a gene literature network in a tabular format, to search for genes on

various annotations like Entrez Gene, UniGene, Gene Ontology term etc.

|Alternate Names

Server

Name Type Context Language

edu wustl fe Gene name UML Qualified Attr caBIG

Gene-name UML Class:UML Attr caBIG

|Alternate Definitions

Name Type Context
\A name for a gene determined by the Entrez Gene project at NCBI UML Class:UML Attr caBIG

CS” Long Name CS” Definition CSI* Name CSI* Type

caCORE 3.0 caCORE Description gov.nih.nci.cabio.domain UML_PACKAGE_MNAME

|Alternate Names

Name Type Context Language
gov_nih nci cabio domain Gene fullName UML Qualified Attr caCORE ENGLISH
Gene-fullName UML Class:UML Attr caCORE ENGLISH
/Alternate Definitions

Name Type Context

The title of the gene. UML Class:UML Attr caCORE

Figure 4.5 CDE Browser - Data Element view showing Alternate Names and Definitions

Creating Alternate Names and Alternate Definitions for a Property

Because the caDSR Property metadata represents the attribute element in a UML
model, the Alternate Names and Alternate Definitions for Properties are also based on
the attribute information provided in the model.

A single Alternate Name is created for each attribute element mapped to a caDSR
Property. This name is given the type UML Attribute and comes from the exact name
used for the attribute in the model. A single Alternate Definition is also created for the
attribute element mapped to the Property. This definition is given the type UML
Attribute and comes from the element description tagged value(s) associated with the
attribute element in the class model.

While alternate information for caDSR Properties is not viewable in the CDE Browser, it
does appear in the caDSR Admin Tool.
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Creating Alternate Names and Alternate Definitions for Data Element Concepts
Because caDSR DECs the class/attribute element combination in a UML model, the
Alternate Names and Alternate Definitions for DECs are also based on a combination
of the class/attribute information provided in the model.

A single Alternate Name is created for each class/attribute combination element
associated with a caDSR DEC. This name is given the type UML Class:Attribute and
comes from the exact names used for the elements in the model. A single Alternate
Definition is also created for the class/attribute combination mapped to the DEC. This
definition is also given the type UML Class:Attribute and comes from the element
description tagged value(s) associated with both the class and attribute elements in the
class model.

While alternate information for DECs is not viewable in the CDE Browser, it does
appear in the caDSR Admin Tool.

Using Pre-mapped CDEs (Common Data Elements)

The SIW interface provides the ability to map UML model elements to existing caDSR
CDEs if appropriate. Specifically, it is the attribute elements in the model that are
mapped to CDEs. When this is done, the class element is automatically mapped to the
OC for the CDE, and the datatype is mapped to the value domain for the CDE.

Because some of this mapping can be pre-entered, the UML Loader automatically
checks each attribute in the model to see if it contains the following tagged values:

e CADSR_DE_ID
e CADSR_DE_VERSION

If both of these tagged values are present, the DE (CDE) and all of its composite parts
(the OC, Property, value domain, and DEC) are reused and the caDSR components
are classified using the CS/CSI information provided for the project/model.

In addition, if the context that owns the mapped CDE is different than the context to
which the model is being loaded, the Alternate Name type shown for the component
lists “Used_By” and no Alternate Definition appears. You must view the CDE within the
context that owns it to see this information.

Creating and Updating Concepts in caDSR

Because trying to retrieve concept information directly from EVS could make the UML
Loader cumbersome and slow, and because new concept information is often
introduced well before EVS can be updated, the caDSR maintains its own repository of
concept information that corresponds to the NCI Thesaurus information in EVS.

When the UML Loader begins to process a file, it checks to see if each concept
corresponding to the specified concept code already exists in caDSR. If the concept
code exists but the name or definition is different, the UML Loader first checks EVS to
see if the name and definition match what is in the XMl file. If they are, the loader
updates the concept in caDSR with the new information.

If the code does not exist, then a new concept is created in caDSR. The data used for
creating the new concept is pulled from the tagged values located in the XMl file which
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were provided through the annotation process. The specific mapping is shown in Table
4.3. using the example of the concept for Gene.

Concept Attribute | Data Example
Preferred Name Derived from ConceptCode C16612
tagged value.
Long Name Derived from Gene
ConceptPreferredName tagged
value.
Preferred Definition | Derived from ConceptDefinition A functional unit of heredity which
tagged value. occupies a specific position

(locus) on a particular
chromosome, is capable of
reproducing itself exactly at each
cell division, and directs the
formation of a protein or other

product.
Version 1.0 (Default) 1.0
Workflow Status RELEASED (Default) Released
Context Specified in the submission form caBIG
with the model - the context to
which the model is to be uploaded.
Begin Date Current Timestamp 01/23/2005

Table 4.3 Concept Attribute details

Definitions that come from sources other than NCI are captured as Alternate Definitions
for a concept and are mapped as shown in Table 4.4.

Alternate Definition Data

Definition Derived from ConceptDefinition tagged value.

Context Specified in the submission form with the model - the context to
which the model is to be uploaded.

Table 4.4 Alternate Definition details

Mapping a UML Class to an Object Class

Each class in the UML domain model is mapped to a caDSR Object Class (OC). The
UML Loader performs this mapping based on the NCI concepts to which the UML class
elements have been mapped through the SIW. These are included as tagged values in
the annotated XMl file for the UML model.

To map a UML class to a caDSR Object Class, the UML Loader retrieves the NCI
concept codes for the UML class from the tagged values in the XMl file and checks to
see if a caDSR Object Class based on those values exists. If it exists, the UML model
class is mapped to it, and the OC is classified and appended with the appropriate CS/
CSI and alternate name/definition information as described in Relating (Classifying)
Metadata Items to UML Models on page 94.
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If there is no OC in caDSR based on the mapped NCI concept code values for the
class, the UML Loader must create a new OC. Table 4.5 illustrates the details of a new
object class that UML Loader creates.

underlying concept(s). Usually the concept
identifier(s).

Object Class o
Attribute Description Example
Preferred Name Derived from the concept codes of the C40992

Long Name Derived from the long name of underlying Homologous Protein
concept(s).
Preferred Derived from the preferred definition of A protein similar in
Definition underlying concept(s). structure and
evolutionary origin to
a protein in another
species.
Version 1.0 (default) 1.0
Workflow Status RELEASED (default) Released
Context Specified in the submission form with the caBIG
model - the context to which the model is to be
uploaded. Default is caBIG.
Begin Date Current Timestamp 01/23/2005

Table 4.5 Object class attribute details

As with all caDSR components, the OC is classified and appended with the appropriate
CS/CSI and alternate name/definition information from the UML model as described in
Relating (Classifying) Metadata Items to UML Models on page 94.

Mapping a UML Attribute to a Property

Each attribute in the UML domain model is mapped to a caDSR Property. The UML
Loader performs this mapping based on the NCI concepts to which the UML attribute
elements have been mapped through the SIW. These are included as tagged values in
the annotated XMl file for the UML model.

To map a UML attribute to a caDSR Property, the UML Loader retrieves the NCI
concept codes for the UML attribute from the tagged values in the XMl file and checks
to see if a caDSR Property based on those values exists. If it exists, the UML model
attribute is mapped to it, and the Property is classified and appended with the
appropriate CS/CSI and alternate name/definition information as described in Relating
(Classifying) Metadata Items to UML Models on page 94.
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If there is no Property in caDSR based on the mapped NCI concept code values for the
attribute, the UML Loader must create a hew one. Table 4.6 illustrates the details of the
new Property that the UML Loader creates.

Property Attribute | Description Example
Preferred Name Derived from the concept codes of the underlying | C25552:C411167
concept(s). Usually the concept identifier(s).
Long Name Derived from the long name of underlying Lead:Organization
concept(s). alUnit
Preferred Definition | Derived from the preferred definition of underlying | Be in charge of.:
concept(s). Organizational unit
like a laboratory,
institute or
consortium.
Version 1.0 (default) 1.0
Workflow Status RELEASED (default) Released
Context Specified in the submission form with the model - | caBIG

the context to which the model is to be uploaded.
Default is caBIG.

Begin Date Current Timestamp 01/23/2005

Table 4.6 Property attribute details

Mapping a UML Class to a Value Domain

Each class stereotyped as “CADSR Value Domain” or “enumeration” in the UML
domain model is mapped to a caDSR value domain. The UML Loader performs this
mapping using the Long Name of the value domain and the Context to which it is being
loaded.

For each class with Stereotype “CADSR Value Domain,” the UML Loader looks for the
following tagged Values:

e CADSR_ValueDomainDefinition
¢ CADSR_ValueDomainDatatype
e CADSR_ValueDomainType (E or N)
e CADSR_ConceptualDomainPubliclD
e CADSR_ConceptualDomainVersion
e CADSR_RepresentationPubliclD
e CADSR_RepresentationVersion

and optionally:
e ValueDomainConceptCode
e ValueDomainConceptPreferedName

¢ ValueDomainConceptDefinition[_n]
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¢ ValueDomainConceptDefinitionSource

¢ Value DomainQualifierConceptCodeN

e ValueDomainQualifierConceptPreferredNameN
¢ ValueDomainQualifierConceptDefinitionN[_n]

e ValueDomainQualifierConceptDefinitionSourceN

The list of optional tags above are used to indicate a “top level” concept for a value
domain. This is also referred to as a “referenced value domain.”

If the value domain is non-enumerated (N), the reference to a top level concept
indicates that the values are not explicitly listed as attributes of the value domain class,
but that the data values for the attribute are constrained to children of the top level
concept.

If the value domain is enumerated (E) the top level concept indicates that the permitted
data values are listed explicitly as attributes of the value domain class and are children
of the top level concept.

During the load process, the UML Loader starts by creating a value domain for each
class with Stereotype “CADSR Value Domain.” Table 4.7 below lists the information
used to create each value domain.

caDSR Field Value Used

Long Name UML Class Name

Preferred Name Similar to the generated public ID and version

Preferred Definition From 'ValueDomainDefinition' tagged value

Value Domain Type From 'ValueDomainType' tagged value

Context From run time default values provided by model owner

Version 1.0

Workflow Status Specified as Default (e.g DRAFT NEW)

Conceptual Domain From 'ConceptualDomainPubliclD' and
‘ConceptualDomainVersion' tagged values

Datatype From 'ValueDomainDatatype'

Begin Date The date of the load

Concept Derivation Rule | Optionally created from the list of Concepts in tagged
values. Similar to Object Class Concept Derivation Rules

Table 4.7 caDSR fields for creating a Value Domain

Value Meanings
For each attribute associated with a “CADSR Value Domain” stereotyped class, the
UML Loader looks for the following tagged values:

e ValueMeaningConceptCode

e ValueMeaningConceptPreferredName

105



caCORE SIW and UML Model Loader Technical Guide

ValueMeaningConceptDefinition[_n]
ValueMeaningConceptDefinitionSource
ValueMeaningQualifierConceptCodeN
ValueMeaningQualifierConceptPreferredNameN
ValueMeaningQualifierConceptDefinitionN[_n]

ValueMeaningQualifierConceptDefinitionSourceN

During the load process and after each value domain has been loaded, the UML
Loader looks for a matching caDSR Value Meaning based on the Value Meaning name
or the mapped concepts, if present. If an existing Value Meaning is found, the UML
Loader reuses it. If no match is found, the UML Loader creates a new Value Meaning.
Table 4.8 below lists the information used to create each Value Meaning.

caDSR Field Value Used

Value Meaning Created from the concatenation of
‘ValueMeaningConceptPreferredName' and qualifiers if
present.

Value Meaning Description Concatenation of 'ValueMeaningConceptDefinition[_n]'
tagged values and qualifiers if present.

Begin Date The date of the load

Concept Derivation Rule Created from the list of Concept in tagged values. Similar to

Object Class and Properties Concept Derivation Rules

Table 4.8 caDSR fields used for Value Meaning

Permissible Values

For each Value Meaning, UML Loader creates a new permissible value. Table 4.9
below lists the information used to create these values.

caDSR Field Value Used

Value

From the underlying attribute's name

Value Meaning The existing Value Meaning name, or the Value Meaning

created according to Table 4.8.

Meaning Description the Value Meaning Description associated with the existing

Value Meaning, or the one created according toTable 4.8

Begin Date The date of the load

Table 4.9 caDSR fields used for Permissible Values

Using a Value Domain Defined within the Model
In order for an attribute in the UML model to use a value domain defined within the
model (also referred to as a local value domain or LVD), the attribute must already
have a tagged value of type “CADSR Local Value Domain” associated with it. The
value indicated in the tag is the name given to the LVD.
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For example: The contains a class that is stereotyped as “CADSR Value Domain” with
the name “My Model Value Domain.” For a UML attribute to use this value domain,
attribute must have a tagged value of: “CADSR Local Value Domain” / “My Model Value

Domain” (name/value).

Mapping Data Element Concepts

A Data Element Concept (DEC) is formed using the combination of a caDSR Object
Class and a caDSR Property. Each class/attribute combination in the UML domain
model is mapped to a caDSR DEC. The UML Loader performs this mapping based on
the mapping it has already done for the model classes (to caDSR OCs) and the model
attributes (caDSR Properties) as described in the previous sections.

The UML Loader checks to see if a caDSR DEC based on the OC and Property values
for the class/attribute combination exists. If it exists, the UML model class/attribute
combination is mapped to it, and the DEC is classified and appended with the
appropriate CS/CSI and alternate name/definition information as described in Relating
(Classifying) Metadata Items to UML Models on page 94.

If there is no DEC in caDSR based on the OC and Property values for the class/
attribute combination, the UML Loader must create a new one. Table 4.10 illustrates
the details of the new DEC that the UML Loader creates.

Data Element Concept
Attribute

Description

Example

Preferred Name

Derived from the Object Class
Public ID and version and Property
Public ID and version. A colon is
used as the separator character
between these values.

1111111v1.0:2222222v1.0

Long Name

Derived from the Object Class
Long Name and Property Long
Name. A space is used as the
separator character between these
two values.

Homologous Protein
Alignment Length

Preferred Definition

Object Class Preferred Definition
and Property Preferred Definition.
A colon is used as the separator
character between these two
values.

A protein similar in structure
and evolutionary origin to a
protein in another species:
The linear extent in space
from one end to the other.
Often used synonymously
with distance.

Version 1.0 (default) 3.0
Workflow Status RELEASED (default) Draft New
Context Specified in the submission form caBIG

with the model - the context to

which the model is to be uploaded.

Default is caBIG.
Begin Date Current Timestamp 01/23/2005

Table 4.10 Data Element Concept details
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Data Element Concept Description Example

Attribute P P

Object Class Long Object Class corresponding to the | Homologous Protein

Name UML Class

Property Long Name Property corresponding to the UML | Alignment Length
Attribute

Table 4.10 Data Element Concept details

Mapping Data Elements

108

Note:

A Data Element (DE or CDE) is formed using the combination of a caDSR DEC and a
value domain. Each class/attribute/datatype combination in the UML model is mapped
to a caDSR DE. The UML Loader performs this mapping based on the mapping it has
already done for the class/attribute combinations in the model (to caDSR DECs) and a
generic existing caDSR value domain that corresponds to the datatype of the attribute
or a value domain defined in the model.

The UML Loader checks to see if a caDSR DE based on the DEC and value domain

combination exists. If it exists, the UML model class/attribute/datatype combination is
mapped to it, and the DE is classified and appended with the appropriate CS/CSI and
alternate name/definition information as described in Relating (Classifying) Metadata

Items to UML Models on page 94.

If the Context into which the UML model is being loaded is different from the Context
that owns the existing data element, a “USED_BY” designation is added to the existing
data element to capture the use by another Context

If there is no DE in caDSR based on the DEC and value domain combination, the UML
Loader must create a new one. Table 4.11 illustrates the details of the new DE that the
UML Loader creates.

DEEY |2 EllEt Description Example

Attribute P P

Preferred Name Derived from the DEC Public ID and 3333333v1.0v:4444444v
version and the Value Domain Public ID | 1.0
and version. A colon is the separator
character.

Long Name Derived from the DEC Long Name and Homologous Protein
Value Domain Long Name. A space is Alignment Length
the separator character. java.lang.Long

Table 4.11 Data Element details
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Data Element Description Example
Attribute P P
Preferred Definition | Derived from the DEC Preferred A protein similar in
Definition and Value Domain Preferred structure and
Definition. The separator character is a evolutionary origin to a
colon. protein in another
species: The linear
extent in space from one
end to the other. Often
used synonymously with
distance. Value Domain
for java language
‘java.lang.Long’
datatype.
Version 1.0 (default) 3.2
Workflow Status RELEASED (default) Draft New
Context Specified in the submission form with the | caBIG
model - the context to which the model is
to be uploaded. Default is caBIG.
Begin Date Current Timestamp 01/24/2005
Data Element The Data Element Concept Homologous Protein
Concept Long Name | corresponding to the UML Class and one | Alignment Length
of its attributes.
Value Domain Corresponds to the datatype of the java.lang.Long
attribute. Supported datatypes include
java classes and java primitives.
Note: An updated file that defines the
mapping between datatypes and value
domains is located here: http://
cadsrsiw.nci.nih.gov/datatype-
mapping.xml.

Table 4.11 Data Element details (Continued)

Mapping UML Associations to Object Class Relationships

Each association in the UML domain model is mapped to an Object Class Relationship
in caDSR.

Table 4.12 below provides details regarding the information used by the UML Loader to
create new Object Class Relationships.

Object Class Data

Relationship Attribute

Preferred Name Generated, equals source class corresponding Object Class
public ID + version; target class corresponding Object Class and
version.

Long Name Derived from the role name of underlying association.

Table 4.12 New Object Class Relationship details
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Object Class
Relationship Attribute

Data

Preferred Definition

Derived from the type of association. Example of the derived value
for preferred definition:

Zero-to-Many
Zero-to-One
Many-to-One
One-to-Many
Many-to-Many
Generalizes

Version

1.0

Workflow Status

Draft New — Specified as a parameter

Context Specified as a parameter
Begin Date Current Timestamp
Type HAS_A

Source Low Cardinality

Derived from UML Association. The Source object is the class
from which the link is drawn.

Source High Cardinality

Derived from UML Association. The Source object is the class
from which the link is drawn.

Target Low Cardinality

Derived from UML Association. The Target object is the class to
which the link is drawn.

Target High Cardinality

Derived from UML Association. The Target object is the class to
which the link is drawn.

Direction

Navigability.
Source-to-Target
Target-to-Source
Bidirectional

Table 4.12 New Object Class Relationship details

Mapping UML Inheritance
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Each inheritance type association in the UML model is mapped to an Object Class
Relationship in caDSR with the same attributes described for associations, except for
Object Class Relationship Type, which for inheritance associations is “IS_A” instead of

“‘HAS_A."

Additionally, the child class of the association inherits all of the attributes of the parent
class. DECs are created based on the combinations of the child class and each of its
parent’s attributes. These combinations are mapped using the same process described
in Mapping Data Element Concepts on page 107. Data elements are then created
using the mapped DECs and the associated datatypes. These combinations are
mapped using the same process described in Mapping Data Elements on page 108.




Chapter 4 caCORE UML Loader and Registering Metadata

In addition, all DECs and DEs are appended with the appropriate classification and
alternate name/definition information as described in Relating (Classifying) Metadata
Items to UML Models on page 94.

Table 4.13 and Table 4.14 below provide an overview of the information used to map
the DECs and DEs for inheritance associations.

Data Element Concept
Attribute

Data

Preferred Name

Child Object Class Public ID + Object Class Version:
Parent Property Public ID + Property Version

Long Name

Child Object Class Long Name +
Parent Property Long Name

Preferred Definition

Child Object Class Preferred Definition +
Parent Property Preferred Definition

Version 1.0 (Specified as a parameter)

Workflow Status Draft New (Specified as a parameter)

Context Specified as a parameter

Begin Date Current Timestamp

Object Class Object Class corresponding to the Child UML Class
Property Property corresponding to the Parent UML Attribute

Table 4.13 Inheritance Data Element Concept mapping

Data Element Attribute

Data

Preferred Name

DEC Public ID + DEC Version:
Value Domain Public ID + Value Domain Version

Long Name

DEC Long Name +
Value Domain Long Name

Preferred Definition

Derived from the underlying attribute description in the UML class
diagram.

Version 1.0 — Specified as a parameter
Workflow Status Draft New — Specified as a parameter
Context Specified as a parameter

Begin Date Current Timestamp

Data Element Concept

The Data Element Concept corresponding to the Child UML Class
and the Parent Attribute.

Table 4.14 Inheritance Data Element mapping
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Data Element Attribute

Data

Value Domain

Corresponds to the datatype of the Parent Attribute:
java.lang.String = Value Domain Name “java.lang.String”
java.lang.Boolean = Value Domain “java.lang.Boolean”
java.lang.Long = Value Domain “java.lang.Boolean”
java.lang.Integer = Value Domain “java.lang.Boolean”
java.lang.Float = Value Domain “java.lang.Float”
java.util.Date = Value Domain “java.lang.Date”

int = Value Domain “int”

long = Value Domain “long”
boolean = Value Domain “boolean”
char = Value Domain “char”
double = Value Domain “double”
float = Value Domain “float”

byte = Value Domain “byte”

short = Value Domain “short”

Table 4.14 Inheritance Data Element mapping
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Reviewing and Verifying Registered Metadata

After your model is submitted for loading to caDSR, the model is first loaded to the
caDSR “Sandbox.” The Sandbox functions as a dry-run environment, so that model
owners and NCICB staff can be sure the model will load properly, and that the
elements in the model are mapped to the appropriate caDSR metadata components.
Once a successful load is verified, the UML model can be loaded to the caDSR
Production database.

The NCICB provides two tools that allow you to search the caDSR and view loaded
UML model elements: the UML Browser and the CDE Browser. Both of these tools are
available for use on the Sandbox and Production environments. Model owners and
NCICB content curators will work primarily with the Sandbox environment until the
model is ready for Production. The steps for using the browser tools are the same,
regardless of environment; the only differences are the URLs used to access the
different repositories.

To access the browser tools for each environment/repository:

e Sandbox UML Model Browser: http://umimodelbrowser-sandbox.nci.nih.gov

e Sandbox CDE Browser: https://cdebrowser-sandbox.nci.nih.gov

e Production UML Model Browser: http://umlimodelbrowser.nci.nih.gov

e Production CDE Browser: https://cdebrowser.nci.nih.gov

Since this section is designed to provide information regarding review and verification
of newly loaded models, the procedures direct you to use the Sandbox URLSs.

Note: The information in this section is provided solely as an overview to using the caDSR
browser tools. For detailed information on using the UML Model Browser or the CDE
Browser, see the respective online help for those tools.

Using the UML Model Browser

Since model owners are typically more familiar with the elements in their UML models
than with the CDEs in caDSR, many find the UML Model Browser easier to use to find
and verify the loading and mapping of the elements from their model.

The UML Model Browser allows you to browse the caDSR repository for all elements in
your project, or search the repository using the class and class element names from
your model. You can also select which project, sub-project and/or package to search
specifically for your model’s elements.

The search result set provides links that open the CDE Browser, displaying the details
of the caDSR administered components to which the elements are mapped.
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To view registered UML model elements using the UML Model Browser:

1. Navigate to the following URL: http://umimodelbrowser-sandbox.nci.nih.gov.

Mational Cancer Institute LS. National Institutes of Health | wwwcancesgov
ML ModelIBrowser

ar FormBuilder Tool Admin Tgol Curation Taol NEI Metathesaurus ~ HCI Terminalogy Server Sentined Toaol

H you dan't see o recently laased madel, pleass click "Refresh free”
caDSR Contexts tree
with caBIG Context expanded
to show projects loaded to caBIG Enter Search criteria then select to
= - caD38 Conlesis search for Classes or Attributes
i :: amain Group)

Search prefarences

Class Hame Attribute Name|

st UML Project Name{ ALL  [Varsion

1 e Sub Project Name | ALL bl

Package Hame ALL w

Class Search ) | Altribule Search ) (_Reset )

Please enterfselect search erlena and chok search button to intiate search

fEERDE®DE
o N i .

Figure 4.6 UML Model Browser showing expanded caBIG Context and Search area

2. Within the UML Model Browser window, you have the following options for
browsing elements loaded to the caDSR:

°  To view all of the loaded elements for a context, click the context name from
the navigation tree on the left side of the window;

° To view all of the loaded elements for your project, click the plus sign (+) to
the left of the context to which your model was loaded (caBIG unless
otherwise specified in your submission) and click your project’s name from
the expanded list.

° Use the right side of the window to enter search criteria, if desired select the
Project Name, Sub Project Name, or Package Name you want to search,
and then click either Class Search or Attribute Search.

The sections below provide more information on how to browse, search for, and view
model elements using the UML Model Browser.

Viewing all registered elements for a Context or Project
When the UML Model Browser first appears, the navigation tree on the left shows all of
the contexts in caDSR in “collapsed” mode. Each of the items listed in the left
navigation tree is an active link. Selecting an item in the tree instructs the UML Browser
to return all of the loaded model elements associated with the selected item.

You must click the plus sign to the left of a context to expand it and show all of the
projects that have been loaded to that context. You must click the plus sign to the left of
a project name to expand it and show all of the sub projects and packages associated
with that project.

Expanding each node provides access to the active links for the items within the node,
allowing you to view all of the elements for that node. This means you can view all
loaded elements for a context, for a project, for a sub project or for a package,
depending on the level of the node you select from the navigation tree.
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Searching in the UML Model Browser
The UML Model Browser provides a straightforward search interface, allowing you to
enter a class or attribute element name and then to select a project, sub project or
package as well as version number to search for that class or attribute. However, it also
allows you the flexibility to search for all attributes associated with a particular class, or
for all classes containing a particular attribute.

To search for a class element:

1. Enter the element name in the Class Name text box. You may use an asterisk
(*) as a wildcard if necessary.

2. If desired, use the drop-down lists to limit the search to a specific UML Project,
Sub Project or Package, and identify a VVersion number if appropriate.

3. Click Class Search. The results appear below the search area.

U.S. National Institutes of Health | www.cancer.gov

Search preferences

Class Name  [Gene [attribute Name |

UML Project Narfs ALL v Version [
Sub Project Namg | ALL v
Package Name | [ALL v
Search across projects fOL/____' Class Search ) |_Attribute Search ) Reset Viewing Classes Tab
class element "Gene"
liw Attributes
Select Class Name link to Select Class Details link to open the
Sort order : Class Name [Ascending] view Attributes for this CDE Browser and view the Object
J. l project’s use of the class Class mapping for this project. @ (1 -14 of 14 »| &
Py
v v ) Project
Class oo ct Name Project o rkilow Sub Project Name Package Name Class O
Name Version Stauts Details  |Version
Gene  |caPE Semwer 2 RELEASED edu wustl fe 2223326 |1.0
Grid-enablement of Protein
ene |Information Resource (PIR) 1.2 1.2 RELEASED edu.georgetown. pir.domain 12223326 |1.0
[Transcription Annotation
Gene  |Prioritization and Screening 1 RELEASED TrIAPSS edu_uiowa clcg trapss domain 12223326 |1.0
System
Gene  |caArray 2 RELEASED caArray 2.0 gov_nih.nci_caarray domain_array 12223326 |1.0
Gene  |Seed 1 RELEASED edu.uchicago. Seed.domain 12223326 |1.0
Gene  |caBIO 4.1 RELEASED gov.nih.nci.cabio.domain 12223326 1.0
d of Protein
Gene |Information Resource (PIR) 1.1 (1.1 RELEASED edu_georgetown pir domain 12223326 |1.0
Gene  |Genomic Identifiers 1 RELEASED UPenn edu_upenn med 12223326 |1.0

Figure 4.7 UML Model Browser - Classes tab after search for class “Gene”

Conducting a Class Search against a Class Name returns all of the class elements
and projects matching the criteria you entered. You can also enter an Attribute Name
and a Class Name and click Class Search. In this instance, your results will be limited
to only those occurrences of the class that contain the identified attribute.

From the Classes tab you have several options for viewing additional information:

e Click a Class Name link - this displays all of the attributes of the class for the
project listed.

e Click a Project Name link - this displays detailed information about the project.

e Click a Class Details link - this opens the CDE Browser and shows the Object
Class information for the OC to which this class is mapped for this project.

You may also select to view the Attributes tab. The UML Browser then performs a new
search for all of the attributes in caDSR that are associated with the class name
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entered (for the identified projects/sub projects/packages). This is the same result you
would get if you entered a Class Name and clicked the Attribute Search button.

To search for an attribute element:

1. Enter the element name in the Attribute Name text box. You may use an
asterisk (*) as a wildcard if necessary.

2. If desired, use the drop-down lists to limit the search to a specific UML Project,
Sub Project or Package, and identify a Version number if appropriate.

3. Click Attribute Search. The results appear below the search area.

U.5. National Institutes of Health | www.cancer.gov

Search preferences

Class Name | |Attrihu|a Name |d\agnusis

UML Project Name| ALL 4 ‘mlersion
Sub Project Name | ALL v ’
Package Name ALL IV

Viewing Attributes Tab

|_Class Search ) (_Attribute Search )KI (_Reset )

Search across projects for

attribute element "diagnosis" r Classesi W
Select links in DE Name celumn te open the CDE Browser and view

Sort order : Attribute Name [Ascending] data element details for each classfattributeidatatype combination. Download Data Elements as XML
2 i S ©
Name Version|Context Data Type Definition DE Name DE Public ID Project Name | Sub Project Package Name
Diagnosis v
represents the
medical cause in  Patient Health Care CDC NCPHI
diagnosis 1.0 caBlG |java.lang.String|narrative form \Visit Diagnosis 2720917 Proof of gov.cdc.bss.domain
associated with the |java lang.String Concept
patient’s visit to the
healthcare facility
|Analysis of Slide Diagnosis
diagnosis 10 caBIG |java.lang.String g mymma Diagnosis Study (2619980 caElmir edu_ucdavis_caelmir domain_eventRecords
VP ava lang String
Pathology Event
\necord Uiagnosis
diagnosis 1.0 caBlG |java.lang.String PRETED & Record Diagnosis 2619993 caElmir edu.ucdavis.caelmir.domain.eventRecords
symptoms Diagnosis Study
ava.lang.String
2 [A=3er3 ¥ ©

Figure 4.8 UML Model Browser - Classes tab after search for class “Gene”

Conducting an Attribute Search against an Attribute Name returns all of the attribute
elements and projects matching the criteria you entered. From the Attributes tab you
can click a DE Name link for the element. This opens the CDE Browser and shows the
data element information for the CDE to which this attribute (class/attribute/datatype
combination) is mapped for the identified project.

You may also select to view the Classes tab. In this instance, the UML Browser
performs a new search for all of the classes in caDSR that are associated with the
attribute name entered (for the identified projects/sub projects/packages). This is the
same result you would get if you entered an Attribute Name and clicked the Class
Search button.

You may also choose to enter a Class Name with the Attribute Name and click
Attribute Search. In this instance, your results will be limited to only those occurrences
of the attribute that occur for the identified class.

Using the CDE Browser
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The CDE Browser allows you to browse for or search the caDSR repository for the
administered components that have been registered through and mapped to the
elements from your (or any other) project. The main difference between the CDE
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Browser and the UML Model Browser is that the CDE Browser searches for and returns
full data element information rather than specific class or attribute information for a
project.

To view caDSR administered components using the CDE Browser:

1. Navigate to the following URL: https://cdebrowser-sandbox.nci.nih.gov.

IR

[ ﬁi National Cancer Institute U, National Institutes of Health | www.cancergov

b L -
caDSR .EgrEt Home FormBuilder Help

Admin Tool  Curation Tool NCI Metathesaurus ~ NCI Terminology Server  Sentinel Tool UML Model Browser What's new

S Projects loaded to the caBIG &
— Context appear in the Data Element Search
27 cans contexts  Classifications folder in the tree.
?ans Biomedical Research Wtearated Domain Grou
e ‘)?E)BIG N1 panoor Biome gl Informatics Grid Search for Data Elements Search preferences Advanced search
& classifications
’7 Enter search criteria and then select the type of search to
0 text

conduct. Select a Context, Classification, or Classification
Scheme ltem from the tree to narrow the result set.

@ Exact phrase
QA of the words | Mame v
O At least one of the words

Tip: This is an exact match search. To search for partial words or phrases use the * as a wildcard.

Note: Default
Registration statuses. Click the "Se:

CAP Cancer Checklists (__Search (__ Clear )

@ ©cne HePHI Proof of Concept

d Training Context viewrs from the tree and certain non-released” Workflow and
arch Preferences’ ink above to view or change the exclusion criteria

Figure 4.9 CDE Browser showing expanded Classifications under the caBIG Context

2. Within the CDE Browser window, you have the following options for browsing
the administered components within caDSR:

° To view all of the CDEs for a context, click the context name from the
navigation tree on the left side of the window;

°  To view all of the CDEs mapped to your project, click the plus sign (+) to the
left of the context to which your model was loaded (caBIG unless otherwise
specified in your submission) and then click the plus sign (+) to the left of the
Classifications node. Then click your project’s name from the expanded
classifications list.

© Use the right side of the window to enter search criteria, select the type of
search to perform, and then click Search.

The sections below provide more information on how to browse, search for, and view
data element details using the CDE Browser.

Viewing all CDEs for a Context, Classification Scheme or Classification Scheme Item
When the CDE Browser first appears, the navigation tree on the left shows all of the
contexts in caDSR in “collapsed” mode. Each of the items listed in the left navigation
tree is an active link. Selecting an item in the tree instructs the CDE Browser to return
all of the CDEs associated with the selected item.

You must click the plus sign to the left of a context to expand it and show the sub-
nodes, which include a Classifications node. All projects loaded to a context are
“classified” and are listed as classifications under the context. You must click the plus
sign to the left of the Classifications node to expand it and show all of the projects
(classification schemes or CS) for the context. You must click the plus sign to the left of
a CS (which corresponds to the project name) to expand it and show all of the sub
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projects and/or packages (classification scheme items or CSI) associated with that
project.

Expanding each node provides access to the active links for the items within the node,
allowing you to view all of the CDEs for that node. This means you can view all CDEs
for a context, for a CS or for a CSl, depending on the level of the node you select from
the navigation tree.

Searching in the CDE Browser

The CDE Browser provides a straightforward search interface, allowing you to enter
search criteria text and then to select whether you want to perform an exact search, a
search for all of the words or a search for any of the words.

Unless otherwise indicated, the CDE Browser will perform the search for entered
criteria across all caDSR contexts.

To search for CDEs across all caDSR contexts:

1. Inthe search text box, enter the item you want to search for. You may use the
asterisk (*) as a wildcard.

2. Select whether you want to search for an Exact Phrase, All of the words, or At
least one of the words.

3. Click Search.

The search results appear in a list below the search area of the window, along with
several feature buttons for manipulating the resulting CDEs and a smaller “paging”
indicator that lists the number of results and which of those results are currently shown.

U.S. National Institutes of Health | www.cancer.gov

Search for Data Elements 28 Matches Search preferences Advanced search

O Exact phrase
@ All of the words Gene Name Name v
O At least one of the words

Tip: This is an exact match search. To search for partial words or phrases use the * as a wildcard.

Hote: Default settings exclud nd Training C
statuses. Click the ‘Search Preferences’ link above

iews from the tree and certain ‘non-released’ Workflow and Registration

o view or change the exclusion criteria

(__Search ) (_ Clear ){_ New Search )

Search Results Search within results

Results fewer than expected? Check Search Preferences

Download Data Elements to Prior Excel] [Download Data Elements to Excel] [Download Data Elements as XML]

Sort order :

(__Add to CDE Cart ) (_Add to CDE compare list ) (_Compare CDEs ) 1-280f28 v
[J|Loeng Name E}sz:t:ﬁdTexl g;vned C”:ﬁfesr Registration Status Workflow Status| IPDUM'C Version
[]|Gene Alias Name java lang String caCORE |[caBIG Qualified RELEASED 12223776 (3.0

[ |Gene Ontology Name java.lang.String caCORE |caBIG Qualified RELEASED 12629575 1.0

[y |Sene Oriology Term Name caBIG Qualified RELEASED 2557984 [10

wa lang o
[ |Gene Product Name java.lang.String caBlG Qualified RELEASED 12638667 (1.0
[ |robe Set Information Summary Enirez caBlG Qualified RELEASED (2557974 10

Figure 4.10 CDE Browser showing search criteria and result set

Clicking a Long Name link from the result set opens a detailed view of the data
element, including additional information tabs and links to object class, classifications
and other information.
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If your result set is too large, you can click the Search Within Results link. This

refreshes the search window, retaining the original result set, but changing the Search
button to a Search Within Results button, and changing the breadcrumbs to indicate

the subset of CDEs you will be searching.

U.S. National Institutes of Health | www.cancer.gov

CDE Cart Home FormBuilder  Help

Admin Tool ~ Curation Tool ~ NCI Metathesaurus NCI Terminology Server  Sentinel Tool UML Model Browser What's new

Sean:h within results

Search Within Search Results 399 Matches Search preferences Advanced search

Breaderumbs show current result set information
#— (first search was for "Gene" across all contexts)

Contexts

Criteria>>All of the words (name=Gene)

O Exact phrase
@Al of the words [ [ Mame v
O At least one of the words

Tip: This is an exact match search. To search for partial words or phrases use the * as a wildcard.

Mote: Default settings exclude Test and Training Conte: from the tree and certain ‘non-released’ Workflow and Registration
statuses. Click the "Search Preferences’ link above to view or change the exclusion criteria

Will limit search to within
current resultset —— (Search within result3 (_ clear ) (_ New Search )

Search Results

Results fewer than expected? Check Search Preferences

[Download Data Elements to Prior Excel] [Download Data Elements to Excel] [Download Data Elements as XML

Figure 4.11 CDE Browser - searching within results

If you want to search for CDEs within a context, CS or CSlI, you must first select that
item from the navigation tree on the left. This populates the breadcrumbs with the name

of the node and limits the CDE search to only those related items.

To search for CDEs within a context or classification:

1. From the navigation tree on the left of the CDE Browser window, click on the
name of the grouping you want to search. You can click directly on a context to
search that context, or you may have to expand (using the plus sign) the context
and classification nodes to get to the name of the CS or CSI you want to search.

2. After the result set shows the CDEs for the node you selected and the
breadcrumbs display the node you want to search, enter the search criteria into
the text box, and select the proper search type (exact, all words, any words).

3. Click Search.

The new result set appears and the breadcrumbs change to reflect the new search
used to create the currently displayed result set.
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GLOSSARY

This glossary describes acronyms, objects, tools and other terms referred to in the
chapters or appendixes of this guide.

Term

Definition

{home_directory

}

Indicates the directory where you installed the SDK

{package__
structure}

Indicates the package structure from the UML models

{project_name}

Indicates the project_name specified in the deploy.properties
file

AGT Artifact Generation Tool

AOP Aspect Oriented Programming

API Application Programming Interface

Writeable API Methods exposed by the CSM to create, update and delete a domain

object. These methods are generated using the code generation
component.

Application Service

This refers to the CSM interface which exposes all the writeable as
well as business methods for a particular application

BO Business Object

C3D Cancer Centralized Clinical Database

caBIG cancer Biomedical Informatics Grid

caBIO Cancer Bioinformatics Infrastructure Objects

caCORE cancer Common Ontologic Representation Environment

caDSR Cancer Data Standards Repository

caMOD Cancer Models Database

cardinality Cardinality describes the minimum and maximum number of
associated objects within a set

CASE Computer Aided Software Engineering

CCR Center of Cancer Research

CDE Common Data Element

CGAP Cancer Genome Anatomy Project
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Term Definition
CMAP Cancer Molecular Analysis Project
CODEGEN Code generator tool

Code Generator Tool

The SDK tool that leverages Model-Driven Architecture to convert a
UML model to a fully-functioning caCORE-like system

CS Classification Scheme

Csl Classification Scheme Item

CSM Common Security Module

CTEP Cancer Therapy Evaluation Program

CVsS Concurrent Versions System

DAO Data Access Objects

DAS Distributed Annotation System

DCP Division of Cancer Prevention

DDL Data Definition Language

DEC Data Element Concept

DOM Document Object Model

DTD Document Type Definition

DU Deployment Unit

EA Enterprise Architect

EBI European Bioinformatics Institute

EMF Eclipse Modeling Framework

EVS Enterprise Vocabulary Services

FK Foreign Key - A collection of columns (attributes) that enforce a
relationship to a Primary Key in another table used in data model
tables in Enterprise Architect

FreeMarker A "template engine"; a generic tool to generate text output (anything
from HTML or RTF to auto generated source code) based on
templates

GAI CGAP Genetic Annotation Initiative

GEDP Gene Expression Data Portal

IDE Integrated Development Environment

ISO International Organization for Standardization

JAF JavaBeans Activation Framework

Jalopy Source code formatting tool for the Sun Java Programming Language._
(http://jalopy.sourceforge.net/manual.html)

JAR Java Archive

Javadoc Tool for generating APl documentation in HTML format from doc
comments in source code (http:/java.sun.com/j2se/javadoc/)

JDBC Java Database Connectivity
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Term Definition

JDiff Javadoc doc-let which generates an HTML report of all the packages,
classes, constructors, methods, and fields which have been removed,
added or changed in any way, including their documentation, when
two APIs are compared (http:/javadiff.sourceforge.net/)

JET Java Emitter Templates

JMI Java Metadata Interface

JSP JavaServer Pages

JUnit A simple framework to write repeatable tests (http://
junit.sourceforge.net/)

MDR Metadata Repository

metadata Definitional data that provides information about or documentation of
other data.

MMHCC Mouse Models of Human Cancers Consortium

multiplicity Multiplicity of an association end indicates the number of objects of
the class on that end that may be associated with a single object of
the class on the other end

MVC Model-View-Controller, a design pattern

NCI National Cancer Institute

NCICB National Cancer Institute Center for Bioinformatics

NSC Nomenclature Standards Committee

navigability Navigability defines the visibility of an object to its associated source/
target object at the other end of an association.
Navigability is the same as directionality.

OoMG Object Management Group

OR Object Relation

ORM Object Relational Mapping

PCDATA Parsed Character DATA

persistence layer

Data storage layer, usually in a relational database system

PK

Primary Key — Key used to uniquely identify a data model table in
Enterprise Architect.

QA Quality Assurance

RDBMS Relational Database Management System
RUP Rational Unified Process

SCM Software Configuration Management
SDK Software Development Kit

Semantic Connector

The SDK tool that links model elements to NCICB EVS concepts.

SPORE

Specialized Programs of Research

SQL

Structured Query Language
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Term

Definition

Tagged value

A UML construct that represents a name-value pair; can be attached
to anything in a UML model. Often used by UML modeling tools to
store tool-specific information

UML Unified Modeling Language

UML Loader SDK tool that converts a domain model in UML to corresponding
common data elements (CDESs) in caDSR.

UPT User Provisioning Tool

URI Uniform Resource Identifier

URL Uniform Resource Locators

WSDL Web Services Description Language

XMI XML Metadata Interchange (http://www.omg.org/technology/
documents/formal/xmi.htm) - The main purpose of XMl is to enable
easy interchange of metadata between modeling tools (based on the
OMG-UML) and metadata repositories (OMG-MOF) in distributed
heterogeneous environments

XML Extensible Markup Language (http://www.w3.0rg/TR/REC-xml/) -
XML is a subset of Standard Generalized Markup Language (SGML).
Its goal is to enable generic SGML to be served, received, and
processed on the Web in the way that is now possible with HTML.
XML has been designed for ease of implementation and for
interoperability with both SGML and HTML

XP Extreme Programming
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Add button 30
adding a concept 30
adding concept mapping to an element 60
adding concepts in review mode 78
administered component 91, 92
aggregations 15
Alternate Definition
as used for classification 94
creating for data element 100
creating for DEC 101
creating for object class 98
creating for Property 100
description 98
Alternate Name
as used for classification 94
creating for data element 99
creating for DEC 101
creating for object class 98
creating for Property 100
description 98
annotated file
definition 14
editing concept mapping 78
final output 75
mapping to EVS concepts 92
model owner verified 88
naming convention 40
registering with UML Loader 92
reviewing after Semantic Connector 57
review step 26
submit for registration 92
submitting for registration 94
viewing in SIW 32
annotation
adding concept mapping to element 30
annotated file 14
associations 47

INDEX

description 9
editing mapped concepts 78
mapping elements to CDE 82
mapping elements to concepts 12
mapping via Semantic Connector 54
overview 46
purpose of annotation 46
purpose of element descriptions 46
purpose of viewing unannotated file 46
review annotated file 14, 26, 74
review unannotated file 14, 25, 42
searching EVS for concept to map 62
unannotated file 14
verifying reviewed file 88
via Curate XMI file step 58
via Semantic Connector task 57
viewing annotated file 32
viewing semantic order 32
viewing unannotated file 31
Apply button 30
applying changes 30, 66
apply to all 70
apply vs. save 31, 89
ArgoUML 10, 22
file extensions 39
generating XMI file 19
output type 14
arrows for reordering concepts 67
associations 15, 34
annotating 47
definition 11
location in tree view 29
mapping elements to concepts 34
mapping to object class relationship 109
recognized relationships 15
UML model constraints 15
viewing in tree view 36
viewing with classes 36
attribute
as model element 11
as value meaning 19
complex type 15
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datatype mapping to value domain 86

definition 11

description tags 15, 31, 46

display inherited attributes 38

mapping datatype to value domain 86

mapping to caDSR administered component 92

mapping to CDE 82, 86

mapping to CDE via Roundtrip task 53

mapping to concepts via Curate mode 60

mapping to DEC 13

mapping to EVS concepts 11

mapping to existing Property 103

mapping to Property 103

mapping to value domain 86

naming convention 16

naming convention in model 16

sort by name in tree view 38

tagged values 11

using local value domain 17, 19, 106
audience for Curate XMI file section 58
audience for guide 2
automatically search EVS on EVS link 36, 37

B

before you begin 14
browsing metadata by project 114, 116
browsing metadata through search 115, 118

C

caBIO
as caCORE component 7
description 7
caCORE
architecture overview 5
components 6
caBIlO 7
caDSR 7
Common Logging Module (CLM) 8
Common Security Module (CSM) 7
EVS 7
SDK 6
SIwW 7
UML Loader 7
definition 1
release paradigm 8
role of semantic integration 8
UML modeling 10
website links 8
wiki links 8
caDSR
accessing UML derived metadata 113
administered components 91, 92
as caCORE component 7
CDE Browser 96
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classifications 94

contexts 96

creating Alternate Definitions 102
creating new object class 103

creating new Property 104

description 1, 7, 21

mapping attribute to Property 107
mapping CDEs to model elements 82
object class details 103

Property details 104

registering metadata from UML models 91
required file for loading 75

reviewing model element mapping 113
sandbox 94

using tools to browse metadata 113

CADSR_Description tags 15, 31, 46
CADSR Local Value Domain 106
CADSR Value Domain 105

camel case 16, 54

CDE Browser

reviewing metadata 113
searching 118

using 116

viewing classifications 96

CDE see "common data element"”

changing the order of mapped concepts 66, 80
checkmarks in tree view 88

class

adding value meaning attributes 19

as local value domain 17

as model element 11

definition 11

describing in model 15, 31

documentation tags 15, 31, 46

mapping to caDSR administered component 92
mapping to CDE via Roundtrip task 53
mapping to concepts via Curate mode 60
mapping to DEC 13

mapping to OC 86, 98, 102

mapping to value domain 104

naming convention 16

sorting by name in tree view 38

stereotyped as enumeration 17

stereotyped as value domain 15

stereotyping as CADSR Value Domain 17
viewing by name in tree view 38

viewing inherited attributes from super class 38

classifications 94, 117
classification scheme 96
classification scheme item 96
classifying metadata 94
common data element (CDE)

see also "data element"”
definition 12, 108



mapping through UML Loader 108
mapping to model element 13
viewing all CDE for a classification 117
Common Logging Model (CLM) 8
Common Security Model (CSM) 7, 8
comparing concepts in model against EVS 70
compatibility with UML modeling programs 22
concepts
adding in review mode 78
adding new 58, 60
adding to element mapping 30
annotating associations 47
attribute details 101
changing order of mapped concepts 66, 80
definition 12
deleting mapped concepts 68, 82
display Primary Concept first 38
editing information 68, 69
editing mapping 30, 65
mapping association elements 34
mapping by EVS curators 26
mapping example 61
mapping in semantic order 32, 67
mapping through Semantic Connector 26
mapping to model element 12
mapping via Curate XMI step 58
Primary Concept 12
Qualifier Concept 12
replacing mapped concepts 66, 79
review annotated file (concept mapping) 26
semantic order 33, 80, 81
updating in caDSR 101
using to map attribute to Property 103
using to map class to OC 102
validating model against EVS 70
viewing element mapping details 29
viewing elements after mapping 32
viewing elements before mapping 31
viewing semantic order 32
context 96
controlled vocabulary 8
creating CSIs 96
Curate XMl file 26, 58
verifying mapping 72

D

data element (DE)
see also "common data element"
as metadata 13
creating Alternate Definitions 99
creating Alternate Names 99
creating new 108
definition 12, 108
description 108

Index

graphical representation 13

mapping to attribute in SIW 85

mapping to model element 13

mapping via Roundtrip mode 48

using existing 108
data element concept (DEC)

creating new 107

definition 13, 107

description 107

mapping to class element 13

mapping to existing 107

mapping to model elements 107
datatype

defined as local value domain 106
DEC see "data element concept”
definitions

Alternate Definition 98

Alternate Name 98

annotated XMI file 14

association 11

common data element (CDE) 12

concepts 12

data element (DE) 12

data element concept (DEC) 13, 107

EVS concepts 12

metadata 10

Primary Concept 12

Qualifier Concept 12

semantic order 32

tagged values 11

terms you should know 10

UML 10

unannotated XMI file 14
deleting mapped concepts 68, 82
description tags 15, 31, 42, 46
DE see "data element"
detail view 29

Add button 30

Apply button 30

automatically launch EVS search 37

display Primary Concept first 38

map to CDE 82, 85

map to concepts 82, 86

multiple tabs 90

Next button 30

Previous button 30

Search EVS button 30

search for data element 83

semantic order of concepts 33

viewing element descriptions 37
detail view for associations 34
display inherited attributes 38
display Primary Concept first 38
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E

editing concept information 68, 69
editing concept mapping 65
editing concepts in review mode 78
editing element mapping 30
element see "model elements"
Enterprise Architect (EA)

file extensions 39

generating XMI file 19

output type 10, 14, 22
enumerated value domain 18
errors tab 34,35
EVS

as caCORE component 7

concept definition 12

concepts 92

description 7

searching for concepts 62
EVS curation team 58
EVS curation team verifying mapping 72
exporting errors to file 35

F

Fatal Error in Model dialog box 45
filtering log tab information 36

fix XMI file task 20, 22

freestyle search 84

fully annotated XMI file 26

G

generating updated errors tab 35, 75

H

human verified 72

I

inheritances 15, 110
inherited attributes 38
internal API (private API) 26

J

Java naming conventions 16
Java term restrictions 15
Java Web Start 22

L

local value domain

as attribute datatype 19
CADSR value domain 17
enumerated 18
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non-enumerated 18
referenced value domain 18
tagged values 17
using within model 17, 82, 106
value meanings 19

log tab 34, 36

M

mapping
applying changes 30
association elements 47
association elements to concepts 34
attribute element to Property 103
attribute to CDE 82, 83, 85
attribute to Property 104
based on previous model 25, 48
by EVS curators 26
changing semantic order 67
changing the order of concepts 66, 80
class element to OC 102, 103
class element to value domain 104
elements to concepts 12
elements to concepts via Curate task 58
elements to concepts via Semantic Connector 54
elements to EVS concepts 47
human verified 72
rejecting changes 66
replacing mapped concepts 66
replacing mapped concepts in review mode 79
review annotated file 74
reviewing element mapping 78
search for data element 83
searching EVS for concept to map 62
semantic order of concepts 32, 80
stereotyped class element to value domain 104
to EVS concepts through curation mode 26
to EVS concepts using Semantic Connector 26
undo changes 66
using local value domains 82
using Semantic Connector 26
verifying by curator 72
verifying element mappings 88
viewing semantic order of concepts 33
Map to CDE button 82
Map to Concepts button 82
metadata
definition 10
mapping to model elements 13
purpose 10
registering 8
registering through UML Loader 91
relationship between model and caDSR 94
using pre-mapped CDEs 101
model elements
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adding a concept 30, 60, 78 navigation tree

annotated file requirements 74 associations in tree view 36
annotating 14 checkmarks in tree view 88
applying changes 30 display inherited attributes 38
associations 11 sort element by name 38
attribute 11 viewing associations 36
camel case naming 16, 54 Next button 30

changing the order of mapped concepts 66, 67,80  non-enumerated value domain 18
class 11

classifying 94 [0)
deleting mapped concepts 68, 82

descriptions in model 15 object class

editing concept information 65, 68, 69 creating new for mapping 103
editing mapping 30 map_ping to cllass element 102
example of mapping to concepts 61 reusing existing for mapping 102
mapping attribute to DEC 13 object class relationship 109
mapping attribute to value domain 86 opening the SIW 23
mapping class to DEC 13 output from Curate XMI step 58, 74
mapping to caDSR administered component 13, output from Roundtrip mode 53
92 output from Semantic Connector mode 54, 57
mapping to CDE 13, 82, 83
mapping to EVS concepts 12, 47 P

marking as verified 72, 88
naming convention 16
providing descriptions for 11

packages 96
perform Roundtrip XMI step 25

purpose of element descriptions 46 Previous button 30

registering as metadata 91 Primary Concept

replacing mapped concepts 66, 79 definition 12, 60

review annotations 26 example 32

review descriptions 25 semantic order 32

review mapping 26 viewing first in detail view 38
searching caDSR 115, 118 Property

searching CDE Browser 118 creating new for mapping 104
searching UML Model Browser 115 mapping attribute element 103, 107
semantic order for mapped concepts 32 reusing existing for mapping 103
tagged values 11, 15 public API vs private API 26
UML descriptions 15, 31

value domain 11 Q

verify concept mapping 26
verifying curation mapping 72
viewing after mapping 32
viewing before mapping 31
viewing descriptions 42
viewing details 29

Qualifier Concept
definition 12, 60
example 32
semantic order 32

viewing element annotations 32 R

viewing element descriptions 29, 31 referencing metadata by project 94, 96
viewing in caDSR 114, 116 regenerate errors listing 35

viewing in SIW 27 registering metadata to sandbox 94
viewing multiple tabs 90 rejecting changes to concept mapping 66

viewing semantic order of concepts 33
modeling programs 22
model owner verified 88

rejecting changes to concepts 78
rejecting concept deletion 68
replacing mapped concepts 66, 79
review annotated file 14, 26, 75

N reviewing registered metadata 113
navigating the SIW viewer 27, 30 review unannotated file 14, 25, 42
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Roundtrip XMl step 25, 48

S

sandbox 94, 113
save vs. apply 39, 89
saving the XMI file 31, 39
saving verified curated file 74
SDK as caCORE component 6
search EVS 62, 63

automatic search launch 37

result set limit 65

Search EVS button 30, 36
search for data element

freestyle search button 84

from detail view 83

result set 84

search data element button 83

suggest button 84
search for value domain 87
searching for registered metadata 118
searching for registered model elements 115
searching for your model elements in caDSR 118
searching the CDE Browser 118
searching the UML Model Browser 115
Search Thesaurus dialog box 63
security warning dialog box 24
selecting classes or packages to process 27
Semantic Connector 47, 54
Semantic Connector Report 54, 57
semantic integration

annotation 9

before you begin 14

defined terms 10

description 8

process 9

purpose 8, 9, 21

role in caCORE process 8

UML model constraints 14
semantic order

changing order of mapped concepts 67, 81

concept order reflects semantic order 80

definition 32

example of concept mapping 67
SIW

as caCORE component 7

before using 22

Curate XMI file step 26

default preferences 36

description 1, 7, 21

detail view 29

errors tab 34

exporting error information 35

filtering log tab information 36
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fix XMI file task 20
generating XMI file from UML model 19
Java Web Start 22
launching 23
log tab 34, 36
model pre-requisites 14
navigating the viewer 27
navigation tree 28
options 25
parsing select classes or packages 27
perform Roundtrip XMI step 25
process 25
processing select packages 27
purpose 8, 22
review annotated file 14, 26, 74
review unannotated file 14, 25
running Semantic Connector 54
security warning on initial open 24
Semantic Connector step 26
setting preferences 36
tree view 28
updating errors tab information 35
use private API 38
viewer overview 27
viewer preferences 36
viewing associations 34, 36
viewing errors 34
viewing multiple tabs in detail view 29
viewing parsing log 34
viewing semantic order of concepts 33
welcome screen 25

SIW viewer 27
Add button 30
Apply button 30
associations in detail view 34
associations in tree view 34, 36
checkmarks on navigation tree 29
detail view 29, 30
display inherited attributes 38
display Primary Concept first 38
element descriptions in detail view 37
errors tab 34
exporting error information 35
filtering log tab information 36
log tab (parsing log) 34, 36
multiple tabs in detail view 29
navigation tree 28
Next button 30
preferences 36
Previous button 30
reviewing annotated file 77
Search EVS button 30
setting preferences 36
sort element by name 38
structural order of tree view 29



updating errors tab 35
use pre-thesaurus to validate concepts 39
use private API 38
viewing associations 34, 36
viewing element descriptions 37
viewing errors 34
viewing semantic order 33
sort by name 38
starting SIW 23
stereotyped class as value domain 104
stereotyped class tagged values 105
stereotyped class value meanings 105
suggest data element matches 84

T

tabs in detail view 29
tagged values
associations 47
CADSR_Description 31
CADSR Local Value Domain 107
CADSR Value Domain 105
class stereotyped as value domain 104
definition 11
description tags 31
element description tags 31
local value domain 15, 17
purpose of element descriptions 46
referenced value domain 18, 105
review unannotated file 25
role annotations (associations) 47
source annotations (associations) 48
target annotations (associations) 48
updating in model from XMI file 40
value domain 105
value meanings 19, 105
verifying element descriptions 45
troubleshooting detail view 29

U

UML definition 10
UML descriptions
viewing in tree view 37
UML Loader
as caCORE component 7
creating CSIs 96
creating new concepts in caDSR 101
creating new data element 108
creating new DEC 107
creating new object class 103
creating new Property 104
description 1, 7, 91
mapping associations 109
mapping attribute element to Property 103
mapping class/attribute to DEC 107, 108

Index

mapping class element to OC 102
mapping data elements 108
mapping DECs 107
mapping DE to model elements 13
mapping inheritances 110
mapping model elements to metadata 91
process of registration 94
specifying caDSR classification 96
updating concepts in caDSR 101
using existing data element 108
using existing DECs 107
using pre-mapped CDEs 101
UML model
class operations 92
constraints 14
description tagged values 15, 31, 46
exported file type 22
generating XMI output 20
mapping attributes 83
mapping elements to caDSR components 92
pre-requisites 14
submitting for registration 94
supported modeling software 14, 22
updating model definitions 40
UML Model Browser 113, 115
UML modeling programs 22
unannotated file
definition 14
review step 25, 42
viewing in SIW 31
undo changes to mapping 66
undo concept changes 78, 82
undo concept deletion 68
updating errors tab 35, 75
updating model with SIW changes 40
use pre-thesaurus to validate concepts 39
use private API 26, 38
using arrows to change concept order 67
using CDE Browser 113, 116
using CDEs mapped through SIW 101
using UML Model Browser 113

A"

validate concepts 70
validate concepts using pre-thesaurus 39
value domain
as model element 11
CADSR value domain 17
definition 11
enumerated 18, 105
local value domain 15, 17
mapping stereotyped class element 104
mapping to CDE via Roundtrip task 53
mapping to datatype 86
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mapping with data element 108
non-enumerated 18, 105
referenced value domain 18
search for value domain in SIW 87
stereotyped class 15
stereotyped class elements 104
tagged values 105
tagged values for LVD 17
using local value domain 106
using LVD for attribute datatype 19
value meanings 19, 105

value meanings 19, 105

verifying concept information in model 70

verifying curated XMI file 72
verifying reviewed file 88

view associations in class tree 36
viewer default setting 36

viewer preferences 36

automatically search EVS on EVS link 37

display inherited attributes 38
display Primary Concept first 38
display UML description last 37
sort element by name 38

use pre-thesaurus to validate concepts 39

use private API 38

viewing associations in class tree 36
viewing

all CDEs for a classification 117

annotated file 32

associations 34

classifications in CDE Browser 96

contexts in CDE Browser 96

element annotations 32

element descriptions 31, 37, 42

inherited attributes in tree view 38

log tab (parsing log) 36

metadata by project 117

model elements in caDSR 114, 116

navigation tree sorted by class name 38

Primary Concept first in detail view 38

registered metadata 116

registered model elements 114

semantic order 32

unannotated file 31, 42

unannotated file errors 45
vocabulary terms 10

W

website links 3

wiki links 3, 12

workflow for semantic integration 9
workflow for the SIW 25
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XMI file

annotate based on previous model 25
annotated file 14

applying changes 31

as EA or ArgoUML output 14
compatible modeling software 10
curate file through EVS curators 26
definition 10

element descriptions in file 31, 46
file extensions 39

filtering packages 27

fix XMI file task 20

fully annotated file 75

generating for SIW 19

model output file extensions 14, 22
model owner verified 88

naming a reviewed file 75

output from Curate XMI step 74
package filtering 27

processing select packages 27
purpose for element descriptions 46
review annotated file 74

reviewing annotated file 26
reviewing newly exported file 25
Roundtrip XMI step 48

saving changes 39

Semantic Connector 26

submitting annotated file to caDSR 94
unannotated file 14

uploading model definitions 40
valid file export from model 22
verify concept mapping 26
verifying reviewed file 88

viewing annotated file 32

viewing element descriptions 42
viewing errors in file 34

viewing model elements 27
viewing structural order of model 29
viewing unannotated file 31, 42

XMI Roundtrip 48
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